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66 26

reader shootout
wildlife photography
Two Digital Camera readers go wild with 
Ben Brain at the headquarters of the 
Wildfowl and Wetlands Trust in Slimbridge, 
Gloucestershire. Big guns at the ready… 

group test
35mm primes
We test eight fast prime lenses that range in 
price from £400 to £830. If you’re inspired 
by our street photography feature, then 
you’re sure to want one of these…

photo projects
10 new ideas to try
All the inspiration you need for a month of 
rewarding pictures – from photographing 
animals in your back garden to shooting 
the urban landscape in a cool new way

174

42 Street photographer Michael 
Ernest Sweet believes the 

internet is killing the artform he loves. 
In this personal piece, he explains why 
you should strive to make your photos 
extraordinary – and how to do it

st R e e t 
p H oto s

114
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Welcome to 
the March 
2016 issue of  
Digital Camera

RESH from the streets 
of New York, this month’s 
lead feature showcases the 
striking shots of street 
photographer Michael 

Ernest Sweet. Michael’s street 
antics, tips and advice are sure to get 
you fired up: I guarantee you’ll look at 
street photography in a new light.
 If you want to get away from 
the hustle and bustle of the 
streets for a more tranquil 
interaction with nature, we’ve got 
bags of great features for you too. 
Join me and readers Jasmine and 
Mark at the Wildfowl and Wetlands 
Trust, Slimbridge, as we try our 
hand at bird photography in this 
month’s Shootout. It’s not easy! 
We also catch up with wildlife 
photographer and presenter Chris 
Packham ahead of his appearance 
at The Photography Show in March.
 And finally, don’t forget to cast 
your vote in the 2016 Digital 
Camera Awards. Turn to page 111 
to find out who the contenders are 
and how to vote for your choice.

this month’s star contriButors…

meet our cover photographer
Mika Linho is an an 
amateur photographer 
from Finland. He’s a 

software developer by profession, 
but photography has been his 
passion for more than 10 years.
 Mika uses professional-grade 
Nikon equipment, as his style of 
photography requires him to work 
in extreme conditions. “I look to 
capture unique bird portraits,” 

he says. “Water is a theme that 
runs through my work, and 
I will frequently include a bird’s 
reflection or water droplets in a 
picture. Backgrounds that are free 
of distractions are something 
I always strive for, too.”
 You can find out more about 
Mika’s cover image on page 12, 
and you can see more of his 
photos at www.linho.fi.

F
the Big interView
chris pacKham
Get an insight into how the presenter’s 
approach to photography has evolved

worK experience
will-Burrard lucas
Find out what the top wildlife pro 
wishes he’d known when starting out

Question master
andrew james
Andrew solves your photo problems, 
including a look at image resolution

lighting guru
scott KelBy
Discover how to make a softbox 
disappear for stunning results 

portfolio
anne maningas
Anne combines her two passions: 
photography and the Tube  

photoshop maestro
james paterson
James show how to create realistic 
composites with Perspective Warp

84

92

74

96

72

130

 
Ben Brain
Editor, Digital Camera
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Free  g iFts
e v e ry  i s s u e  w e  b r i n g  yo u  m o r e  F r e e b i e s  t H a n  a n y  ot H e r  p H oto  m ag a z i n e !

Learn how to make your 
photos even better with this 
free guide to Photoshop 
Elements. Discover layers, 
blending modes, selection 
tools and more, plus
creative techniques such 
as combining images with 
Photomerge Compose and 
adding effects with filters. 
You can download your PDF 
ebook now by typing this link 
into your web browser: 
www.bit.ly/elements-ebook

FREE! 223-page elements 
ebook

164-page 
Buyer’s  
guide

leVels 
& curVes  
eBooK

9 all-new 
tips cards

Our bumper buyer’s guide has 
all the advice you need to help 
you choose your next camera 
or lens. This edition of Camera 
Shopper is provided as a PDF 
ebook which you can 
download today via:    
www.bit.ly/dc174shopper

Master the fundamentals of 
tonal control with the help of 
this essential ebook. As well 
as complete guides to each 
command, you’ll discover an 
array of effects and tricks to 
try. This ebook follows on 
from the magazine.

Our popular tips cards offer 
pocket-friendly advice for 
photographers on the go. 
Keep them in your camera 
bag, ready to refer to them 
wherever you are. This 
issue’s collection follows 
the magazine, with tips for 
portraits, landscapes, depth 
of field and more.

9 Videos
Our videos take you beyond 
the printed page and give you 
even more essential image-
editing advice and tips. With 
this selection, you can explore 
the topics in your free Levels 
& Curves ebook and follow 
the techniques from this 
issue’s step-by-step Digital 
Darkroom tutorials. 
 Visit www.bit.ly/
dc174video now to watch your 
videos: this is a private web 
page available only to Digital 
Camera readers.

When you see this 
logo in the magazine, 
you can watch a 
related video via www.
bit.ly/dc174video. 
See below for details 
of our videos.

watch  
Video  
www.bit.ly/ 
dc174video
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10 Hotshots
Inspirational images from 

photographers around the world

20 in Focus
The new  

D5  and more

26 photo projects
10 creative ideas, tips, tricks 

and techniques to try this month

42 street photography
Fresh ideas that will revitalise 

your approach to this genre 

54 back to basics
Get to grips with a digital 

camera’s focusing controls

58 image analysis
Discover the secrets of 

lighting, composition and more…
 

66 shootout
Two readers join us at 

Slimbridge, armed with Sigma lenses  

72 portfolio
London Tube driver Anne 

Maningas on railway photography

74 photo answers
Andrew James rates your 

pictures and solves your problems

80 assignment
The winners of our theatre 

contest, plus a new challenge

84 Chris packham 
We talk to the wildlife TV star 

and photography competition judge

92 work experience 
New series starts this issue!

96 scott kelby 
Add intrigue to wedding shots

99 bluffer’s notes 
Lee Miller’s legacy 

127 Digital Darkroom
Get to grips with Photoshop 

and Lightroom with our expert guides

146 back issues  
Catch up on your reading

148 Desert island D-slr  
David Griffen on why he 

wants studios around the world

102 Fujifilm 
Xt-1 vs 

olympus e-m5 ii 
Two stylish retro CSCs 
go head to head

109 sony 
90mm 

f/2.8 macro 
Get the verdict on 
Sony’s close-up prime  

111 Digital Camera 
awards 2016 

Cast your vote for the 
best photography 
products of the year

114 group test: 
35mm 

prime lenses 
We test eight fast 
wide-angle primes 
that offer the perfect 
focal length for street 
photography and more  
  

122 mini-test: 
Drones 

Drone photography is 
on the rise – but which 
multi-rotor unit is worth 
your time and money? 
We take four popular 
models for a spin 

124 mini-test: 
Camera 

trigger systems
A round-up of devices 
that can fire your camera 
and flash when you’re 
not around 
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174

v i d e O S

P H OTO S H O P  g u i d e

Use Photoshop’s Levels command to 
make dramatic improvements to tones 
See page 4 of your ebook

Take precise control over the tones in 
your image with Photoshop’s Curves 
See page 8 of your ebook

Use Levels to enhance the colour 
and depth of a photograph 
See page 6 of your ebook

Enhance a portrait and add digital 
make-up with the help of Curves 
See page 10 of your ebook
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174

v i d e O S

Explore the techniques for sharpening 
up photos with the help of Lightroom 
Read the tutorial on page 128

Image-editing tips for 
Photoshop and Lightroom: 
see page 127 for contents

Use Perspective Warp to match the 
angles of objects from separate photos 
Read the tutorial on page 130

Explore the options offered by 
Perspective Warp in Photoshop 
Read the guide on page 131

Four different ways to select and replace 
a single colour using Photoshop 
Read the tutorial on page 136

Discover a simple but effective way 
to smooth skin with Photoshop 
Read the tutorial on page 132
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federico galeTTo, brazil       “The view was amazing and Fitz Roy Massif was leading 
everything. The wind was so strong that I couldn’t even stand without moving, so I decided that the tripod 
was not helping in this case. Losing this constraint helped to free my mind, and I lay down in the middle of 
the road to beat the wind. When I looked through my lens, I understood that everything was in the right 
place, and I shot.”
Kit Nikon D750 with Nikon f/1.8 50mm lens  Exposure 1/2,500 sec at f/9, ISO 100

SEND US  
YOUR SHOTS
Your photograph could 
appear here! Send your 

best recent shot to  
digitalcamera 

@futurenet.com 
(subject line: Hotshots)
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mika linho, finland       “I live in Pori, Finland, where we have one of the best wader birding spots, the 
Yyteri sand flats. I’d tried to shoot migrating waders on more than 20 occasions – my technique was to lie still next 
to small puddles, equipped with a full-camouflage Gore-Tex suit and a tent sleeping pad. The sanderling is a rare 
migratory wader in Finland, and usually hard to photograph. This time I was ready and waiting in the right place.”  
Kit Nikon D700 with 500mm f/4G ED VR lens and TC-E20 III teleconverter; 1,000mm effective focal length   
Exposure f/8, 1/640 sec at f/8, ISO 640
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mika linho, finland       “For many years I have been feeding birds during the long, cold Finnish winter.  
Wintering birds need a lot of energy for staying warm and surviving in the cold conditions. Maintaining the feeding 
station through the winter is a good way to help the birds. One winter I had a lot of European greenfinches at my 
feeding stations. Although I had many feeders, the one with the best nuts and seeds was always busy with many birds 
waiting to get there. Sometimes a fight broke out to determine who got the best bits…” 
Kit Nikon D4 with Nikkor 500mm f/4G ED VR lens  Exposure 1/3,200 sec at f/5, ISO 4,000

BiRDS Of 
a fEaTHER
Two Digital Camera 

readers join editor Ben 
Brain at Slimbridge 

to improve their 
wildlife photo skills  

see page 66
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alessandro cabras, iTaly       “This picture was taken at the Terrazza Mascagni, a very 
crowded place in Livorno. I waited for rain so it would be empty and the floor would look polished with a better 
contrast. It’s an abstract place, almost timeless – the long exposure for the sky helped to show this feeling.” 
Kit Canon EOS 450D with Sigma 10-20 DC HSM lens at 10 mm    
Exposure 1/25 sec, ISO 100; f/16 for the ground; 10 sec with ND filter for the sky
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pawel zygmunT, ireland      “The Cave is on the bottom of Downpatrick Head cliff (126ft, 39 m) and it’s 
usually filled with water. It can only be approached during the spring low tide. You have to climb down the cliff, walk for about 
300m on slippery rock shelves uncovered by ocean during low tide, then walk into the cave where you have a massive amount of 
wild water in front of you. You really get the feeling of how insignificant you are against the powers of nature.” 
Kit Nikon D750 with Tokina 16-28 mm f2.8 lens  Exposure 1.3 sec at f /22, ISO 50 
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pawel zygmunT, ireland     “Mount Errigal (2,464 ft, 751 m) near Gweedore in County Donegal, Ireland, is 
the most majestic mountain in this part of the country. I arrived at 11pm, parked my car between two lakes and fell asleep. In the 
morning I saw deer walking around my car but once I moved to reach for my camera, they were gone. I walked towards the lake and 
a few minutes later the sun started rising behind Errigal, giving clouds and mist in a bloody red colour. It was a perfect morning.” 
Kit Nikon D750 with Tokina 16-28 mm f2.8 lens at 16mm, 2-stop ND grad filter, 4-stop ND filter  Exposure 8 sec at f/22, ISO 100
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paul barson, usa      “This shows the style I developed to transform normal flower shots into evocative, floral 
portraits that give the subjects a soul and life all of their own. My work is shot in its natural environment, and this was taken on 
a windy day. Waiting a few minutes, watching the pattern of the wind, then firing off a number of shots ensured a blur-free shot.” 
Kit Canon EOS Rebel T3i with EF 100mm f/2.8 Macro USM lens  Exposure 1/320 sec at f/3.2, ISO 200

kaTrina parry, uk      “There is nothing my youngest son loves more than to play around our farm with our dog. 
This was taken one morning in golden hour natural light, with adjustments and colour enhancement in Lightroom and Photoshop.”
Kit Canon EOS 5D Mark III with Canon EF 135mm f/2.0L USM lens   Exposure 1/640 sec at f/2, ISO 125





Photography news from around the globe

We knew Nikon’s D5 would be exciting, but the announced specs look tremendous

s widely predicted, Nikon 
has used the giant CES 
technology show in Las 
Vegas to launch the D5, 

its new flagship SLR. This full-frame 
professional powerhouse replaces the 
D4S, a camera as legendary among Nikon 
fans as the EOS-1D X is in the Canon 
world. These are the top two cameras in 
the world for sports, action and press 
photography; the reputation of an entire 
brand rests on cameras like these.
What Nikon has done with the D5 is a 
mixture of careful development and 
astonishing technical achievement.

First, the new sensor. It has 20.8 
million pixels, just four million up on 
the D4S and some way behind the 
Nikon D810 and the Canon EOS 5DS. 
But the D5 is a very different sort of 
camera, designed for high speed and 
low light, for subjects where getting the 
shot is much more important than the last 
ounce of resolution. Pros will be pleased 
with four million extra pixels, but glad it’s 
no more – because they won’t want to risk 
losing high-ISO low-light performance.

Pros will also be impressed with the 
increase in continuous shooting speed, up 
fractionally to 12fps. It’s not much, but any 
gain is valued at this level – it could mean 
the difference between getting the big shot 
or not. 12fps is a big stretch for a full-
frame camera with a mirror and a focal 
plane shutter, so it’s possible we’re seeing 
the DSLR design pushed to its limit here.

The headline story though, is the D5’s 
new 153-point AF system, including 99 
cross-type sensors. Nikon’s been using 
and developing a 51-point AF system for so 

long that it’s become part of the 
photography landscape, but this new AF 
system is a giant leap forward. It remains 
to be seen how it performs in the real 
world – the 51-point system still performs 
brilliantly – but if the specs are anything 
to go by, it should be awesome.

The second big story is the D5’s 
sensitivity range. Its standard ISO range 
looks good but unremarkable at ISO 
100-102,000, but in ‘expanded’ mode 
it can go right up to an incredible ISO 
3,280,000. We don’t know what the image 
quality is going to be like at this kind of 
setting, but the fact that it’s possible at all 

is extremely impressive. This camera 
could practically suck the light out of 
a black hole.

The Nikon D5 can also shoot 4K video. 
It’s the first Nikon SLR to offer 4K – 
a pivotal moment for Nikon and its 
ambitions in the video market.

So yes, the D5 is a niche camera aimed 
at professionals, but it’s also an important 
flagship model for Nikon, and one that 
incorporates a mix of carefully planned 
development and what looks like jaw-
dropping innovation. The Nikon D5 will 
be available from March. 
www.nikon.co.uk; £5,200/$6,500
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1

New seNsor iNside
The D5’s 20.8MP sensor 
is designed to cope with 
high-speed subjects and 

low-light conditions.

2

New autofocus 
system iNside 
The D5 is Nikon’s 
first SLR to offer 
153 focus points.

D5 sensation
N E W  N I K O N  F L A G S H I P  S L R



Pocket 
rockets

PA N A S O N I C  C O M PA C T S

Panasonic has announced 
two new TZ-series travel 
cameras – small enough to 
slip into a trouser pocket but 
with big zoom ranges to 
make them very versatile.

But these aren’t just routine 
updates. The TZ80 (ZS60 in the 
US) takes the established design 
of the TZ range but adds a new, 
higher-resolution sensor, while 
the TZ100 (ZS100) speeds off in 
a whole new direction with a 
larger 1-inch sensor and – we 
hope – a big hike in image quality.

The TZ80 should appeal to 
traditional TZ travel camera fans 
looking for a compact, powerful 
and versatile camera with a wide 
zoom range, while the TZ100 is 
aimed more at enthusiast and 
experts who are willing to trade 
some of this zoom range for much 
better image quality.

In fact, the TZ100/ZS100 
looks like it will also straddle 
the high-end compact camera 
market, going right up against 
the  Sony RX100 IV and Canon 
PowerShot G5 X, but with a much 
longer 10x zoom range.  
www.panasonic.co.uk 

NIkoN ActIoN cAM
Nikon has marked its 
entry into the action 
camera market with 
the KeyMission 360, 
a wearable camera that 
records 4K UHD video 
around a full 360°. 
Nikon didn’t provide 
full specifications, but 
says the KeyMission 
360 features an image 
sensor and lens 
combination on two 
opposite sides of the 
camera. Images from 
each are combined 
in-camera to create 
a single high-definition, 
360° image. The 
camera is waterproof to 
depths of 30m and will 
be released this spring.
www.nikon.co.uk

NIkoN LeNses
The AF-P DX Nikkor 
18–55mm f/3.5–5.6G 
VR (£199.99/€259.00) 
and the AF-P DX Nikkor 
18–55mm f/3.5–5.6G 
(£149.99/€199.00) are 
the first Nikkor lenses 
to employ Nikon’s new 
Stepping Motor. The 
Stepping Motor 
promises to focus 
quietly and faster when 
zooming into a scene 
and shift focus from 
subject to subject with 
no drive noise. 

The new lenses  
employ two aspherical 
elements to help 
minimise spherical 
aberration and other 
forms of distortion. 
www.nikon.co.uk

Go to  
www.digital 

cameraworld.com  
for the latest 
NeWs, revieWs 

&techNiques

D500 REvEALED

TELE Tubby

Nikon’s best-kept secret for ces was the 
DX-format slr fans have been waiting for 

olympus unveils the 
world’s most compact 
telephoto lens...

N I K O N  A P S - C  S L R

O Ly M P u S  T E L E P H O T O

o everyone’s 
amazement, shortly 
after revealing its 

flagship FX-format camera, 
the D5, Nikon used CES to 
announce a new DX- format 
camera, the D500.

Chief among its features is the 
same 153-point AF system as the 
D5, with 99 cross-type sensors. 
With the Nikon D500, AF 
capability can also be extended 

lymPus has 
announced the 
M.Zuiko Digital ED 

300mm 1:4.0 IS Pro, which 
it claims is the world’s most 
compact and lightweight 
telephoto lens. Weighing 1.27kg, 
the 300mm f/1.4 lens is a quarter 
of the weight of most SLR lenses 
with equivalent focal lengths, 
and is just 227mm long.

Aimed at pros who shoot sport, 
wildlife or the performing arts, 
the Olympus 300mm f/1.4 
boasts a 1.4m focusing distance 
from subject to camera, with 
a maximum 0.48x zoom.

Along with its 600mm focal 
length (35mm equivalent), it 

down to -4 EV with the central 
point and -3 EV with all other 
points. The new Expeed 5 
image-processing engine helps 
deliver high-quality images from 
a native sensitivity range of ISO 
100 up to 51,200 (expandable to 
ISO 1,640,000 at the Hi 5 setting).

The Nikon D500 can also 
record 4K UHD (3,840 × 2,160)/ 
30p/25p/24p as well as 1080/60p 
video for up to 30 minutes, with 
simultaneous output via HDMI. 
It’s also possible to generate 4K 
UHD time-lapse movies within 
the Nikon D500.

On the outside is a touch-
sensitive 3.2inch tilting LCD. 
The camera’s touchscreen shares 
another feature with the D5 in 
the form of text input on images, 
and also enables you to use touch 
AF and touch shutter.
www.nikon.co.uk; 
£1,730/€2,330

t

o

offers an angle of view of 4.1° and 
a six-step image stabilisation 
system. What’s more, when used 
with Olympus cameras like the 
OM-D E-M1 or E-M5 Mark II, the 
new lens – released in spring – 
can achieve autofocus speeds of 
less than 300ms, Olympus says.
www.olympus.co.uk; £2,200
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That ISO range is 
meant for photography 
inside a black hole.
Kenneth Ellseth

I want a Nikon about 
as much as I want that 
price tag on my next 
camera. Which is about 
0% right now.
Justin Thiel

In terms of the 
South African Rand, for 

R,140,000+ (excluding 
the new memory 
cards, spare battery 
etc) you could buy a 
car, or 100,000 trees, 
a swimming pool or a 
business franchise 
with that money and 
still have money left 
over for a decent DSLR 
and a lens or two.
Blaize Pascall

Canon will have to 

up its game.
Chris Fox

Maybe I will get this 
for my birthday...
Dan Wong

How many stops is 
that 3 million ISO?
Dallin Tahere
 
Join the conversation at 
www.facebook.com/
digitalcameraworld

Have your say
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 Digital Camera asked: “What’s your 
reaction to the all-new Nikon D5?”

what’s new?I n  f o c u s
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stranD & Deliver
london’s v&a museum to host retrospective 
of legendary photographer Paul strand

N E W  E X H I b I T I O N

ondon’s V&A 
Museum will host 
the UK’s first 

retrospective in over 30 years 
of American photographer 
Paul Strand. It will showcase 
his efforts to popularise concepts 
in abstract photography and trace 
the images taken on his travels, 
beginning in New York in 1910 
and ending in France in 1976.

The V&A has made a number 
of new acquisitions especially for 

Nikon sB-5000 
speedlight
This is the world’s first 
compact flash unit to 
feature an on-board 
cooling system. At just 
420g, the SB-5000 
offers a guide number 
of 34.5 (ISO 100, m) and 
a wide FX-format zoom 
range of 24-200mm.
www.nikon.co.uk; 
£500/€659

sony HDr-As50
Sony’s new camera 
features an 11.1MP 
back-illuminated CMOS 
sensor and Zeiss 
Tessar lens offering up 
to 3x zoom, as well as 
two angle setting 
modes for field  
angle adjustment.
www.sony.co.uk

rounding up 
what’s new 
and exciting
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XF HIts A toN
1 0 0 M P  C A M E R A

Phase one has announced the Xf 
100mP camera system, which 
boasts a new full-frame, medium 
format 100-megapixel cmos 
sensor. Developed in collaboration 
with Sony, the sensor packs in an 
amazing 101,082,464 active pixels, 
supporting a native ISO range from 
50 up to 12,800 and exposure times 
up to 60 minutes. The camera also 
supports 16-bit colour, 15 f-stops 
of dynamic range and Live View 
capture with HDMI output.

Phase One launched its XF 
Camera System series last year, 
incorporating features like Honeybee 
Auto Focus, Vibration Tracking and 
Electronic First Curtain Shutter. 

The $49,000 price tag includes  
a Schneider Kreuznach 80mm LS 
lens. The camera is on sale through 
Phase One partners worldwide.
www.phaseone.com; $48,990

Go to  
www.digital 

cameraworld.com  
for the latest 
NeWs, revieWs 

&techNiques

BAILey HIts 
tHe stAge

P H O T O G R A P H y  S H O W

iconic photographer david Bailey 
is among the top industry names 
confirmed to speak on the super 
stage at the Photography show 
this march. Bailey will be joined by 
wildlife supremo Chris Packham, 
Dan Rubin, Nick Danziger, Peter 
Dench, Lara Jade and Alec Soth, 
plus many more to be confirmed.
Run by the makers of Digital 
Camera, The Photography Show 
runs from 19th to 22nd March at the 
NEC in Birmingham. Make sure you 
book your tickets soon, as sessions 
are already selling out!
www.photographyshow.com/
tsPrtickets

the exhibition, which come from 
Strand’s only UK project – a 1954 
study of the island of South Uist 
in the Scottish Hebrides. 

These images will be shown 
alongside 200 other objects, 
including vintage photographic 
prints, films, books, notebooks, 
sketches and even some of 
Strand’s own cameras. 

The exhibition will run from  
19th March to 3rd July.
www.vam.ac.uk/paulstrand

Panasonic 
telephoto zoom
Panasonic’s Leica DG 
Vario-Elmar 100-400mm 
f/4.0-6.3 ASPH is small 
and durable, offering a 
35mm-equivalent focal 
length of 200-800mm 
for a Micro Four Thirds 
camera. Using 20 
elements in 13 groups, 
it’s weather-sealed and 
uses a 240fps AF Drive.
http://eu.panasonic.
com
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X meters tHe spot
fujifilm unveils its new flagship camera, the 
X-Pro 2, with improvements in every area

N E W  F u J I F I L M  C S C

canon Powershot 
sX540 Hs
Boasting an incredible 
50x optical zoom and 
an ultra-wide lens, the 
Canon PowerShot 
SX540 HS allows you to 
capture a wide range of 
scenes. Inside is a new 
20.3-megapixel CMOS 
sensor and Canon’s 
latest Digic 6 processor. 
It can record full HD 
video in MP4 and uses 
five-axis Dynamic IS to 
keep footage steady.
www.canon.co.uk; 
£300/€420

samsung Portable 
ssD t3
Weighing just 50g, this 
palm-sized external 
hard drive offers 
multi-terabyte storage 
and write speeds of up 
to 450MB per second 
with a USB 3.1 interface.
www.samsung.
com/T3

Lexar 1800x 
microsD cards
Lexar’s Professional 
1800x microSDHC and 
microSDXC UHS-II cards 
offer read transfer 
speeds up to 270MB 
per second and  are 
available in 32GB, 
64GB, and 128GB 
capacities. Designed 
for high-speed capture, 
the new cards can store 
more than 15 hours of 
video, Lexar says.
www.lexar.com

rounding up 
what’s new 
and exciting
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he X-Pro 1 was 
Fujifilm’s first 
compact camera. And 

now, after four years and a slew of 
siblings, we have the X-Pro 2.

The sensor is a 24MP X-Trans 
CMOS III device, while the Dual 
Cortex A processor is dubbed 
X-processor Pro. Image 
processing is claimed to be four 
times faster. A new focal plane 
shutter enables a maximum 
shutter speed of 1/8,000 sec with 
a maximum flash sync speed of 
1/250 sec. The new shutter is 
quieter and produces less 
vibration than the X-Pro 1’s. 

Sensitivity is set in the native 
range of ISO 200-12,800, with a 
JPEG-only expansion setting of 
ISO 100 and raw file expansion 
settings up to ISO 51,000. 

Look out for our hands-on 
review of the X-Pro 2 shortly.
www.fujifilm.co.uk

t

focal
PoiNt

travel awarDs
marsel van oosten wins the prestigious  
travel Photographer of the Year 2015 award

C O N T E S T  R E S u LT S

arsel van Oosten 
has won the overall 
Travel Photographer 

of the Year 2015 award. The 
Dutch photographer beat out 
thousands of other entries from 
more than 110 countries with his 
black-and-white portfolio of eight 
images shot in Louisiana. Along 
with the other winners from 22 
countries, Marsel’s portfolio will 

be on display at The Museum of 
London Docklands over the 
summer of 2016.

Other winners included Chinese 
amateur photographer Xia Xuejun 
in the Portfolio category, while 
Australian Scott Portelli and 
Britain’s Timothy Allen shared the 
award for Best Single Image in a 
Monochromal portfolio.
www.tpoty.com/winners

m

NPs JoB

trevor coLe

J O b  O P P O R T u N I T y

C O R R E C T I O N

Fancy earning up to $100,000 
working in a job once filled by the 
inimitable ansel adams? The US 
Department of the Interior is looking 
to hire a photographer to follow in 
the master’s footsteps.

To celebrate its 100th year, the 
National Park Service is seeking 
a photographer to document its 
railroads, buildings and landscapes.

The NPS requires applicants to 
be skilled in “the principles and 
techniques of large-format black-
and-white photography”. The NPS 
wants images in both digital and film 
format, and the work will join Adams’ 
among the permanent collections at 
the US Library of Congress.
www.nps.gov

in issue 170 we wrongly attributed 
the above image from our ‘colour 
Blue’ assignment. This image was 
the Crowd Vote winner and should 
have been credited to Trevor Cole. 
See more of Trevor’s work at www.
photocrowd.com/accounts/17812
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Pho t o 
P ro jeC t s

10 fresh and creative ideas to  
try – from fisheye forests 

to portraits at dawn…

go on a back-yard safari
Capture close-up shots of wild animals and birds in the dead of night

P r o j e C t  1

Y
ou don’t have to lug 
a long lens halfway 
around the world to 

bag prize-winning pictures 
of wildlife. Why not follow 
the lead of European Wildlife 
Photographer of the Year, 
Richard Peters? He set up 
camera traps in his garden 
and went on to win the Urban 
category of the Wildlife 
Photographer of the Year 
competition with the results.
 For this image, Richard used 
a Nikon D750 and a Nikon 
18-35mm f/3.5-4.5G lens, 
along with three Nikon SB-28 

flashguns, a Pixel Componor 
flash off-camera cord and a 
Camtraptions passive infrared 
motion sensor. “It’s a 
technically difficult shot,” he 
says. “The long exposure for 
the stars has to be combined 
with flash and a subject that’s 
constantly on the move, which 
increases the risk of ghosting. 
I ended up using an exposure of 
30 seconds at f/9, ISO 1,600.”
 Setting up on your own patch 
gives you the time to tempt 
animals into the right position. 
At least, that’s the theory. “I use 
peanuts and fresh water to 

encourage badgers, foxes, 
pigeons, jays and jackdaws 
in the garden,” says Richard, 
“although there is an element 
of uncertainty as they never 
regularly walk past the camera 
in the right position or from the 
right direction.
 “Garden birds have had no 
issue with the camera, but it 
took three or four weeks for the 
badgers and foxes to adjust to 
the sound of the shutter.”

See Richard’s garden wildlife 
photography guide at www.
richardpeters.co.uk/ebook



explore 
environmental 

portraiture 
Make the landscape 

a key feature 

P r o j e C t  2

nVIronmental portraits add 
much more conceptual content 
than a standard studio backdrop. 

Technique writer Tom Welsh has been high 
on the Anoach Eagach ridge in Glencoe, 
Scotland, to demonstrate shooting a winter 
portrait of a mountaineer, out in the hills.
 “When composing an environmental 
portrait, whether on a mountain ridge or in 
a blooming garden, consider the framing of 
the landscape before positioning your model 
within it,” says Tom. “If you’re using a wide 
lens, for the most part you’ll want to keep the 
person close to the camera so that they don’t 
appear too small and lost in the frame; or 
in our case, frame them against a clean 
backdrop or the horizon in order to make 

them stand out. If you’re faced with steep 
terrain, as I was here, try to stay level with 
your subject, as looking up or down at them 
will appear to flatten slopes.
 “Along with the technical requirements 
of shooting an action portrait, such as fast 
shutter speeds, continuous focusing and 
high-speed drive mode, shooting in winter 
requires additional attention when it comes 
to exposure.
 “Automated shooting modes can treat 
the white as a midtone, resulting in darker 
exposures, and slightly grey snow. Use your 
exposure compensation to brighten up the 
images, and check the histogram; it should 
stretch into the right side of the graph 
without falling off the end.”
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take a low view
Use a fisheye or ultra-wide lens to create eye-catching shots of a forest

HIle anyone can 
wander into a wood, 
point their lens 

skyward and snap a canopy 
shot, developing an eye 
for a more appealing 
arrangement of branches 
can be challenging. “I often 
look for an unbroken area of 

canopy to create a repeating 
pattern,” says nature pro Alex 
Hyde. “This helps to block out 
large areas of distracting sky. 
I also prefer beech woodland 
for this type of shot, as each 
tree seems to have its own 
particular snaking, flowing 
form rather than the more 

regimented straight trunks 
one associates with many 
coniferous woodlands.”
 For the greatest impact, 
lie on the ground with a 
wide lens, but watch out for 
distractions at the edge of the 
frame. “My Canon 8-15mm 
fisheye gives outrageously 

wide coverage at 8mm,” says 
Alex. “Sometimes when I am 
lying on my back I accidentally 
get the tips of my boots in the 
picture, and I often have to 
hide my camera bag behind 
a neighbouring tree or risk 
that showing up, too.”
www.alexhyde.co.uk
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P r o j e C t  3
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Play with 
shadows 

Include bold, black 
shapes to add intrigue  

P r o j e C t  4

P h o t o
P r o j e C t s

ometImes it pays to look the 
other way. When you’re shooting on 
a sunny day, rather than focusing on 

the fine details of a subject, turn around and 
see how you can use the shadows being cast 
as a creative compositional device. As with 
silhouettes, a strongly defined shape works 
well, and there are plenty of ways in which 
you can use them to either darken or lighten 
the mood. A shadow project is gear-agnostic 
too, as you can shoot shadows regardless of 
the camera or lens you own – although some 
degree of exposure adjustment will help you 
control the density of the shadows.
 Even a phone will do. Street photographer 
Foad Ashtari used an iPhone 6 to shoot this 
striking scene where the shadows tell the 

story. “I was walking in a park in Tehran and 
suddenly I noticed a van in which there was 
a horse,” Foad explains. “The van came to 
a halt and two men came out. One of them 
went inside the van, while the other held the 
rope which was around the horse’s neck and 
tried to pull it out.
 “I took four or five shots of the horse and 
the men next to it, before I noticed the 
shadows on the wall. I realised the potential 
was there for a good shot.
 “I sat next to the van, looking at the wall 
and waiting for the best moment. I guess it 
took around five minutes before they could 
get the horse out, and I was sitting there with 
my back to them the whole time!”
www.instagram.com/foadashtari
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Hoose reflections 
as the theme of 
your next photo 

project, and you’ll be 
challenging yourself 
technically as well as 
creatively. Include a large 
expanse of pale sky as part 
of the reflection, for example, 
and you’ll have to keep a 
close eye on the histogram 
if you’re to avoid problems 
of underexposure. You’ll also 

have to find an angle that 
doesn’t see your own image 
reflected back at you.
 The urban environment 
offers lots of potential for 
this type of photography. 
Take a standard zoom on 
your next photo walk and 
look for creative ways in 
which you can contrast an 
interesting reflection with its 
surroundings, or shoot with 
abstract images in mind. 

shoot 
at dawn 

Photograph a portrait 
as the sun begins to rise

Focus on reflections  
Take a new look at the urban landscape 

eInG out and about 
early to catch the 
best light isn’t only 

good for your landscape 
photography. A crisp sunrise 
can also form the perfect 
background to a portrait – 
if you’re persuasive enough to 
get a model to join you at the 
sharp end of the day, that is.

Keep it local, as Luca 
Simonetti did for this image, 
so you can take advantage of 
rapidly changing conditions. 
“I plan everything in detail 
in advance,” explains Luca. 
“Checking the weather 
forecast consumes much of 
my time, as I try to figure out 
the chances of catching a 

perfect sunrise. But the most 
challenging thing about taking 
pictures early in the morning 
is timing. You need the model 
to be on time, ready for the 
shoot, as you generally only 
have around 20 minutes 
before the best light’s gone.”
www.instagram.com/
luca0312.ph
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have fun with 
perspective 
Try making large objects 
appear small in the frame

go wide 
up close
Take macro shots 

with wafer-thin depth

PeCIalIst macro 
lenses are among 

the sharpest optics 
available, able to resolve 
incredible detail across 
a picture. But why not try 
something a bit different 
this month? Dial in the 
widest aperture available 
on the lens (typically f/2.8) 

and get in close, selectively 
focusing on one part of a 
subject and allowing the 
rest to fall into blur. This 
technique can produce 
great results with delicate 
subjects such as flowers 
and food, but can also 
create abstract pictures of 
cutlery, kitchen utensils 

and other everyday items. 
The image displayed in 
the viewfinder is always 
shown at the lens’s widest 
aperture, making it easy to 
judge the overall effect, 
but it pays to use the larger 
Live View screen as an aid 
for manually focusing with 
absolute precision.
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HIs project is 
great training for 

your photography brain. 
Can you frame a shot so 
that an object appears 
much smaller than it is 
in reality? Or do the 
opposite: make a small 
object look really big? 
 The trick here is in 
selecting the right lens for 
the job. Longer focal 
lengths will ‘pull’ distant 
objects in, making them 
appear to be on a similar 
plane as objects that are 
closer to the camera. 

Wide lenses do the 
reverse, making objects 
in the background appear 
much farther away and 
smaller in the image. 
 ‘Forced perspective’ 
photography exploits this 
trait. It’s typically used to 
show people interacting 
with objects that are 
in the foreground or 
background – such as 
appearing to prop up the 
Leaning Tower of Pisa. 
But it’s a useful trick for 
creating interesting 
framing elements, too…

T
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geometric city
Get back to building block basics 

He next time 
you’re lining up 
a city view, look for 

geometric shapes to help 
build stronger images. 
“I was scouting around the 
Thames for architectural 
subjects when I came across 
this view of the Tate Gallery’s 
chimney and the Shard glass 
tower,” explains Stavros 
Charisopoulos. “What drew 
me to it was the perspective 
of the two buildings and the 
negative space created at the 
centre of the composition.
 “My intention was to 
emphasise the competitive 
relationship between the two 

buildings, and also to take 
advantage of the strong 
dark geometric shape of the 
granite seawall on the left. 
I used an ND filter and a long 
exposure to create a milky 
effect on the water, as well 
as in the cloudy sky.”
 “When I converted the 
image to black-and-white in 
Photoshop, I did it with the 
intention of creating a path 
through the image for the 
viewer. I increased the 
contrast to enhance the 
geometric shapes of the Tate 
chimney and the white space 
of the water underneath.
stavroscharisopoulos.com
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shoot a 
long-lens 

landscape 
Use a telephoto zoom 
to frame tighter shots

IDe-anGle lenses 
may be the go-to kit for 
scenic photographers, 

but the reach offered by a 
telephoto zoom can bring 
frame-filling impact to your 
landscape portfolio. 
 It can be easier to compose 
‘cleaner’ landscape shots with a 
long lens, as their narrower angle 
of view enables you to crop out 
distractions. You’re able to isolate 
interesting features, textures and 
tones, and the manner in which 

long focal lengths ‘compress’ a 
scene can be used as a creative 
compositional tool as well. If you 
want rows of hills or mountains to 
appear tightly stacked together, 
a telephoto lens is the way to go.
 For the sharpest results, you’ll 
need to mount a long lens, rather 
than the camera, on a stable 
tripod and head. Even then, their 
larger size makes them prone to 
picking up vibrations in breezy 
conditions, so be prepared to act 
as a wind-break for your set-up.

W

Step
 
Filters go hand in hand with 
landscape photography. Using 
a square filter system may be more 
cost-effective, as you only need one 
set of filters and a range of adaptor 
rings to fit them to both your 
wide-angle and telephoto lenses.

1 Step
 
If you’re using a strong ND filter such 
as the Lee Big Stopper, remember to 
shield the viewfinder to prevent 
stray light from entering here and 
creating hotspots in the image. Use 
the Live View monitor to compose 
and focus with the filter fitted.

2 Step
 
If you prefer to use the viewfinder 
when you’re taking a photo, 
remember to activate the camera’s 
mirror lock-up feature. If you don’t 
do this, you risk vibrations from the 
movement of the mirror robbing the 
image of some of its sharpness.

3 Step
 
With mirror lock-up enabled, you’ll 
need to trip the shutter with a 
remote release in order to avoid 
nudging the camera. A lockable 
remote is also essential when you’re 
using Bulb mode for long-exposure 
landscapes, too. 

4
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digitalcamera@ 
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MeMber FrOM 
JUST 

£48!

J O i n  O U r  b r i L L i A n T  n e W 

It’s more than a subscription: get your favourite magazine, gifts, 
discounts and more. Discover the benefits of being a member…

OPTiO
n 1

Discover the benefits 
of joining Photo Club…
Become a member to enjoy 
13 issues of Digital Camera 
per year, access to our 
members-only site for extra 
content – and much more! 
Recommended Retail PRice: £252

Our Member package includes:
magazine A one-year subscription to 
Digital Camera (print; 13 issues a year)
website Extra content, free ebooks and 
video tutorials on our members-only website
handbook A best-selling handbook, 
sent to you once a year
dVd A free DVD guide with expert tips and 
tutorials, sent to you once a year
offers Discounts from partners including 
Adobe, Vanguard, Kamkit and more

P H O T O  C L U b

plus 
MeMberS 

OnLy 
WebSiTe

40            D i g i TA L  C A M e r A        MarCh 2016 www.digitalcameraworld.com



Free giFT for new members!
The Lumimuse 3 is a  220-lux rechargeable LED 
light is ideal for shooting low-light portraits. Unlike 
a standard flash, you can see the effect of the 50° 
beam of light as you frame, making fill-light effects 
a cinch to set up. The compact pocket-size design 
can fit on your 
camera hotshoe – 
but it’s perfect for 
off-camera strobist 
effects too.

JOin PHOTO CLUb TODAy!

Terms and conditions: Prices and savings quoted are compared to buying full priced UK print and digital issues. You will receive 13 issues in a year. If you are dissatisfied in any way 
you can write to us or call us to cancel your membership at any time and we will refund you for all unmailed issues. Prices correct at point of print and subject to change. Gift is 

subject to availability. Please allow up to 60 days for the delivery of your gift. In the event of stocks becoming exhausted, we reserve the right to replace with items of a similar value. 
For full terms and conditions please visit: myfavm.ag/magterms. Offer ends 26th March 2016

Our Member Plus package 
includes all the benefits 
of being a Member, plus:

digital A one-year Digital Camera 
subscription (iOS or Android)
gifts Manfrotto and Lowepro gifts
binder A magazine binder to store 
your print issues

Recommended Retail PRice: £368

Our VIP package includes all 
the benefits of Member and 
Member Plus, along with: 

adobe 1-year membership to 
Creative Cloud Photography plan
show Entry to The Photography Show
Critique An expert portfolio critique 
gifts More Manfrotto and Lowepro gifts 
Recommended Retail PRice: £541

www.myfavouritemagazines.co.uk/dcmclub16

MeMber PLUS ViP

FrOM  
JUST 

£252!OPTiO
n 2

OPTiO
n 3

FrOM  
JUST 

£108!

www.digitalcameraworld.com  MarCh 2016       D i g i TA L  C A M e r A             41



C o v e r  s t o r y
M

ai
n 

im
ag

e:
 M

ic
h

ae
l E

rn
es

t 
S

w
ee

t

st r e e t s

Sav e
o u r

Is the internet helping street 
photography – or killing it? 

Michael Ernest Sweet offers 
a provocative personal view

treet photography is on fire, to say 
the least. But is any of it any good? More 
importantly, is it of any consequence? How 

can you make engaging, unique street images 
when everything has already been shot? Are 
workshops and endless rules of any value? 

I’ll attempt to candidly answer these questions, 
as well as get you started in meaningful street 
photography. We’ll take a whirlwind tour of how 
I developed my own style. It wasn’t easy and 
I certainly failed along the way, but now I can 
produce street photographs that not only break 
free of clichés, but consistently sell worldwide.

S

What is street photography?   page 44
A brief history of street photography 46
What’s wrong with today’s photos 48
Why you should be wary of rules 50
Hit the streets and be unique 52
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MicHAel 
ernest sWeet

Photographer, writer 
and teacher

Michael is known for 
his close-up, gritty, 
black-and-white street 
photography, as well 
as his low-fi work with 
disposable and toy 
cameras. In 2012, he 
published his first book 
of photography, The 
Human Fragment, 
and followed it up with 
Michael Sweet’s Coney 
Island in 2015.
www.michaelsweet 
photography.com
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The qualities that make an image into a 
street photo are broader than you think
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here has been a lot of 
discussion lately about 
what constitutes a street 

photograph. Is it just a photo taken 
on the street, or is there more to it?

“Street photography is photography 
that features chance encounters and 
random accidents within public 
places,” suggests Wikipedia. “It does 
not necessitate the presence of a street 
or even the urban environment. 
Though people usually feature, street 
photography might be absent of 
people, and can be an object 
or environment where 
the image projects 
a decidedly human 
character in facsimile 
or aesthetic.” 

Look around
This definition helps 
us understand what 
we are trying to create 
in a street photo. Note 
that a street itself is not 
required; nor is a person. 
Pushing beyond obvious elements 
will allow your work to stand above 
the plethora of street photos out there.

Don’t just photograph someone 
walking down the sidewalk. Look for 
unusual locations – alleys, country 
roads, parking lots; the county fair or 
the barber shop. Even a grocery store 
could be interesting.

Try making some images that 
imply a human presence, but don’t 
directly depict people. This is hard, 

What is  
street  
photography?

Perhaps this has more to do with 
distancing themselves from the 
quantity of underwhelming street 
photography out there.

But the question is a valid one. 
Documentary, street and portrait 
photography intermingle and even 
produce hybrid photographs. Some 
of this work can be the most engaging. 
Perhaps a new category is needed, or 
rather a new way of speaking about 
this genre? Maybe a term like public 
photography would be more suitable.

So what does all this mean? It 
means that you can make great street 
photographs, and bend or even break 
the rules in doing so. More on rules 
later. For now, know that wherever you 
are, whatever your subject, you can 
excel at street photography. 

Street tip 
Pay no attention to rules. 

Shoot intuitively. Live 
with your photographs 
for a bit before showing 

them to the world.

but can pay off handsomely when you 
nail it. William Eggleston has done so 
famously in his work.

Many people can feel discouraged 
from trying street photography if they 
don’t live in a big city like New York or 
London. Don’t worry: there are many 
great photographs waiting to be taken 
in rural locations. Mark Cohen made 
a whole career out of chronicling the 
Pennsylvania town of Wilkes-Barre. 

One area of contention is whether 
you can ask a person to pose 

for a street photo. A lot of 
self-proclaimed street 

photography gurus insist 
that you cannot, that 

a street photo must be 
candid. If only it were 
that simple.

What is ‘candid’? 
Does an unspoken, 
tacit agreement 

between photographer 
and subject count? If not, 

what about Vivian Maier, 
regarded as one of the best street 

photographers of the 20th century? 
Much of her work was produced by 
approaching a subject and engaging 
them in a non-verbal pact. 

a LabeL iS juSt a LabeL
One of the most sobering questions of 
all is whether the street photography 
label is even needed. There seems to be 
a movement where people who called 
themselves street photographers are 
distancing themselves from this title. 

Don’t just photograph someone on the sidewalk. 
Look for unusual locations – alleys, country roads, 
parking lots; the county fair or the barber shop. 
even a grocery store could be interesting

T



left  Michael says: 
“Don’t be afraid to tilt 
the camera at weird 
angles to get the shot.”

Below left  “This shot 
was made by leaning 
about two feet directly 
over the man. Speed is 
essential to pull it off.”

Below  “Sometimes 
I like to make a cameo 
appearance, it adds 
interest and symmetry 
to this photograph.”
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Street tip 
Buy a 35mm disposable 

camera and hit the 
streets for an afternoon. 

The freedom from 
camera settings will 

be exciting. Have fun!

A
ll 

im
ag

es
:  

M
ic

h
ae

l E
rn

es
t 

S
w

ee
t

C o v e r  S t o r y



any people run out, 
buy a camera and hit 
the streets. This is OK –  

you might even get lucky and make 
some great photographs – but being 
an artist, at least in the traditional 
sense, is a lot more work than that!

One important element is knowing 
some of street photography’s history, 
and figuring out where your work fits 
in. Imagine joining a conversation 
without knowing anything that was 
said before you joined in. Making art 
or photographs is no different.

So here goes: the quick and dirty 
history of street photography. Like all 

Become familiar with some of the work that came before you, 
and you’ll start to understand where you belong

a Brief history of 
street photography

history, clearly demarcated lines exist 
only in textbooks, but it is usually 
accepted that Eugene Atget is the father 
of the genre. He worked the streets 
of Paris from the 1890s to the 1920s, 
establishing the street as a meaningful 
location for photography. 

Atget’s photos consisted mainly of 
non-human subjects. Yes, the father 
of street photography made street 
photographs without people. So why is 
it so hard (and even discouraged) to do 
so today? A quote from Susan Sontag’s 
wonderful book On Photography will 
help us understand. “Photographic 
seeing has to be constantly renewed 

with new shocks, whether subject 
matter or technique, so as to produce 
the impression of violating ordinary 
vision,” she writes. In other words, 
pictures of parks, store windows and 
other non-human street subjects 
became too familiar to us to disrupt 
how we saw them. We are now in 
danger of having street photos of a 
person fall into the same fate. 

the deciSive moment 
The next big name to enter the scene 
would be Henri Cartier-Bresson, with 
whom nearly every photographer is 
familiar in some way. He was one of the 
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Opposite page 
Henri Cartier-Bresson 
brought timing and the 
human element into 
street photography.

left 
Bruce Gilden’s 
spontaneous, flash-
driven style has been 
much-imitated.

Below 
Constantine Manos 
seeks out interesting 
situations before he 
starts photographing.

first to focus on human action in the 
streets and to shoot what he termed 
“the decisive moment”.

This is the idea that there is a 
‘perfect’ moment to take a shot in any 
unfolding human scene on the street. 
A split-second before or after this 
instant will diminish the aesthetic 
value of the photograph. I feel it is 
sometimes useful, but not universal 
in its application. The moment that 
appeals to my aesthetic taste may be 
quite different from yours. To suggest 
that there is an objectively definable 
correct moment may be difficult to 
establish, to say the least. Regardless, 
the concept has stuck and remains 
a central contribution to the genre. 

Next, enter Robert Frank. He was 
a member of the New York School, a 
group that helped to popularise street 
photography in the United States. 
Frank’s The Americans (published 
1958) is one of the most popular and 
best-selling street photography 
monographs. These photos had an 
edgy, often haphazard quality that 
challenged the world of photography at 
the time. It was arguably the moment 
that gave birth to what we would term 
street photography today – raw, 

candid moments of people doing 
everyday things. 

modern timeS
Later street photographers to achieve 
fame were usually direct descendents 
of Frank. I would single out three for 
making noteworthy contributions to 
street photography that remain hot 
topics for debate.

Gary Winogrand should be 
considered the father of a popular 
technique with street photographers 
today: ‘machine gun’ photography. 
Although he used 35mm and simply 
wound on and shot rapidly, contrasted 
with today’s burst modes, the 
two are really the same. 
This way of working 
comes under attack 
from those who claim 
that good photos 
emerge more by 
chance than by skill.

Mark Cohen was 
among the first to 
make ‘no finder’ shots 
– no viewfinder, no 
careful framing. Again, this 
technique comes under fire for 
leaving much to chance.

Joel Meyerowitz saw in 
the use of colour film 
in street photography. 
Once more, it’s an 
issue that is still 
largely debated: is 
a colour photograph 

a true street photo? Of 
course it is, but not for 

the purist who lives in an 
age of black-and-white film 

photos. I find this argument amusing. 
Somehow mono images are supposed 
to be superior in conveying reality, 
despite the fact that we see in colour. 

These are just starting points. Look 
up some of the names I’ve mentioned, 
and you will quickly find yourself 
submerged in all the history of street 
photography you could ever want.
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Street tip 
Get off the screen and 
make prints. They’re a 
safer bet for archiving  

treasured images – but 
more, they will resonate 

with you differently.
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Constantine Manos / Magnum Photos

Know some of street photography’s history, and 
figuring out where your work fits in. Imagine joining 
a conversation without knowing anything that 
was said before you joined in
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The internet has made street photographs more 
popular than ever – and it’s killing them

Contemporary 
street  
photography
has no Clothes

e now have a sense 
of what a street photo 
is, and some broad 

understanding of the history 
of the genre. Let’s turn our 
attention now to where things 
started to go wrong. 

Street photography has 
become such a popular 
pastime that the genre 
produces hundreds of 
dull, clichéd candid 
images of people by 
so-called street 
photographers every 
day. Is that shot of 
someone’s granny on 
her grocery run making 
the rounds on Facebook of 
any artistic value? Does this 
kind of image bear any relation to the 
work of Cartier-Bresson or Frank? 

I’d argue that it doesn’t. Not only 
has the content of the image become 

worn out to our eyes (thanks to our 
visual culture, where everyone has 
a camera in their pocket), but the 
vision behind the image is also 
lacking. Much of what we call street 
photography today is in for a serious 

moment of truth. The emperor 
isn’t wearing any clothes. 

heat, but no Light
One of the greatest 
issues is a compound 
problem: there is no 
barrier to entry and, 
once in, there is no 
exposure to criticism. 

Let me explain.
Today, all one needs 

to be a street photographer 
is a camera, even a mobile 

phone, and a platform to publish on 
– Facebook, Instagram, or a website. 
Things weren’t so easy for Frank, 
Winogrand or even Bruce Gilden. 
They had to invest in the idea of 
making street photography. Then they 
had to subject their work to critics and 
publishers, who were much harsher 
than your Facebook friends.

These critics were expressing 
criticism, not merely personal taste. 
They understood the history of 
photography and the philosophy of 
aesthetics, and situated the work 
within (or expelled it from) that larger 
conversation. Today, we just count 
Facebook Likes and accept that as 
an expression of artistic worth. Truly 
a case of the blind leading the blind, 
and it’s beginning to show.  

So why does all this bad street 
photography exist? The answer isn’t 
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Street tip 
Broaden your knowledge 

beyond street photos. 
Read about art, cinema 
and pop culture. It will 

show in your work more 
than you imagine.

simple, but let me attempt to illustrate 
what’s going on. People grab a camera 
(a small investment in today’s terms), 
hit the streets, and haphazardly make 
photographs of strangers doing, well, 
usually nothing. They come home, sort 
through their 9,000 frames, and pick 
out a couple they think are good. They 
post these online, sit back and wait.

Next, their friends or ‘followers’ hit 
the Like button. Then the trolls, often 
people who are jealous of the attention 
someone gets, come along and throw a 
little shade. The comment wars break 
out. None of this has anything to do 
with the aesthetic quality of the photo. 
At best, someone might express their 
personal taste – “I don’t like the photo” 
– but, sadly, this is of little value. There 
is no true criticism anymore. This is 

There is a plainness 
we are seeing in street 
photography that is 
unintentional – there is 
simply no artistic vision

W



Opposite, bottom  
“Sometimes less is better. 
More here would have 
resulted in a clichéd 
Times Square photo.”

left  “The photo that 
started it all for me with 
the ‘human fragment’ 
theme. Try capturing 
bits of people without 
exposing flesh.”

Below left  “This was 
made without stopping, 
exemplifying the 
impressive speed of 
Ricoh GR cameras.”

Below  “Not all street 
photos have to be void 
of interaction. Approach 
someone and chat with 
them – just keep your 
finger on the shutter!”
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how so many banal, over-worked 
images appear in our lives.

Now, please don’t misinterpret my 
words. You can make truly engaging 
banal street photographs. William 
Eggleston does. But there is a plainness 
we are seeing in contemporary street 
photography that is unintentional – 

there is simply no artistic vision 
behind it. The difference is immense. 
Simply take a look at Eggleston’s work 
to immediately see what I mean. He 
shows us the banal in a way that 
renews our way of seeing. 

Finally, there is the issue of editing. 
Seemingly no-one edits their work 

anymore, at least in the current street 
photo community, where it is common 
for a photographer to upload a dozen 
or even two dozen images a day! This is 
simply not sustainable – not as art, 
anyway. And if we’re not making art, 
we need to ask ourselves what it is we 
are doing. 
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As more people take up street photography, more are keen to 
learn. Just be careful about who you choose to learn from

street photography
rules are DumB

Above  “One of my 
all-time favourite photos. 
I love blur. I love dogs. 
I learned to live with the 
crossed eyes.”
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ne unfortunate side-effect 
of the street photography 
craze is the plethora of people 

trying to make a living from teaching 
the genre to the never-ending train 
of newbies. The problem is most of these 
teachers are uniquely unqualified to be 
teaching. They are not only making up 
stupid content to teach, but are also causing 
monotonous repetition in the genre.

One of the most popular things for these 
workshop leaders to do is to peddle a rule. Do 

this, don’t do that. But following rules doesn’t 
produce art – not good art, anyway. What 
informs art the best is familiarity with, and 
careful contemplation of, master artists and 
their work. Study the arts if you want to be 
an artist, rather than forking over hundreds 
of dollars to listen to some inexperienced, 
self-fashioned expert read off a list of dos 
and don’ts in a workshop. 

So what are these rules? Do any of them 
hold up? I took a look around the internet, 
and here’s what I found…

Michael Ernest Sweet

O



Eight guidelines you might find in workshops  
or online – and how you can do better

t h e  ‘ r u l e s ’  o f   st r e e t 
p h oto g r a p h y   D e B u n k e D
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1  “When in doubt, 
ditch it”

Many treasure troves of unpublished 
negatives have been found in the 
estates of master photographers. 
Some of these, which the photographer 
initially second-guessed, have become 
highly popular images. Furthermore, 
we have learned a great deal about 
already-famous photos by looking at 
the surrounding images on contact 
sheets. Ditching everything except 
your very best will leave little in your 
lifetime archive. It may also deprive 
posthumous study of your work, 
should it arouse such interest.

Also, what you think is a bad photo 
today may change. Time almost always 
smiles favorably upon photographs. 
As Susan Sontag claimed in On 
Photography: “Time eventually 
positions most photographs, even the 
most amateurish, at the level of art.”

2  “never, ever crop”
Has anyone ever looked 

at the contact sheets of famous 
photographers? All they seemingly did 
was crop! If you take a fantastic image, 
but there is a tiny bit of construction 
barrier or part of a stray head along the 
edge of the frame, for instance, are you 
really expected to leave it because 
some workshop leader told you to 
never crop? Nonsense. Crop away!

The point, perhaps, is that you 
should not rely on cropping to make 
good images. Cropping is just another 
tool in the post-processing toolbox; you 
shouldn’t be afraid of using it in the 
right situations and in the right way.

3  “post-process a 
photo until it looks 

about 80 per cent good, 
then stop”
Huh?

4  “photographs shot 
on film are more 

respected than digital”
No, good photographs are more 
respected. This is just another lame 
attempt to justify the use of film. Film 
photography is different from digital. 
Neither is better than the other, just 
different. Try both. Experiment.

However, be warned: 35mm film is 
going to die, at least at the consumer 
level. This is not a debate anymore. 
Not only are most 35mm cameras no 
longer produced (nor parts for them), 
but the cost of developing film is 
increasing exponentially and rapidly.

5  “never shoot in 
program or auto”

Why? Shoot with whatever mode 
allows you to capture the moment 
best. Besides, P mode stands for 
Professional, not Program.

6  “shooting film helps 
the editing process”

No, silly, learning to edit helps the 
editing process.

7  “street photography 
is all about getting up 

close – really close”
OK, there is some wisdom here, but far 
too many street photographers take 
this rule way too seriously. Street 
photography is not defined (or should 
not be defined) by blowing a flash six 
inches from someone’s face. You’re to 
blame for this one, Bruce Gilden!

Before someone points it out, yes, 
I too am guilty of this technique. But 
does every good street photo have to 
be so claustrophobic? Back up a bit. 
Show us the rest of the story. Cartier-
Bresson was, generally speaking, not 

all that close. And when Robert Capa 
mentioned getting closer, he was not 
talking about six inches.

Contemporary street photography 
(in a lot of instances, but not all) is 
getting more intrusive. It’s reached 
the point where it is not improving 
street photography, but rather 
causing a lot of imitation, which leads 
to tired images. Don’t follow a rule to 
make an image: follow your gut. You 
can follow your heart too. Not all 
street photography needs to be so 
raw and grotesque. There are other 
ways of shocking the senses.

8  “avoid confrontation 
when shooting 

street photography”
Now they’re just taking all the fun out 
of it! On a more serious note, there 
could be some good advice here. It 
also goes hand in hand with getting in 
so close. All the conflict and intrusion 
we are seeing reflected in much of 
contemporary street photography is 
largely responsible for the increasing 
cries to criminalise the genre.

There is a big divide between being 
legally allowed to take someone’s 
photo and having their tacit 
permission to do so. If someone 
displays discomfort with your lens 
being aimed in his or her direction, my 
advice is to back off. Is it really worth 
it? Would you like it? 

OK, this is not a rant against street 
photography workshops – not 
really. I am, however, offering 
a warning to beginner street 
photographers: there are people 
eager to take your money. Avoid 
workshops unless your aim is to 
become a copy of someone. Study 
photography as an art, not a 
science. Look at the work that 
came before you. Follow 
inspiration, not rules.

C o v e r  S t o r y
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iscouraged? Don’t be. 
Street photography can 
be a lot of fun, and there 

are still distinctive photographs 
to be made. To make good street 
photography in the visual age, you 
will have to both learn the history of 
photography and develop your own 
style within that conversation. It’s not 
as hard as it sounds, I promise. Here’s 
how I eventually developed an 
instantly recognisable style. 

I was like every other newbie street 
photographer. I idolised Bruce Gilden, 

The future of street photography is in your hands. 
Time to decide what you want it to become

hit the streets
anD Be unique

took side shots of ordinary people 
doing ordinary things, and truly 
believed I needed a Leica to do it. I soon 
learned that the photos I was making 
were anything but unique, let alone 
interesting, and that a Leica M was too 
heavy to be practical, at least for me. 

Learning to fLy 
I began to dig through classic photo 
books. I was immediately and 
instinctively drawn to the work of Mark 
Cohen and Daido Moriyama. I bought 
a Ricoh GR1v 35mm and tried to be 

Moriyama. I made some interesting 
pictures, but it was a copy of much 
greater work. 

Next, I got a Ricoh GR Digital IV: 
small, light, and so fast it was without 
rival. This let me capture images 
without really being seen or detected. 
I diversified my locations. I began to 
shoot on the beach as well as the 
sidewalks. I didn’t have a viewfinder 
and the LCD was turned off.

With a 28mm, you learn to see how 
the camera sees. I could simply aim the 
camera and know pretty much what 
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Opposite page  “This 
is one of my best-selling 
photos. Get in close, really 
close. Give us just enough 
for the imagination to do 
the rest.” 

left  “Stop and rest 
sometimes. Keep your 
eye in the finder and 
finger on the shutter, 
it will happen.”

Below  “A man takes a 
break from scorching July 
heat. Let your subject 
bleed out of the frame: 
it adds anxiety.”

www.digitalcameraworld.com  MarCH 2016       D i g i ta l  C a m e r a             53

XXXXXXXXXX 
XXXXXXXXXXXXX

I was getting in the frame. I combined 
this with Cohen’s influence of cutting 
off heads and Daido’s gritty, grainy 
aesthetic and came up with something 
that began to resemble my own style.

It wasn’t easy: it was a long process 
over multiple years. When I first 
returned to photography in 2010 after 
more than 10 years away from the 
camera, I was shooting 
colour images of 
doorknobs – a far cry 
from my more recent 
apocalyptic images of 
sunbathers at Coney 
Island. Be patient and 
persistent; your style 
will emerge when you 
least expect it. 

I have also produced 
other bodies of work that 
stand apart aesthetically from 
the most common street photography. 
Love it or hate it – and there are many 
people in each camp – the work is 
uniquely my own. Currently, I am 
working on street photography that 
is largely devoid of people and is 
exclusively captured on disposable 
cameras. Again, not for everyone, but 
it is novel in its vision and approach.

Following rules, copying the masters, 
and spending all my time buying gear 
never produced any good photographs. 
When I broke free of those things and 
focused inward, I came into myself as 
a photographer. 

the meanS, not the end
What about the camera? My 

advice: keep it simple. Spend 
less time worrying about 

gear, and more about 
what your photos have 
to say to the world. 
Any camera can 
be made to be 
submissive to the 
artist and render 

work that has vision.
Aside from that, find 

something compact, 
versatile and light; something 

you can take everywhere, but still 
produces a quality photograph. If I had 
to name one camera, it would be the 
Sony RX-100 Mark IV. It can produce 
images that rival cameras twice the 
price and three times the size. It’s a 
great camera, and I say that because 
I believe it, not because I have any 
affiliation with Sony. (I don’t.)

now it’S up to you 
In the end, you will have to develop 
your own style, and you will have to 
do it largely on your own. Simply 
grabbing a camera and clicking your 
way down the street is, at best, only 
going to produce digital noise for social 
media. To truly contribute to the larger 
conversation in street photography, 
you will need to push the boundaries, 
avoid the rules, and experiment.

Never get comfortable. Make 
mistakes, take bad photographs, do 
your own thing. Read – not only about 
photography, about the world. Learn 
to see in ways others can’t. Learn to 
be an artist, not merely someone with 
a camera.

Street photography is not dead, but 
it is hurting. A sort of renaissance is 
needed; hopefully it’s on its way.

You will have to develop your own style, and you will 
have to do it largely on your own Simply grabbing 
a camera and clicking down the street is, at best, 
only going to produce digital noise for social media

Street tip 
Buy a simple, light 

camera. With a lens that 
goes as wide as 28mm 
and as long as 70mm, 
you can capture every 
kind of situation you 

might encounter.

C o v e r  S t o r y
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6  
af point selection
For more precise and faster focusing, you can 
choose a single AF point. Some cameras have 
a thumbstick that lets you highlight individual 
AF points directly; with others, you’ll need to 
press a button and use the control wheel.

5  
af switch/button
Press the button on the camera 
marked AF, and use the control 
dial or direction pad to cycle 
between the various autofocus 
modes on the camera.

4  
af/Mf switch
This will override the focus 
mode set on the camera. It 
may be the only way to select 
the manual focus option.

1  
shutter release
Half-press the shutter 
release button to 
activate the autofocus. 
Once the camera has 
focused on the subject, 
keep the button 
half-pressed to lock 
the setting in during 
One Shot autofocus.

2  
back-button focus
In addition to the shutter 
release button, you may 
also be able to activate or 
deactivate the autofocus 
system using an AF-L 
button near the thumb grip.

3  
full-tiMe Manual
More expensive lenses offer 
full-time manual focus, which 
means you can twist the focus ring 
to fine-tune the sharpness even 
when the camera is autofocusing. 

Everything you need to know about the focus 
options available on your digital camera

 

 



aBOVe
use One Shot when when the subject is stationary, 
and Continuous when they’re moving. A third 
autofocus option may be available, which 
automatically alternates between the two.

>

b a c k  t o  b a s i c sFOCUSING
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ODERN cameras offer such 
a comprehensive array of 
focusing options that it can be 
difficult to know where to begin 

when you want to take control. But the 
place to start is with the fundamental choice 
between focus modes.
 There are three focus mode settings 
that are common to all cameras: One Shot 
autofocus, Continuous autofocus and 
Manual. The names may differ between 
cameras, but the principles remain the same
 In One Shot autofocus, once the camera 
has found a point to focus on, it will stop 
focusing. As long as you don’t lift your finger 
from the shutter release button, this focus 
distance will stay locked in. This is ideal if 
you’re shooting a subject that isn’t moving, 
allowing you to fire off a burst of shots that 
will be focused in the same place.
 As the name suggests, Continuous 
autofocus never stops. It’s the mode to use 
when you’re photographing a moving object, 
as the camera will continuously refocus the 
lens to keep the subject sharp.
 Your camera may include a third ‘hybrid’ 
autofocus option – AI Focus AF on Canon 
cameras and AF-A on Nikon – which switches 
automatically from One Shot to Continuous 
when the camera detects movement. This 
may sound convenient, but we’d recommend 
presetting the autofocus mode manually in 
order to reduce the camera’s reaction time.
 Manual focus is the way to go if you need 
the lens to remain focused at a specific 

distance or when the camera is struggling 
to focus automatically, such as in low light, 
at close distances or when there’s a lack of 
contrast for it to ‘bite’ onto.
 To set the focusing mode, use the 
camera’s quick control screen or dip into the 
shooting menu. Some cameras also have a 
dedicated AF switch or button on the camera 
body. The majority of autofocus lenses also 
have a sliding switch that enables you to 
alternate between autofocus (AF) and 
manual focus (MF).

M

autofocus points
ThE more advanced a camera is, the 
greater the number of AF points it 
offers. Take the Nikon SLR range: the 
beginner-level D3300 has 11 AF points, 
while the new professional D5 (see page 
20) boasts 153 of them.
 The more AF points there are, the 
smoother the focus tracking – where 
the camera ‘hands off’ from one AF point 
to another to track a moving subject. A 
larger amount of AF points across the 
image provides greater flexibility when 
selecting individual points: with fewer AF 
points, none may align with a detail you 
want to focus on, and you’ll have to lock 
the focus before recomposing.
 Not all AF points are made equal. 
Standard AF points measure sharpness 
in one plane, while cross-type AF points 
can detect both horizontally and 
vertically. Dual cross-type detects 
diagonally as well, although you’ll need 
lenses with large maximum apertures 
to activate this functionality.

1  
af point selection       
While the focus mode 
dictates how a camera 
focuses, it’s the choice 
of AF point(s) that 
determines where it 
focuses. By default, the 
camera will make the 
decision automatically. 

2  
Going manual       
You can manually select 
a single AF point or a 
small group of them, if 
your camera offers this 
function. Use the dial or 
thumbstick to position 
your preferred option in 
the AF point array. 

3  
single      Set a single 
AF point when you want 
the most precision. 
Here, the camera may 
have locked onto the 
close branch rather 
than the building, but 
manually setting the AF 
point avoids this. 

4   
Group      Use a group 
of AF points when you’re 
tracking fast subjects 
that are hard to follow 
with a single point, 
although with all the 
AF points active, the 
camera may focus on 
the background instead.

Manual focus is the 
way to go if the 
camera’s struggling

1

2

3

4

ONE-SHOT Af CONTINuOuS Af
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pHASE vs CONTrAST
A digital SLR uses two different methods to focus, 
depending on how you’re using the camera

TO determine if an object highlighted 
by an AF point is sharply focused, 
a digital SLR will use either phase 
detection or contrast detection. Phase 
detection is used when you’re shooting 

with the viewfinder. It’s a fast system that 
uses a dedicated autofocus sensor to 
determine whether the lens needs to be 
focused closer or farther away, and by how 
much, in order to make the details under 

the active AF point or points snap into 
sharp focus.

When you switch to Live View, the 
camera uses contrast detection instead. 
This measures the level of contrast in the 
area highlighted by the focus point on the 
screen. When the highest level of contrast 
is detected, the camera assumes it has 
achieved peak sharpness. To confirm this , 
it has to drive the focusing mechanism 
both beyond and in front of this ‘peak 
contrast’ point. This makes it slower, but 
potentially more accurate.

2  
Double-take      The AF sensor 
sees two ‘out of phase’ versions of 
the image which need to be aligned.

2  
blurred      The camera detects 
the level of contrast in the area 
covered by the focus sensor. 

1  
subject      Pre-focus at a spot 
close to the subject to speed up 
the autofocus acqusition.

1  
extra-sharp      With the mirror 
locked up, the camera’s AF sensor 
is not exposed to light.

Phase-detection aF
Makes use of a dedicated AF sensor 
during viewfinder shooting

Contrast-detection aF
Measures the level of contrast 
on the imaging sensor



live View

Focus on the details

b a c k  t o  b a s i c sFOCUSING
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SOmETimES, autofocus just 
won’t do. For instance, you may 
want to prefocus at a point and 
keep the lens locked at this 
distance, such as when you’re 
waiting for a bird to land on a 
perch or a racing car to cross the 
finish line on a race track.
 If you’re photographing a 
landscape, where setting a 
precise focus distance along with 
an optimum aperture can ensure 
everything from the foreground 
to the horizon appears sharp, or 
an extreme close-up, where the 
difference between a sharp image 
and soft one can be separated by 
just a millimetre or two, then 

manual focus 
is the best 
option.

Using 
an optical 
viewfinder to 
do this is a tricky 
business, so take 
advantage of the Live View 
display. You can magnify the 
image, enabling you to fine-tune 
the focus on small details. Use 
your camera’s depth of field 
preview function to check 
whether details closer to the 
camera or farther away will also 
be sharp, then adjust the focus 
point and aperture accordingly.

In Live View mode, you can 
magnify the image, enabling 
you to fine-tune the focus on 
very fine details – although you 
may find it easier to do this at 
a lower magnification setting. 
Use your camera’s depth of 
field preview function to check 
whether details closer to the 
camera or farther away will also 
be sharp, then adjust the focus 
point and aperture accordingly.

 Phase detection is a 
fast system that uses 
a dedicated autofocus 
sensor, while contrast 
detection uses the 
imaging sensor

MANuAL fOCuS
When you need to take control

lens first
The majority of 

lenses need to be set 
to MF in order for you 

to freely rotate 
the focus ring.

3  
high contrast      To determine whether the 
point of highest contrast has been reached, the 
lens has to be focused backwards and forwards, 
so it’s much slower than phase detection. 

neXt
Month

Master the 
basics of 
aperture…

3  
fast      The camera knows 
whether the lens needs to be 
focused closer or farther away.

4  
hunting      The focus 
may ‘hunt’ backwards 
and forwards if it can’t 
find the subject.

4  
tracking      
Some SLRs use  
a hybrid system 
that combines 
elements of phase 
detection and 
contrast detection 
for focus tracking 
in Live View.



58            D i g i ta l  C a m e r a        MARCH 2016 www.digitalcameraworld.com

Im
age 

 

analy
sIs

W
Hy

 sH
ot

s W
oRk

58            D i g i ta l  C a m e r a        MARCH 2016 www.digitalcameraworld.com

Im
age 

 

analy
sIs

W
Hy

 sH
ot

s W
oRk

#1

GREAT, SCOTT!
phOTOGRAphy 

wiTh impACT

Preparation helped scott kelby 
capture the drama of a crucial 

match with pinpoint sharpness

While 
Scott Kelby 
is perhaps 
best known 
for his work 
as a busy 

Photoshop training guru, 
he’s also an accomplished 
sports photographer, and 
covers NFL matches for a 
newswire service. This 
memorable shot packs in so 

much of what is great about 
the NFL, from the bruising 
tackle to the cheerleader.

“It was a regular game in 
the 2015 season between 
the Tampa Bay Buccaneers 
and the Carolina Panthers,” 
Scott explains. “The Carolina 
Panthers are the hottest 
team at the moment in the 
whole of the NFL, and this 
image shows a tackle to a 

touchdown pass to the 
Panthers’ Kelvin Benjamin.

“As I shoot for the media, 
I can pretty much shoot from 
anywhere on the field except 
the bench area, where the 
players stand.”
www.scottkelby.com

Scott Kelby explains how to 
remove a visible light source
See page 96

See Scott Kelby at The 
Photography Show at 
the NEC, Birmingham, 
this March. Visit www.
photographyshow.com 
for details and tickets 
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WHy sHots WoRk i m a g e  a N a lY S i S

While most sports photographers 
try to keep the background clean, 
the characters in this shot’s 
background 1  are as crucial 
as the main subjects. “It’s funny 
that the cheerleader is smiling, 
notes Scott. “Her team has just 
been tackled!” He fired off 
several shots of this tackle, but 

this one works best because of 
the background characters, 
stood in perfect alignment. The 
players are also razor-sharp 2 .

“I used a 400mm f/2.8 lens 
with an extender, and set up my 
Canon 1D X so the shutter speed 
never dropped below 1/1,000 
sec,” he says. “This will freeze 

anything from an IndyCar to an 
athlete, so it’s a great setting. 
Even going down to 1/800 sec 
can create softness, so 
I recommend it for sports.

“Newswire photographers 
are allowed to do very little in 
software, so I just added a bit 
of contrast and sharpening.”

2

1
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mEET ThE 
’FiShER KiNG

Determination and 
perseverance pays 

off, as seen in this 
once-in-a-lifetime 

photograph

hOW determined are 
you to get a great 
wildlife shot? Few will 
be as determined as 
Alan McFadyen, who 
spent 4,200 hours and 

took 720,000 exposures to get this 
perfect shot of a kingfisher diving into 
water. “I took this image at Tarff Water, 
on the estuary of the River Dee in 
Galloway,” Alan explains. “I used to visit 
this site with my grandfather 40 years 
ago, and saw my first kingfisher there. 
I have been watching the site ever since.”

As well as displaying Herculean levels 
of perseverance, Alan decided to help 
the kingfishers by building an artificial 
nesting area. “The birds’ habitat is on 
a tidal stretch, so their nests flood every 
year. I also supplement their food. 
Intervening in this way might seem 
unethical to some, but I think the 
kingfisher is an amazing bird and 
needs all the help it can get.”

The response to this image has been 
overwhelming, with accolades from all 
over the world. “I’m going to continue 
photographing the kingfishers,” Alan 
says. “It would be great to capture a full 
reflection of the bird, or one with its belly 
at the front.”
www.photographyhides.co.uk

i m a g e  a N a lY S i S WHy sHots WoRk

in the frame
To get this shot, Alan concealed himself in 
a flooded hide, up to his chest in water, and 
carefully watched the kingfisher as it surveyed 
the water for food. The bird was captured one 
morning in late October. “I used a Nikon D4 with 
the Nikkor 70-200mm lens zoomed out. The 
exposure was 1/5,000 sec at f/5, ISO 1,250. 
I also used a Yongnuo remote trigger, as I’d 
prefocussed on where the bird was likely to 
dive from its perch.”

These settings have kept the bird sharp where 
it needs to be 1  , while also helping to nicely blur 
out the background 2  . The golden-brown 
background is provided by the leaves of a beach 
tree. Alan had to work fast, however: high winds 
were about to hit and strip away the leaves.

The final piece of the jigsaw 3  is the near- 
perfectly symmetrical reflection of the bird. Alan’s 
familiarly with the location ensured he was in the 
right place at the right time, while the fast shutter 
speed captured the action with precision.

1

2

3
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Adding gels to your 
lights is a simple way of 
making portraits more 
interesting, as this 
Sean McCormack shot 
proves. “I’ve been 

adding gels since I started doing studio 
lighting almost 12 years ago,” he explains. 
“Recently I’ve been inspired by the work 
of Jake Hicks.”

For this shot, Sean used gels to modify 
a lighting set-up he’d normally use for edgy 
portraits. The key light is from a gridded 
95cm Octa with a blue gel on it. “It’s more 
noticeable on the background in this shot, 
but still glows on Sam’s skin. I chose Sam 
for the shoot as I felt the lighting would 
work well with both her skin and her hair.

“Keeping with the ‘cool’ feel, I added two 
strip lights with grids to the side of Sam, 
with peacock-coloured gels (116 in Lee 
Filters). These are often used from the 
back, but I wanted more spread on the 
light, so I side-lit instead. The grids are 
there to help prevent background spill.

“The final light I added was a Speedlight 
with a MagMod gel holder attached, using 
MagMod’s amber gel. This is bounced into 
a silver reflector to give it more spread. It 
lights the underside of Sam’s hands and 
face, as well as her legs. The yellow 
complements the blue in this image.”

Sean shot this image with a Fujifilm 
X-T10, taking a 1/180 sec exposure (the 
flash sync speed) at f/7.1, ISO 200.
www.seanmcfoto.com

Sean McCormack’s Lightroom Skills
See page 128

EVERyThiNG 
JUST GELLED...

#3

Clever use of gels, side-
lighting and a silver 

reflector can create 
a really ‘cool’ portrait
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Portrait lighting set-up
1   Key light      A gridded 

95cm Octa with a blue gel 
provides the key light, creating 
an attractive, cool effect.

2   Striplights      The 
striplights to the side of the 
model help to create a more even 

spread of light on Sam’s 
shoulders and arms.

3   Flashgun      The spread 
of light is further enhanced by a 
Speedlight firing through a silver 
reflector. Sean also used an 
amber gel with the reflector. 

“Unlike a lot of my gelled 
portraits, there is no white light 
in this image,” he says.

4   Backdrop      A hand-
painted warm grey canvas from 
Bespoke Backdrops provides the 
background for the shot.

i m a g e  a N a lY S i S
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3
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Members of the global Digital Camera community share their work with you…

Get Involved!
If you’d like to take part in any 
of the features in Photo Active, 
please send us an email at 
digitalcamera@futurenet.com 
with one of the following in the 
subject line: Rate My Photo, 
Shootout, Portfolio or Photo 
Answers. Please include your full 
name, contact details (including 
a daytime phone number) and a 
sample of your work (max 10MB)

66 74 80

shOOTOUT
Two Digital Camera readers join editor 
Ben Brain at Slimbridge to test their 
wildlife photo skills on the residents…

PhOTO ANsWERs
Your questions answered, including 
puddle conundrums and how to make 
sense of image resolutions

AssIGNMENT
The results are in for our theatrical 
photo challenge. Then get your wellies 
on and chase the perfect storm…

FaCebook www.facebook.com/
digitalcameraworld

FliCkr www.flickr.com/ 
groups/digitalcameraworld

twitter www.twitter.com/
DigitalCameraW

PHoto
aCtiVe

PortFolio
72   See the London Transport 

system in a new light with the 
Tube-train-driving photographer
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Wildlife pHotogRApHy

out!Shoot
Two readers head to Slimbridge WWT 

in search of the perfect wildlife shot 

Our latest Shootout took place at Slimbridge  
Wildfowl and Wetlands Trust, Gloucestershire,  

where Ben Brain challenged two readers 
to get creative with birds and big lenses

Join us and learn new skills! Email digitalcamera 
@futurenet.com (subject line: Shootout). 
Please include your address and phone number

Mark 
GawthorneJasmine 

Kamal-Pasha
Camera:  Canon eoS 550d 

loCation:  london

Camera:  Canon eoS 5d Mark iii 

loCation:  exeter, devon

Jasmine has recently 
graduated with a degree 
in photography from 
Kingston University. As 
a photography graduate, 
Jasmine is eager to forge 
a career as a photographer, 
so spending a day with 
like-minded people was the 
perfect opportunity for her 
to extend her skills. 

Combining her love of 
both fine-art and wildlife 
photography, this month’s 
Slimbridge Shootout 
was the ideal platform for 
Jasmine to flex her creative 
muscles. Bubbling with 
enthusiasm and energy, 
it’s clear that Jasmine is 
off to a good start.
jasminekamalpasha.com 

mark’s been a full-time 
wedding photographer in 
Devon for more than 25 
years. Despite shooting 
more than 80 weddings 
in 2015, Mark was keen to 
finish the year with us at 
Slimbridge to try his hand 
at wildlife photography. 
“I have always held in 
utmost respect those who 

make a career out of this 
photographic discipline, 
and am often in awe of the 
inspiring images produced,” 
he says. 

Mark also welcomed the 
opportunity to get his hands 
on some big lenses from 
Sigma, which kindly lent us 
some for the day.
www.evolvephoto.co.uk

READER 1 READER 2

You CoulD take 
part in our next 

reaDer shootout



S H O O T O U T

www.digitalcameraworld.com  MARCH 2016       D i g i ta l  C a m e r a             67



We were lucky enough to borrow some big 
500mm and 600mm lenses from Sigma 
Imaging – however, they’re not cheap. If 
you want to experiment with big lenses, try 
renting one for a day before splashing out. 
To rent a Nikon AF-S 600mm f/4G ED VR 
from www.calumetrental.co.uk will set 
you back £75 (plus damage waiver and 
VAT). This might seem a lot – but buying 
the lens will set you back over £6,000.

Challenged by the mass of 
flamingos in this vast flock, Jasmine 
struggled to get a clean shot without 
a distracting background. However, 
an opportunity finally arose: by isolating 
this beauty from the rest of its group, 

Jasmine managed to create a portrait 
where the flamingo can be fully 
appreciated as an individual, creating 
a more engaging image. Jasmine has 
also made the bird stand out from the 
background by throwing the latter out 
of focus, using a wide f/4.5 aperture 
to create a shallow depth of field. 

The green hues of the background 
also contrast wonderfully against the 
bird’s bright pink, a palette that makes 
the photo more eye-catching. 

kit Canon EOS 550D with Sigma 500mm lens   exposure 1/500 sec at f/4.5, ISO 200

•  Isola ting one bird took some 
pa tience, bu t finally Jasmine 
managed to capture this bird 
away from the flock. 

•  The blurred background nicely 
separates this flamingo from its 
surroundings. 

•  The colour combina tions of 
pinks and greens works a trea t. 

Expert opinion
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1 Capture 

a fabulous 
flamingo 
portrait 
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Jasmine

Big lenses

S h o o t o u t Wildlife pHotogRApHy
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If you want to capture pin-sharp shots, 
holding up a big heavy lens is pretty much 
out of the question. Camera movement is 
inevitable unless you’re using super-fast 
shutter speeds – and even if you are, it’s 
exhausting to hold your kit for extended 
periods. A tripod is the obvious solution, 
but a monopod can be useful too. Even 
a handy bean bag can be used to absorb 
the weight and help keep things steady.

tripods and bean bags 

like Jasmine, Mark struggled with 
the tangle of flamingos in this area. 
In the end, this magnificent specimen 
struck a delightful pose. Honed by 
years of shooting weddings, Mark’s 
quick reactions meant he was able to 
quickly but carefully grab the shot. 

Despite the mass of birds, Mark bagged 
a clean background, which is artfully 
thrown out of focus by using the Sigma 
150-600mm’s widest aperture (f/6.3) 
to achieve a narrow depth of field. Using 
a fast shutter speed of 1/1,000 sec (at 
ISO 1,600), Mark ditched the tripod and 
risked hand-holding his kit. It paid off: 
the eyes of the bird are brilliantly sharp, 
which is crucial. 

Ultimately, though, it’s this fabulous 
flamingo’s splendid expression that 
makes it such a compelling portrait. 

kit Canon EOS 5D Mk III with Sigma 150-600mm lens at 600mm   exposure 1/1,000 sec at f/6.3, ISO 100 

•  Quick reac tions in a tricky environment ensured tha t Mark was able to grab this grea t opportunity. 
•  The pin-sharp eye is perfectly focused, with no camera shake either – quite an achievement with a hand-held 150-600mm.•  A wonderful expression!

Expert opinion

top  kit

Mark

S H O O T O U TWildlife pHotogRApHy
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The background is a vital 
element to a successful wildlife 
shot. It doesn’t always have to 
be neutral or out of focus: 
sometimes environmental 
context is more helpful to tell a 
story. Either way, it’s essential 
to consider what you’re going 
to show – or not.

Background

kit Sony A77 II with 90mm f/2.8 Macro lens
exposure 1/125 sec at f/2.8, ISO 100

SwitChing to his own trusted 
70-200mm lens with a x2 converter,  
Mark extended the long end of his 
zoom to 400mm to capture this 
engaging image. Mark played the 
waiting game; after a short time, the 

birds chose to ignore him and his big 
lenses, and went about their normal 
routine. Mark was then able to take a 
series of photos with the bird’s eye in 
varying stages of openness, but settled 
on this one for its soft sweeping lines, 
simplicity and texture. The dark 
background brings the image together.

Mark skilfully positioned himself to 
get this composition; hand-holding his 
camera, he needed a fast shutter speed 
to avoid camera shake.

kit Canon EOS 5D Mk III with EF 70-200mm f/2.8 lens   exposure 1/1 000 sec at f/5.6, ISO 1,000

•  Mark’s pleasing composition 
is simple and striking. 

•  The subtle handling of the 
white tones in the bird’s feathers 
has just enough de tail. 

•  While the light is a bit grey 
and fla t, the dark background 
helps to create depth.

Expert opinion

embrace 
the art 
of black-
and-white C
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A special thank you to 
Sigma Imaging (UK) 
for loaning us some 
beautiful long lenses: 
the 150-600mm 
f/5-6.3 DG OS HSM 
Sport and the 500mm 
f/4.5. Visit www.
sigma-imaging-uk.com 
for more info.

I think we all came away 
from the day with a 
newfound respect 
for the art and 
craft of wildlife 
photography. 
Wielding big 
lenses, 
critical 
focusing and 
unpredictable 
(to me anyway) 
behaviour from the 
subjects made it a 
challenging task that 
both readers aced.

Ben says

sigma lenses

JaSmine was in her element for this 
assignment. It allowed her to experiment 
freely with her love of both fine-art and 
wildlife photography. 

Seeking out an alternative take on the 
theme, Jasmine decided to focus on smaller, 
less obvious details – in this case, the 
foot of a moorhen. “I’m often drawn to 
photographing the feet of birds. Their shape, 
colour, and texture intrigues me,” explained 
Jasmine. The textured scales of the bird’s 
feet, contrasting with the hard texture of the 
concrete surface, have made an unusual but 
successful image. 

Working at a focal length of nearly 
500mm, Jasmine had to use a tripod to avoid 
camera shake, even using a shutter speed 
of 1/400 sec at ISO 1,600. This can be 
challenging with such a detailed shot of a 
moving subject, but Jasmine nailed it with 
this razor-sharp shot. The wide aperture of 

•  A beautifully observed shot 
tha t reveals how smaller 
de tails can make grea t images.

 •  Jasmine’s bold and confident 
crop is simply superb.

•  The conversion to black-and-
white accentuates the textures 
and creates a moody, striking 
image to treasure.

Expert opinionJasmine

f/6.3 has also helped focus the viewer’s 
attention by creating a shallow depth of field, 
with the focus exactly where it should be.

Using Adobe Camera Raw, Jasmine made 
the black-and-white conversion, and added 
Clarity and Contrast to further accentuate 
the surface textures. She was not afraid to let 
parts of the image fade to black, and with a 
subtle vignette, the image is packed with 
mood. Combined with a hard square crop, 
the finish has been artfully resolved.

kit Canon EOS 550D with 150-600mm lens at 481mm   exposure 1/400 sec at f/6.3, ISO 1,600

Jasmine
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An arty take on 

architecture 
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Tunnel vision: meet the Tube driver who’s lucky 
enough to combine her two great obsessions

Portfolio
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Name:  anne maningas 

LocatioN:  London

Subject:  ‘Travel’ photography

equipmeNt:   canon EOS 5D mark III with 35mm f/1.4L USm lens 

WebSite:  www.version3point1.co.uk

ONCE you get 
to grips with the 
basic principles of 
photography, it’s 
invariably time 

and access to a subject or a 
location that make the biggest 
difference to your pictures. 
But this is often at odds with the 
demands of a day job. One 
solution is to combine the 
two – something that London 
Underground driver Anne 
Maningas has managed with 
great success.

“I’ve been working for the 
Underground for nearly nine 
years, but I’ve had an obsession 
with it ever since childhood,” 
Anne reveals. “I learnt a lot about 
lighting constraints as a teenager 
when I started to travel around on 
the Underground with one of my 
first cameras, a Pentax ME Super. 
My style and approach has 
developed in such a way that 
I only shoot handheld and rarely 
use flash, preferring to use what 
light is available in some difficult 
lighting conditions.

“Besides low light, one of the 
main issues I have to deal with 
is safety,” she explains. “I take 
it very seriously, because the 
Underground can be a dangerous 
place. I’m licensed to be on, and 
work on, the track when trains are 
moving, so I’m aware of the 

various risks posed by being on 
the railway and what precautions 
I may need to take. It’s not worth 
risking safety just to get a shot.

“The photography also has to 
fit in when I’m going to and from 
a work site or job – or I happen to 
have a spare 10 minutes before 
I start work or at the end of the 
day. I never shoot while driving or 
when I’m in charge of a train,” 
Anne adds. “When I’m travelling 
and able to take photos, I have 
to be aware of sudden lateral 
movement or jerks, such as when 
the train runs across a junction. 
Having a working knowledge of 
the Underground means that 
I can anticipate a lot of this and 
steady myself.”

Anne has been an avid user of 
the Canon EOS 5D series since 
2008. She currently owns a 5D 
Mark III, using a Canon 35mm 
f/1.4L USM lens as her mainstay 
for the last seven years. “I also 
use the Canon 24-70mm f/2.8L II 
USM for outdoor work, such as on 
our special heritage event days. 
When the bulk simply isn’t 
practical, I have a Canon EOS M 
with a 22mm f/2.8 STM lens – it’s 
a handy little box of tricks, and 
I also use it for my day-to-day job 
when I need to report things like 
track faults, or anything that 
would require a good-quality 
photograph as evidence.”

Kit Canon EOS 5D Mark II with EF 35mm f/1.4L lens
Exposure 1/30 sec at f/4, ISO 400  
Making the most of the available light on an empty 
carriage from an old 1962 Tube stock train.

Kit Canon EOS 5D Mark II with EF 35mm f/1.4L USM lens 
Exposure 1/15 sec at f/1.4, ISO 2,000   
Hitching a ride home on the Jubilee Line.
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Kit Canon EOS 5D Mark II with EF 17-40mm f/4L USM lens at 40mm
Exposure 1/500 sec at f/8, ISO 400   
Spring morning fog descends on the Metropolitan line, Uxbridge, Middlesex.

Kit Canon EOS 5D Mark II with EF 17-40mm f/4L USM lens at 22mm
Exposure 1/640 sec at f/8, ISO 400    
‘C’ stock trains from the 1960s at the end of their working life in Hammersmith.
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I took photos of my 
hometown reflected in 

puddles. Should I show the 
reflections in the images the 
right way up or not?
Steve Hart

This is really a decision only 
you can make, Steve: it 
depends entirely on what 

you think works best and is 
visually the most interesting 
composition. In so many areas of 

In a puddle

Photo
answers

ANDREW JAMEs 

Our expert photo 
advisor is here to help

ExaspEratEd by ExposurE sEttings? nonplussEd by nd filtErs?

Send your question to digitalcamera@futurenet.com and let us provide you with a solution

Your tricky photography questions answered!

photography, there is no absolute right or 
wrong way of doing something; this is a 
mantra we are always trying to put across 
through the pages of Digital Camera!

Having said that, when I had a look 
through my files at the numerous puddle 
reflection shots I’ve taken over the years, 
I discovered that almost nine times out 
of 10, I choose to flip the image so the 
reflection is the ‘right’ way up! If there are 
people in the reflection, I always flip the 
image and also choose to try to keep their 
feet in the frame, if I can. I think this 
gives some visual reference that helps 
the viewer work out what’s going on.

What I absolutely agree with you 
about is that photographing the world 
reflected in a puddle is a really fun, 

creatively challenging, and ultimately 
satisfying way of taking photos. You’ll never 
get two pictures looking the same. In fact, 
when it comes to shooting in urban 
environments, I’m really happy if there is 
a bit of rain to either create puddles or put 
sheen on pavements – especially at night, 
when the reflections of street lights can really 
bring a place to life.

You can get some funny looks when you 
are kneeling down snapping a puddle-
reflected scene – but who cares if you are 
getting the shot you want? So my simple 
advice is to keep doing what you are doing; 
then, in Photoshop or Lightroom, flip the 
image and decide which way works best. 
It really is your creative decision, so you 
can’t get it wrong.

including a subject’s feet  
in the frame (bottom left) 

can help a viewer make 
sense of reflection shots.
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What is image resolution?
If you load your image in an image editor 
like Photoshop then zoom right in, you’ll 
see thousands of tiny squares, or pixels, 
that make up the photo, like a mosaic. The 
image resolution is simply the number of 
pixels in the image.

do all cameras have the same 
image resolution?
No. One of the ways that manufacturers try 
to get you to buy new cameras is to develop 
models with a greater resolution than the 
last. Most digital cameras also allow you to 
choose the resolution you want to shoot at, 
up to the camera’s maximum.

Why would i want to shoot at less than 
the maximum resolution?
There may be times when choosing a 
smaller file size is a sensible option – for 
example, if you want to get more images 
onto your memory card. Or perhaps you 
know that the images you are taking will 
only ever be seen on a computer screen, 
you may feel that using the camera’s 
highest resolution isn’t necessary.

How do i ensure i get the best resolution 
with my camera?
By selecting the maximum JPEG setting 
or shooting in raw. You can do this through 
your camera’s menu. Manufacturers use 
different terms to describe the file sizes 
you can choose between, so make sure you 
understand them. Many cameras can take 

different-resolution raw files too, so make 
sure you are using the largest megapixel 
size if you want maximum quality.

How do i know what my camera’s 
resolution is?
In most cases, your camera manual will tell 
you. For example, a Nikon D810’s highest 
resolution is 7,360 x 4,912 pixels. If you 
multiply these figures together and divide 
the answer by one million, you’ll have 
the camera’s maximum resolution in 
megapixels – like 36MP for that D810.

so ultimately it’s all about quality?
Yes. The higher the resolution you shoot at, 
the more chance you have of capturing the 
scene in clear detail. Then you can make 
a photo print at a reasonable size without 
worrying about the quality. For example, 
a 20MP image should easily print at A2 
(594 x 420mm) without any quality 
problems, but an image shot at 2MP will 
only print clearly up to around 6 x 4in. If 
you try to print it bigger, detail may be lost.

so for maximum quality, should i get 
a camera with the biggest resolution?
In principle, yes, although other factors will 
also determine the final quality of your 
images. Among these are the resolving 
abilities of your lenses, your aperture 
choice, your technique and any editing 
work you carry out. But if you want the best 
image output from your camera, shoot at 
its highest resolution.

image resolution
The devil is in the detail when you’re shooting rich images

It rocks
Should I shoot pebbles 
on a beach as the waves 

are coming in or going out?
Sonya Smith

TRy both and see what happens! 
As the waves come in over pebbles 
or rocks, it tends to be faster; 

when the water is trickling back, the 
pebbles slow it down. The effect will be 
different for each direction depending on 
your chosen shutter speed.

With the faster water, you’ll get more of 
a sense of energy from the waves – even 
when you are blurring them with a slow 
shutter speed. The water will cover more 
of the rocks, so be aware how this alters 
your composition. Once the waves start 
to recede, the trickle of water may lend 
a more tranquil feel to the scene, and more 
rocks are actually revealed.

Set up on a tripod to ensure there is 
no movement of the camera during the 
exposure. Then you just need to manual 
focus on a boulder that looks good and is 
unlikely to be swamped by the incoming 
waves. This is important as this rock is 
going to act as the anchor in the image – 
the focal point that holds the viewer’s 
attention while the water swirls around it.

This is best attempted early or late, 
when lower light levels make it easier 
to achieve exposures of a second 
or more. It’s also great if there is 
some interesting light that can 
help to define the edges of the 
rocks you are photographing.

My two example shots both 
have a shutter speed of two 
seconds but show the difference 
in results you can expect.

ASK US A 
qUeStIon
digitalcamera@ 
futurenet.com 

(subject line: 
Photo Answers)
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I like the idea of 
portraits shot with a 

wide aperture – but it often 
looks like my shots aren’t 
sharp enough! Should I use 
a smaller aperture?
Sue Lang

WiDE aperture use and 
portraits definitely go hand 
in hand, Sue, so don’t give 

up. Perhaps you just need to go back to 
basics and make sure you are ticking all 
the right boxes with your technique.

You are right when you say that 
shooting at a wide aperture limits 
sharpness. This means accurate focusing 
is an absolute must. If you focus on the 
wrong point at f/2.8, the error will really 
be shown up. Use a single AF point to 
pinpoint the area of focus – almost 
always the eyes – with absolute precision. 
While this sounds easy, the camera may 
well try to focus on the side of the face or 
on the eyelashes, so watch out.

The other thing to bear in mind is the 
position of your subject’s face. If the face 
is straight on, you can get both eyes sharp 
at f/2.8 – but if it is even slightly angled 
away from you, one eye will always drop 
out of focus. In these circumstances, it 
may be better to stop down to f/4 or f/5.6 
for a greater depth of field.

When I take travel portraits, I almost 
always shoot at f/2.8: it can make light 
work of distracting backgrounds and 
throw all of the viewer’s attention onto 
the subject’s eyes.

When I look in wildlife 
photography books, 

all I see are tight shots of 
animals taken with long 
lenses. Why don’t pro 
photographers include 
the environment?
Joseph Hobbs

i’M not sure what books you’ve 
been looking at, Joseph. Every 
pro wildlife photographer I know is 

always looking for great shots of their 
subject within its environment.

A good wildlife book should have a really 
wide selection of images. If every page you 

saw was a tight portrait of an animal, 
it would be a very dull book indeed – 
especially if it was all one species.

I’ve noticed that when enthusiast 
photographers first get a long telephoto 
lens, they get a bit carried away and 
want those frame-filling portraits, simply 
because they’ve not been able to achieve 
this before. This is perfectly natural – but 
something they usually grow out of.

It’s not the lens itself that necessarily 
dictates how you shoot your subject, but 
the composition you choose. These two 
squirrel shots were taken with a 300mm 
lens, but are completely different takes on 
the same subject. One is the type of tighter 
portrait you referred to in your question, 
while the other is an attempt to connect 
the squirrel with its woodland setting. 
Neither is better than the other; they just 
work in slightly different ways.

too soft?

nature boy

I want to take some 
indoor shots of 

plants with a simple 
white background. I 
don’t have lights, so 
how can I make my 
background really white?
Lionel Branner

if you are working on a 
relatively small scale, try 
backlighting tissue paper at 

a window. Avoid a window with direct 
sunlight: you really just want some 
relatively flat even lighting to come 
through the paper.

Tape the white tissue paper to an 
old picture frame so that it’s easy to 
move around and position. When the 
frame is propped against the window, 

Tissue paper
QUICK Q&a

position your subject in front of it. You 
might need to bounce a little light back 
onto your subject, and you’ll need some 
plus exposure compensation to get the 
background clean.

Wildlife shots can really benefit when you connect the animal with their environment.
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Select a highlight tone
In the Develop module, go to 

the Split Toning panel and click on 
the small rectangular box next to 
Highlights. This opens the colour 
picker for the highlights. Using the 
eyedropper, click on the yellows and 
move it left and right or up and down 
until you get the right amount of 
warmth in your shot.

Select a shadows tone
Now open the colour picker for 

Shadows. I didn’t want to add any 
additional warmth to the darker areas 
of the wood in this shot, so I selected 
a subtle blue. Again, move the 
eyedropper around to see how it 
changes the look of the photo. You’ll 
see the area you selected for the 
highlights marked by a small square.

tweak the overall 
colour balance

Finally, use the Balance slider to tweak 
the look of the image further still. If you 
want to make further changes to either 
Highlights or Shadows independently, 
just go back to the colour picker or use 
the individual sliders. With this image, 
I ultimately chose to bias the slider to 
the warmer highlights.

Control colour with 
lightroom’s split toning
Split Toning allows you to change the colour of the image 
highlight and shadows independently from each other

1

2

3
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Should I give shots 
I put on websites 

a watermark?
Cory Nordstrom

WATERMARkiNg your 
images won’t stop people 
from stealing them, but 

it will at least make them think 
twice. Make sure that your 
copyright is embedded in the 
metadata of each image as well.

All the images I upload are 
low-resolution to prevent prints 
being made from them – and they 
all have ownership details!

Anti-theft

Before after

QUICK Q&a

Shoot in auto
I have been trying to 
shoot in Manual mode 

but the results I get 
aren’t as good 
as Auto. What am 
I doing wrong?
Mary Sweeney

i hEAR this a lot, Mary. In 
Auto, your camera works out a 
decent exposure for you and helps 

you focus. When you switch to Manual, 
you suddenly have to deal with focusing, 
aperture choice, shutter speed, metering 
and so on! My advice is simply to slow 
down and don’t panic. Try one of the 
semi-auto modes, like Aperture Priority, 
and think about every shot you take.

ASK US A 
qUeStIon
digitalcamera@ 
futurenet.com 

(subject line: 
Photo Answers)
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Get 
RAteD!

Email your shot to 
digitalcamera@
futurenet.com 

(subject line: Rate  
My Photo)

Shooting exactly to the 
bride’s brief. Top marks.

The letters are clear and 
well-exposed.

I’d like to see the blurred 
faces of all the letter writers.

A better background would 
have enhanced the shot.

NICely dONe

ROOM FOR IMPROveMeNT

EsTELLE sAys: this image 
was shot at a friend’s 
wedding. I think it turned 
out OK: I’ve never tried this 

at a wedding before. The bride specifically 
asked for this shot to be taken, as it 
contains all members of the family 
in a more modern wedding shot.

I used a long exposure, and the bride 
and family lit the shot with sparklers. The 
photo was taken on my Canon EOS 50D 
using an 18-55mm lens and a 10-second 
exposure at f/5.

ANDREW sAys: if this is 
your first attempt, Estelle, 
then it’s pretty damn 
good – and, as you say, it 

makes for a wedding image with a 
difference. As it was specifically 
requested by the bride and she’s happy, 
then what’s not to like?

Light-painting is good fun and relatively 
straightforward to do, although you need 
to work out the space you have to write 
your message in beforehand. Obviously, 
this was easy with your four letter writers 
in place. It’s when you have one person 
doing the writing that it can get tricky.

The individuals aren’t sharp in this shot – 
and they never could be, as they are 
moving during the 10-second exposure. 
But they are all clear – except for the poor 
old groom, who has rather disappeared 
into the darkness in his suit. With a little 
work in Lightroom with an Adjustment 
Brush and the Shadows slider, you might 
be able to rescue him a bit.

My only real criticism is the backdrop. 
I like that bit of ambient sky you can see, 
and would like you to have made more of 
this to frame the group against. Easy for 
me to say, of course – maybe there was 
nowhere else you could take the shot – 
so it’s more of an observation.

estelle 
Keeber

A special keepsake 
for a friend’s 

wedding reveals 
Estelle’s long-

exposure skills

rat
e

mY 
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Beautifully panned so the 
subject is sharp enough.

Good crop to make the 
most of the scene you had.

 
Watch those dust spots 
spoiling the image.

A shooting position without 
the buildings behind would 
also help.

NICely dONe

ROOM FOR IMPROveMeNT

RiChARD sAys: i go to the 
royal international air 
tattoo every year – but in 
2015, i was one of only two 

people picked to go air-side with tattoo 
photographers rich Cooper, Jamie 
Hunter and the legendary Katsuhiko 
tokunaga. It was a great privilege to be 
with them throughout the day, and it gave 
me unlimited access to the aircraft as they 
landed, taxied and parked.

I have been experimenting with 
different camera settings to get just 
a panning effect I like, as I’m not a lover 
of over-panning. The shot was taken on 
a Canon EOS 1-DX and a 300mm lens, 
with an exposure of 1/80 sec at f/11.

ANDREW sAys: beautiful 
shot, richard. i can almost 
hear the roar of the spitfire’s 
engine! I’m not an aircraft 

buff, but even I have to admit there is 
something about the sight of this iconic 
aircraft in action that really brings a lump 
to the throat.

I think you’ve certainly done the Spitfire 
justice with this shot, and your panning 
experiments have definitely paid off. There 
is enough solidity and sharpness to the 
shot for the aircraft to be clear and 
recognisable – particularly important 
when you’re such an enthusiast – but the 
streaking gives it that all-important sense 
of speed and helps it to stand out from the 
background. The way the shutter speed 

has also blurred the propeller blades all 
adds to the overall effect.

Obviously you’ve cropped the image. 
This was a good move, as it has helped you 
lose that flat, white sky. It’s a shame there 
wasn’t a bit of detail in the sky at the time 
to help you out, but there’s nothing you 
can do about that.

One little thing to try and spot next 
time is the dust marks from your sensor 
showing up on the background. If you have 
any dirt on the sensor, you can be sure a 
slow-shutter-speed panned shot will reveal 
them. You can easily spot these out with 
the Healing Brush in Photoshop – then 
give your sensor a clean too!

richard 
Chappell

Richard makes the 
most of the Air 

Tattoo with this 
cracking shot of a 
Spitfire taking off

rat
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jolqa          What this beautifully presented image may lack in exuberance is 
more than compensated for by the elegant composition and sophisticated treatment. 
The choice of crop, along with the centred pole and figure, lend a natural balance to 
the frame, while the monochrome treatment, vignetting and subtle texture in the 
backdrop bring depth. The restful mood created is probably quite at odds with the 
effort required on the part of the dancer to hold this position.
No shooting information 

1 2 step haiselDen          Long exposures and intentional 
camera movement are popular techniques for conveying the energy 
of a dance routine. This eye-catching photo really takes it to the 
extreme, producing an abstract play of light and shade in which only 
the merest hints of the performer’s movements during a rehearsal 
are allowed to register.  
No shooting information

1
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The winners of our ‘theatre and dance’ contest – 
and details of this month’s outdoor challenge

assignment

This month’s photo assignment  
is all about wild weather – see the  
full details over the page…

EvEry issuE, we challenge you to take the 
most creative and arresting shot around a 
theme, and share it at the online community 
at Photocrowd (www.photocrowd.com). 
Here, you’ll be able to browse the entries and 
vote for your favourites. The best entries 
receive a critique from our judging panel – 
and one winner receives a special prize!
 Your mission in issue 172 was to shoot 
theatre and dance. We suggested that 
anything could top the bill, be it an image 
taken during a live show or a portrait of a 
performer in the studio, and that any style 
of photography was fair game too. The 
submissions were packed with variety, with 
abstract blurs, candids and silhouettes being 
some of the most popular creative techniques 
on show. Here’s our top selection…

Charles paul azzoparDi          A superbly timed capture where the 
foreground and background elements are perfectly aligned. A camera with a fast burst 
rate can, of course, give you an edge when it comes to capturing a moment like this, but 
fast reactions on the part of the photographer make the real difference. The dynamic 
pose, motion blur and black-and-white finish combine to create a captivating image.
Kit Canon EOS-1D X with 70-200mm f/2.8L IS II USM lens at 200mm 
Exposure 1/320 sec at f/2.8, ISO 640   

3 4

nenaD martiC           
Chosen by the voting community 
at Photocrowd.
Kit Canon EOS 7D with 100mm lens 
Exposure 1/125sec at f/2.8, ISO 100
 

CrowD vote

Crow
d 

vote

TURN 
OVER!

There’s a storm 
coming… can you 

capture it in a 
creative way with 

your camera?

2

3

4
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some of the most beautiful and 
dramatic landscape images are the 
result of pretty ugly weather. From 
long exposures that tame crashing waves 
and whipped-up clouds, to the  snatches 
of sparkling light in between downpours, 
there are plenty of rich pickings on offer for 
the patient, parka-clad photographer. 
 While many will head to the coast when 
there’s a storm on the horizon, don’t overlook 
the potential in rural and urban settings. 
Underexposing dark clouds and using flash 

to illuminate a foreground object 
will create a thrilling contrast, 

while  the action of wind 
across fields and through 
forests can add an edge to 
familiar scenics.

How to enter
Visit www.photocrowd.

com/a/current and look 
for the Digital Camera 

Perfect Storm contest. 
(You need to register, but it’s free 

to join.) Click Submit An Image to 
upload your  entry. The closing date is Friday 
26th February. The creator of the best photo 
in the judges’ opinion will receive a brand-
new Lowepro Transit Sling 250 AW bag. The 
Crowd Vote winner also receives a special 
prize. A selection of 
winning images will 
appear in issue 176.

For this issue’s contest, 
we want you to head out 
when everyone else is 
heading in, and capture 
striking pictures of 
stormy weather

perfeCt 
storm

ENTER 
TODAY!
www.photocrowd.
com/a/current 
closing date: Friday
26th February

win a Lowepro transit 
sLing 250 aw baCkpaCk!
We’re giving away this super-convenient Lowepro 
camera backpack worth £82 to the lucky winner 
of our new photo challenge. 

The Transit Sling 250 AW offers flexibility and 
fast access when you’re out shooting. A side opening 
enables you to pull out your camera on the spur of 
the moment. Its innovative UltraFlex™ fit system 
gives you multiple ways to organise equipment – 
and the All-Weather Cover™ means gear is safe from 
the rain. Visit the Lowepro website for details of its 
entire range of photographers’ bags.
www.lowepro.com

new assignMent
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Best known as a TV presenter on wildlife 
shows, Chris Packham is also a skilled nature 

photographer, as Geoff Harris discovers

CHRIS 
PACKHAM

I n t e r v I e w

W
ere you 
interested in 
photography 
as a kid?
No, I didn’t really 
get into it until 

I was in my early 20s. I played in a 
band but it never went anywhere, so 
I ended up selling my gear and buying 
a Canon A1 SLR.

I’d always been into art, and there 
had always been a big divide about 
whether I went for art or biology. I’d 
always painted too, and my mother 
used to take me to art galleries. So 
after I graduated in zoology from 
Southampton University, I did some 
sculpture, and it was then that I got 
more into photography.

I photographed wildlife, as I knew 
a bit about it. From the outset, 

I wanted to take pictures that were 
different from other photographers – 
I wanted to do more ‘arty’ images.

Which other photographers 
influenced you?
I used to look a lot at the work of 
Ernst Haas, from the 1960s and 
1970s. He was a National Geographic 
photographer and would do slow 
exposures on Kodachrome. His book 
The Creation really impressed me: 
nobody else was doing anything like 
it. I didn’t try to mimic Haas’s style, 
however – I just liked the way he 
looked at the natural world in 
a completely different way. So 
I thought, “How can I look at it in 
a different way too?”

Initially my work was very surreal 
and manufactured. I thought it was 

All photos: Chris Packham



 Chris says: “Part of a huge crowd of more than 
100,000 King Penguins, backlit on the banks of a  

river draining into St Andrews Bay, South Georgia.  
The silver-rimmed fluffy youngsters looked great, so 

I ‘crushed’ them together with my 500mm Nikon 
lens and under-exposed by about three stops.”



I n t e r v I e w

86            D I g I ta l  C a m e r a        MARCH 2016 www.digitalcameraworld.com

striking, but I under-estimated how 
entrenched and conservative the wildlife 
photography world was. When I showed 
them my early work, they didn’t get it. 

How did you get your first break?
The first few years were quite hard. 
Eventually I got some portfolio work 
printed in the magazine Creative 
Photography, which was reassuring, 
and then I won a couple of competition 
prizes. I won joint-first in the Graphis 
photography competition with a picture 
of a dead fish that I’d spray-painted gold, 
so it looked like a fossil. I then started 
to get more work printed.

Which of your early projects were 
you most satisfied with?
I’m never happy or satisfied with my 

Above      
Chinstrap Penguins
“These three unlucky 
penguins were stuck on top 
of a beautiful blue giant 
’berg which had calved 
and rolled to leave them 
stranded high above the 
sea. When one peeped over 
the side in forlorn hope, 
I had the shot. Again, 
I used the 500mm lens.”

CHRIS 
PACKHAM

Chris was born in 
Southampton in 1961. 
He’s a household name 
thanks to his regular 
appearances on hit TV 
series such as The 
Really Wild Show, 
Springwatch and 
Autumnwatch.

Chris studied zoology 
at university, and was 
a cameraman before 
breaking into TV and 
writing work.

Photography has been 
another passion of his 
since he was a student. 
His books include 100 
Things That Caught My 
Eye and Back Garden 
Nature Reserve. He 
also leads tours  
and workshops.

images, to be honest, but I’ve always tried 
to imagine photos, draw them, and strive 
to make that a reality.

In one early project that worked quite 
well, I got some red mushrooms and 
placed them as if they growing out of 
corner of the kerb by a drain. I then got 
my girlfriend at the time to put on some 
fishnet tights and stilettos and walk 
past. I lit it as well, using power from 
a neighbour’s kitchen. Somebody told me 
that I should be shooting ads for Pretty 
Polly tights!

In another project, I carefully collected 
a lily pad and recreated it on the floor 
of a warehouse, so it looked like it was 
growing out of the floor of a very 
incongruous environment. It took days…

CHRIS PACKHAM

Above right      
Walrus and calf
“Shot somewhere 
in Arctic Canadian 
waters. This was the 
one close encounter 
we had with any large 
mammal on this trip. 
Every creature was 
terrified because 
the level of local 
aboriginal hunting 
is out of control.”

Right      Grey Wolves
“Shooting them 
in Scandinavia is 
difficult, as they are 
so timid because of 
hunting pressures. 
I used a 1.4x converter 
on my 500m lens.”
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You then became a wildlife film 
photographer, right?
Yes, although I focused on stills 
photography for periods of time. I’ve 
known full-time pro stills photographers, 
but they have always struggled, and 
I didn’t want to go back to having no 
money. For the last two years I have been 
focusing on my writing and have not 
done much photography at all. I’m now 
back into it though, and I’m coming up 
with lots of ideas.

How would you currently describe 
your style as a wildlife photographer?
It’s become a lot cleaner over the years. 
I am OCD and don’t deal well with detail 
and clutter. I’m speaking to you from 
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CHRIS PACKHAM

a kitchen where you wouldn’t know 
anyone was living in the house.

I did a proposal with another 
wildlife photographer recently, 
and his approach was so radically 
different to mine. His images involved 
the environment, while mine did 
everything they could to cut it out, 
using close-up techniques rather than 
wide angles. I focused on aspects that 
were beautiful in their own right 
rather than the bigger picture.

I find more harmony in my 
photographs by focusing on detail 
and cutting out the clutter. I am 

Above left       
Tawny Owl  
“I ‘built’ this row of 
birch trees in my 
garden to photograph 
this young Tawny Owl. 
I used a telephoto.”

Above right      
Nile Crocodile
“I set it against the 
backdrop of glowing 
green weed which 
carpeted the water 
behind it.”
 
Right      Otter
“I shot this at the 
British Wildlife Centre 
in Surrey. I’ve no 
qualms about working 
with captive animals 
as long as they are 
well looked after.”

QUICKFIRE Q&A

What was your 
first-ever camera?
I inherited a Box 
Brownie from my 
parents, which 
I customised with 
a sticker from the kids’ 
TV series Joe 90.  
Get the full story at 
chrispackhamphotos.
com/concepts/
History.htm

What kind of band 
were you in?
A punk rock band, but 
I wasn’t very good. 
I don’t have much of 
an ear for acoustics, 
so I sold my gear and 
bought an SLR.

What’s your next  
book about?
It’s an autobiography 
called Fingers in the 
Sparkle Jar. It’s 
available in May.

hyper-critical about my work, and 
a real perfectionist. Sometimes 
it takes the enjoyment out of 
photography, but it’s the way I am.

Do you believe photographs can 
still make a difference to the 
cause of conservation?
Yes, definitely. Photography is still 
a very powerful medium. It can 
communicate beauty and hope – and 
yes, it can be depressing when you see 
what is happening to wildlife. A great 
photograph really hits you between 
the eyes.
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What’s your attitude to infrared 
camera traps when it comes to 
photographing wildlife?
I don’t mind at all, so long as the 
animal isn’t harmed. Camera traps 
or not, you still need to make choices 
about exposure, angles and so on. 

If the animal is rare, shy and 
inaccessible, then traps are perfectly 
acceptable. Take Steve Winter’s 
amazing images of snow leopards,  
for example, which he wouldn’t have 
got otherwise.

How did you find the advent 
of digital cameras?
Quite difficult actually. I liked the  
feel of transparency film, and the 
discipline of working with it and 
trying to get the exposure spot-on. 
I’ve always been a photographer who 
likes rules and constraints. A recent 

project involved shooting damselflies 
in the New Forest and I set out the 
exact area I was going to work in, 
sticking to just two lenses. But I love 
the 36MP Nikon D810. I love being 
able to crop, change colour and be 
creative, doing the kind of things 
I could only dream about when I 
was shooting film.

What about the thorny issue  
of Photoshop?
I do use it and Lightroom, and will 
remove distractions or even do some 
comping, but I am always open about 
it. You should never pretend you 
haven’t used Photoshop and try to lie.

You are a competition judge, and 
see a lot of images. What kind of 
errors do you see again and again?
One of the biggest errors that we see 
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NEXT
MONTH
The American 
chronicles of 

Alec Soth

repeatedly when sifting through 
thousands of images, is choosing 
the wrong format – horizontal or 
vertical. You do need to really think 
about the very best format for the 
subject you are photographing, and 
be prepared to twist the camera 
around if necessary.

Also, and this is a really important 
point, don’t just take a photo of the 
opportunity: you need to see the 
photo in the opportunity. You have  
to be able to interpret it, personalise 
it, and put it in the image. Take the 
scenario of one creature killing 
another, for example. That is the 
photo opportunity, but where is the 
real photograph in there? You need  
to really think about these things 
before shooting.

When judging competition entries 
I also see a lot of over-processing, 
with cartoon-like images that end 
up looking they could have been 
produced by Pixar. When choosing 
images to shortlist, the impact of 
an image is more important than the 
technical aspects too.

What are you going to be talking 
about at The Photography Show?
I’ll be discussing how I work, 
how I get ideas (often when I’m 
stuck on the motorway) and my 
particular approach. If I was going 
to photograph elephants, for 
example, I would go online and 
look at thousands of images until 
I familiarised myself with how 
they tend to be photographed – then 

I would do something different. So 
my photography is about thinking 
in advance and not just producing 
replicas of other people’s work.

I’ll also stress the importance of 
taking risks with your photography. 
I’ve been shooting birds recently, 
straight into the sun, to really make 
use of lens spots. It really does pay  
to choose the hardest option 
sometimes: you end up with 
a far more interesting picture.

You can learn more about  
Chris by heading over to  
www.chrispackham.co.uk and 
more about his photography 
(including some truly  
fascinating blog posts) at  
www.chrispackhamphotos.com

CHRIS’S kIt Bag
Chris says: “My main 
camera is now the 
Nikon D810, as I need 
lots of pixels, but 
I really wish they would 
put it into a D4 body. 
The D810 is not made 
for rough pro use, 
which I find frustrating.

“My favourite 
lenses are the Nikon 
105mm macro, the 
500mm and the 200mm 
f/2, though the latter 
is very heavy. I much 
prefer prime lenses to 
zooms; I have tried 
zooms, but there are 
always compromises.”

Above      Hawk
“My first composite image, 
made before Photoshop 
had been thought of! Taken 
in 1984 on a 6x4.5 camera.”

Below left      Snowy Owl
“One morning I went to The 
Hawk Conservancy Trust 
near Andover and lay in the 
cold to take this shot.”

See Chris Packham at 
The Photography Show 
at the NEC, Birmingham 
this March. Visit www.
photographyshow.com 
for details and tickets. 
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issue for FREE!

 

take out our risk-free trial  
and pay nothing for 30 days

  Pay less per issue
   Download the latest 
issue instantly
  Choose to download 
issues automatically
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GET  
IT now! 

Download the Digital 
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device and start  
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offering an insider’s view on photography 
today for professionals, aspiring 
professionals and enthusiasts alike. 
This month, wildlife photographer Will 
Burrard-Lucas shares his thoughts...

What do you know now about  
your job that you wish you  
knew starting out?
The biggest thing I’ve learned is the 
importance of being focused. By this 
I don’t mean camera craft, but trying 
to cover a particular subject in depth 
and exploring every creative possibility, 
rather than flitting between one subject 
and the next. At this point in my career, 
for instance, I now focus primarily on 
African wildlife. I’ve learned that the 
more I specialise in an area, the more 
opportunities seem to open up for me.

In general, I think an in-depth body 
of work on one subject is much more 
valuable than a large selection of good 
shots on a host of unrelated subjects. 
We don’t think this way when we’re 
young and starting out: we try to be 
a jack of all trades. But if you can 
master one subject well, you will 
never be short of work.

How have new technologies 
changed your job?
I have always embraced new technology, 
and tried to use it to develop a fresh and 
innovative style for my photography. In 
particular, I have used new technology 
to develop my own devices for getting my 
camera up close to potentially dangerous 
wild animals. This led to the creation of 
BeetleCam, which is a remote-control 
buggy for my SLR cameras.

As I explored this technology, 
I launched Camtraptions to further 
develop remote and camera trap 
products for other forward-thinking 
photographers and film-makers.

hat do the top professional 
photographers wish they 
had known when starting 

out their career? In this new series, 
we’ll meet leading photographers as 
they reflect on what they have learned 
through experience, and how changing 
technology has affected their work. 

Each month, a photographer will give 
a personal insight into his or her own 
specialism and the broader industry, 

W

>

Will Burrard-Lucas has built a successful career 
around photographing African wildlife. “I’ve 
learned that the more I specialise in an area, the 
more opportunities seem to open up,” he says. 

WORK 
EXPERIENCE
The decision to narrow his specialism down to African 
wildlife has paid off handsomely for nature photographer 
Will Burrard-Lucas, as he explains to Jeff Meyer
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Above      Will’s 
BeetleCam device 
draws the attention 
of a young leopard 
in South Lunagwa 
National Park, Zambia. 

Far left      A lion 
savours his kill in 
Kidepo Valley, Uganda.

Left      Southern 
carmine bee-eaters 
take flight in South 
Luangwa National 
Park, Zambia.
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Which income streams have 
declined, and which new ones  
have emerged?
One of the most frequently asked 
questions I get is about how to make 
a living from nature photography – so 
much that I actually wrote an ebook on 
this topic called Build a Profitable 
Photography Business.

10 years ago, a wildlife photographer 
might have expected to make a living 
from licensing images through a stock 
agency, but times are changing, and this 
income source for photographers has 
declined significantly. This is largely due 
to the ubiquity of digital cameras and 
how far down they’ve come in price.

Digital photography allows so many 
more people to produce high-quality 
images who wouldn’t have had the 
same  access to equipment in the past. 
This creates an increase in supply, and 
coupled with the internet, cheap imagery 
is now easily accessible.

The internet has also put pressure on 
traditional publications like magazines, 
limiting their budgets and driving down 
the price of commissioned work. Most 
magazines can no longer afford to pay the 
same amounts for editorial photography 
that they did at the start of this century.

However, the very factors that led 
to the decline in the value of image 
licensing have also created some new 
opportunities for photographers. There 
are now more photographers than ever 
before, and this represents a huge target 
market. Up-and-coming photographers 
look for workshops, trips, education 
materials and equipment. Creating 
products or services around these areas 
can be profitable, which is what I have 
done with my Camtraptions business, 
photo safaris and training products.

If you were starting your career now, 
would you still be a photographer?
Definitely! With the power of the internet 
and social media, there are so many 
opportunities to set up a photography 

“�The�very�factors�that�
led�to�the�decline�in�
the�value�of�image�
licensing�have�created�
new�opportunities��
for�photographers”
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business and talk directly to your customers, 
who may be based all over the world. 

How important is having a business 
sense in photography? How do you 
balance that against your creativity?
There’s very little point having an incredible 
talent if you don’t know how to market your 
images and get your name out there. You 
need to be able to translate your talent into 
sales. Luckily I am as passionate about the 
business and marketing side of photography 
as I am about the photography itself, but 
there’s definitely a difficult balance to strike 
between working on the business side of 
things and being out in the field. I may have 
a period of time where I want to focus on the 
business side; during these periods I try not 
to travel too much. 

What are some of the mistakes you see 
from others who are making the leap?
I think a lack of focus on a particular project, 
subject or geographical area is something 
a lot of up-and-coming photographers fail 
to do. Photographers need to decide what 
they want to be known for, and really focus 
on that. This is something I wish I’d known 
when I first started.

How do you see photography and the 
photographic profession changing in 
the future?
Technology is playing a massive role in how 
the photographic industry is progressing. 
Look at how drones have revolutionised 
aerial photography in just a couple of years. 
In wildlife photography, remote-control 
cameras and camera traps are making 
it possible to photograph animals in 
completely new ways. As high-quality 
cameras get smaller, this also increases the 
possibilities of what we can do with them.

Above      Will used his 
BeetleCam for this 
shot of a wild dog in 
Hwange National Park, 
Zimbabwe.

Far left      Will’s 
attempt to photograph 
a baby hippo soon 
caught the attention 
of its mother!

Left      Shots like this 
oryx prove popular on 
Will’s website, where 
he sells art prints.

• For more of Will’s images, visit  
www.burrard-lucas.com or follow him  
on Facebook www.facebook.com/
BLphotography or @willbl on Instagram.

• For more about 
Camtraptions, Will’s 
remote and camera 
trap product 
business, visit www.
camtraptions.com

• For more training 
and advice from Will, 
plus a free online 
wildlife photography 
course, visit www.
wildlifephoto.com
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Scott Kelby shows how to make a wedding portrait look its 
best by with the help of an apparently invisible light source

tHe bRide 
woRe bRigHt

his issue we’re 
returning to an old 
stomping ground: 

wedding shoots. Here’s an 
effective location lighting 
technique for when you’re taking 
a formal portrait of the bride.

Part of the technique is done 
in-camera, the other part in 
Photoshop. We’re only going to 
use one simple hotshoe flash, and 
it’s an inexpensive one — the 

T

See Scott Kelby at The 
Photography Show at 
the NEC, Birmingham, 
this March. Visit www.
photographyshow.com 
for details and tickets 
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SCott Kelby P r o  z o n e

STEP 1

STEP 3

STEP 2

STEP 4

There’s one more accessory I would 
recommend, but it’s cheap too. It’s the 
Yongnuo YN-560 II Wireless Flash Controller, 
which lets you change the power of the flash 
from right on top of your camera.

It’s only £45 and worth every penny, because 
your flash is actually inside the softbox, so you 
can change the power without digging around 
inside the box or taking off the front diffusion 
panel. Also, you can control up to three groups of 
flashes and turn them on and off individually, all 
from this unit. If you had to buy every bit from 
scratch, it would be around £300 for the flash, 
the wireless controller and the huge softbox. 

Once you take that shot, where you can 
clearly see the softbox, ask your assistant to 
pick up the light (it’s not heavy) and move it 
far away so you don’t see the light at all in the 
scene. So all you’re getting is the ambient light in 
the reception hall and no light from the flash. 
Now take your second shot.

You want to keep your camera up to your eye 
the whole time, to minimise your movement 
between frames. If you’re shooting on a tripod, it 
doesn’t matter: you can theoretically take all the 
time you want, but you need to ask the bride to 
hold her pose until you’ve taken both shots, so 
it’s best not to wait too long between them.

Flash controller

take the second shot

There are four great things about this 
softbox. First, it’s pretty huge – and the bigger 
the softbox, the softer the light, so when I have 
a choice, I ‘go big’ like this. Second, it’s 
collapsible like an umbrella, so despite its large 
size, it’s super-portable and sets up fast. 

Third, the flash aims backward towards the 
back of the softbox, not directly at your subject, 
so the light reflects and bounces back towards 
your subject. This avoids a hotspot in the centre 
and creates even softer light all the way around. 
Finally, since it’s so large, you can light groups 
with it. For a softbox this large, £210 really is 
something of a bargain.

FirsT you’re going to position the light right 
near your subject. In this case I’m positioning 
it next to our bride. As you can see from the 
production shot above, the lighting isn’t aimed 
directly at her — it’s aimed a bit past her, so the 
light is just skimming her a bit. That way, the light 
is more subtle and softer because the light that’s 
hitting her is from the edges of the softbox, 
instead of from the centre. (You may have heard 
this technique referred to as feathering the light).

You can also see my photo assistant Brad 
‘The Beard’ Moore standing by as I take the shot. 
It’s important to have someone to help, as you’ll 
discover in the next step.

the softbox

the first shot

Yongnuo YN-560. It’s only £45, 
which is amazing for a decent unit.

Then we’re going to use a 
collapsible softbox made for 
hotshoe flash — the 50-inch 
Recessed Mega JS Apollo from 
Westcott, for around £210. 
Anyone who came to my London 
seminar last summer will 
recognise this as the one I used 
during my live portrait shoot.
www.scottkelby.com
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nOw open both images in 
Photoshop. Go to the image 
that has the bride lit by the flash. 
Choose Edit > Select All then Edit 
> Copy. Next, go to the image 
with no flash (the ambient light 
image) and use Edit > Paste to 
add the first image to this, as a 
layer on top.

If you used a tripod, you can 
skip the rest of this step, but if 
you hand-held the shot like I did, 
you’ll need to have Photoshop 
automatically align the two 

images so they line up with each 
other. You do this by going to the 
Layers panel and selecting both 
layers, then choosing Edit > Auto 
Align Layers. 

When the Auto Align dialog 
box appears, use the default 
setting of Auto and click OK. In 
just a few moments, your two 
images will be perfectly aligned. 
You’ll need to slightly crop the 
image to hide the white edges 
created by the alignment, but 
that can wait.

Prepare the images

STEP 5

GO to the Layers panel and 
click on the top layer (the one 
with the softbox in-scene). 
Hold down the Alt key and click 
the Layer Mask icon at the 
bottom of the Layers panel – it’s 
the third button from the left. 
This adds a black layer mask 
over your entire layer, so the lit 
layer is now hidden behind that 
black mask, which is exactly 
what we want.

Get the Brush Tool and 
choose a small soft-edged brush 
from the Options Bar at the top 

of the screen. Make sure your 
Foreground colour is set to 
white. Now  simply paint over 
the bride so she appears ‘lit’: 
you’re revealing that one part of 
the lit image layer that’s hidden 
behind the black mask.

As long as your bride isn’t 
close to the background in the 
shot, you won’t have any trouble 
painting her in — it’ll take all of 
five seconds. If she’s close to the 
background, then you have the 
worry of spilling light onto the 
background as you reveal the lit 

version of her. You can still do it, 
you just have to be more careful 
and use a smaller brush.

The last step is to use the 
Crop Tool to crop away those 
white edges created by the Auto 
Align move. Finally, I hate to  
say “just add contrast” – but 
add some contrast in Camera 
Raw, sharpen the image, and 
you’re done.

There you go: Some camera 
work, some Photoshop work, 
and a nicely lit image without 
spending lots of money. 

Paint in the light

STEP 6

Camera settings
When I’m shooting with flash – 
especially indoors like we are 
here, at a very popular venue for 
weddings and receptions – I set my 
ISO at the lowest, cleanest native 
setting for my camera. For my 
Canon 5D Mark III, that’s ISO 100.

Since I’m using flash, I always 
shoot in Manual mode so I can get 
my shutter speed at what I would 
say is a safe, ‘no worries’ shutter 
speed for flash: 1/125 sec. My 
f-stop is usually around f/5.6 if I 
want the background a little soft; 
but in this case I went with f/4.  
(I probably accidentally hit the  
dial on the back of my camera at 
some point.)

The lens I’m using for this 
particular shot is in vast contrast  
to the price of all the lighting gear, 
because it’s as expensive as all 
get-out. (That’s American for ‘it 
costs a lot’.) 

It’s Canon’s new 11-24mm ultra 
wide-angle lens, shot at 11mm. Of 
course, you don’t have to use this 
lens — any nice wide-angle will do 
the trick.
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How did Lee Miller become  
a photographer?
Miller’s passion for photography 
grew out of modelling. Her 

father, Theodore, was a keen amateur 
photographer; as a teenager she often 
posed for him, sometimes for nude figure 
studies. Miller started modelling for 
Vogue in New York in 1927, aged 19, and 
she became one of the supermodels of her 
time. However, when a photo of her was 
used to advertise Kotex menstrual pads, 
it caused a scandal and brought her 
career to an abrupt end.

When did she go behind the camera?
In 1929 Miller travelled to Paris, where 
she became Man Ray’s assistant and 
collaborator, as well as lover and muse. 
Ray taught her his studio techniques, and 
she sometimes did fashion shoots that 
were subsequently credited to him.

What was her role in Ray’s 
(re) discovery of solarisation?
While developing a print in the 
darkroom, Miller accidentally turned on 
a light, which caused the partial reversal 
of the image. Ray said this solarisation 
technique was “an escape from banality”, 
and went on to use it in some of his 
best-known photographs.
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How did World War II change her 
photographic work?
The war transformed Miller from a 
Surrealist-influenced studio fashion  
and portrait photographer into a 
photojournalist who documented the 
traumatic events she witnessed. She 
photographed the Blitz in London, 
then in 1944 became a Time Life 
correspondent and followed the US Army 
during its advance through Europe. She 
was almost certainly the only female 
photojournalist covering the front line 
of the war in Europe.

What did she photograph?
She photographed battles, including the 
siege of St Malo, at close range and was 
present at the liberation of Paris. She also 
took bleak and harrowing images of 
victims at the Buchenwald and Dachau 
concentration camps.

Strange but true…
In 1945, Miller and fellow photographer 
David Scherman moved into Adolf 
Hitler’s private apartment in Munich 
after it had been abandoned at the end of 
the war. She was living there when the 
Nazi leader’s death was announced. 
“I took some pictures of the place, and 
I also got a good night’s sleep in Hitler’s 

bed,” she later wrote. “I even washed the 
dirt of Dachau off in his tub.” Scherman 
photographed Miller in the bath to prove it.

How did Miller react to all her 
wartime experiences?
She returned to photographing for Vogue 
for two years, but the experience of war 
took its toll and she only worked 
intermittently in the following years. 
Suffering from what might now be 
described as post-traumatic stress 
disorder, she struggled with alcoholism 
and depression for many years before her 
death in 1977. It’s only since the 1980s 
that Miller’s achievements have become 
widely appreciated.

Why is she in the news?
The exhibition Lee Miller: A Woman’s 
War is at the Imperial War Museum, 
London, until 24th April. An 
accompanying book has also 
been published, with text by 
Hilary Roberts and Miller’s 
son, Antony Penrose. Both 
use her photographs to 
explore the impact of World 
War II on women’s lives, 
while giving an insight into 
an important part of Miller’s 
extraordinary life.
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One woman’s journey  
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Lee Miller offered a 
distinct perspective 

of World War II.
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35mm prime lenses
Eight pieces of glass featuring a focal 
length many street photographers favour

sony Fe 90mm f/2.8  
macro G oss
A high-quality prime for Sony Alphas

FUJiFilm X-T1 vs  
olympUs om-D e-m5 ii
The battle of the retro CSCs

Drones
They’re one of the hottest technologies 
around – but which one is best for you?

TriGGer sysTems
Six ways to make your camera shoot in 
response to light, sound or other effects

Given to the top 
product in a  
group test

For products  
that offer superb 
value for money

Given to products 
that receive five 
stars overall

Given to products 
that are innovative 
& groundbreaking

Given to products 
that merit very 
special attention

reviews you can trust

Our five awards

Digital Camera is brought to you by 
the UK’s most experienced team of 
photography journalists, which means 
you can trust everything you read, and 
compare kit with confidence. 

We believe the best way to test a 
product is to use it as it was intended. 
Our real-world testing involves taking 
equipment on a proper shoot – 
whether outdoors or in the studio – 
and using it exactly as you would, to 
let you know if it’s fit for purpose. 

Scientific data won’t tell you 
everything, but it’s a great way to 
make comparisons and sense-check 
our real-world conclusions. We have a 
series of controlled tests for cameras 
and lenses that deliver objective 
benchmarks. You can download the 
high-resolution test images and 
resolution charts we shoot from www.
techradar.com/cameras. This means 
you can check the quality yourself – 
and even run your own tests.

Scores explained
Each of our tests scores  
out of five in one or more 
sub-categories; then we award 
an overall mark out of five. 
Digital Camera is 100% 
independent – and never 
swayed by advertisers. The tests 
you read are our genuine, 
unbiased opinions. Our company 
has a strict code of conduct on 
testing – the most rigorous of 
any photo magazine.

Forget it

Below average

Good for the price

Very good all round

An exceptional,  
best-in-class product

111

DiGiTal camera aWarDs: 
VoTe For yoUr FaVoUriTe!
Pick your favourite products of the year
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Two stylishly retro compact system cameras face off
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olympus e-M5 II
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FujiFilm X-t1 olympus e-m5 ii S
velte, stylish and 
sophisticated, these 
two supermodel 
cameras look eager to 
strut their stuff, with 
classic retro designs 
that are lean, luxurious 

and meticulously crafted. Indeed, the 
weather-sealed magnesium alloy bodies 
of these mirrorless compact system 
cameras put many a dull-looking plastic 
SLR to shame.

The main difference between these 
cameras and an SLR is that there’s no 
reflex mirror inside. Instead, a live feed 
is taken direct from the image sensor and 
fed to an electronic viewfinder (EVF), 
placed fairly centrally at the top. This 
gives you the choice of composing 
shots on the rear screen or through 
the electronic viewfinder.

If you’re used to an SLR viewfinder, 
you’re likely to feel both gain and loss 
when eyeing things up through an EVF. 
The gain is that a scene appears as a 
direct preview of the resulting shot, with 
exposure values, white balance and other 
settings all part of the picture. It’s ‘what 
you see is what you get’ photography. 
The loss is that, despite both cameras 
featuring high-quality, high-resolution 
2.36MP OLED viewfinder, the view isn’t 
as detailed as when using an optical 
viewfinder, and you can find yourself 
feeling a step removed from reality. That 
said, the X-T1 offers a ‘natural’ viewing 
option, which we’ll come to later.

Features
While the external design ethos looks 
very similar, there’s a major difference 
between the two cameras in terms of 
their image sensors. The X-T1 has an 
APS-C format sensor that measures 23.6 
x 15.6mm and gives a 1.5x crop factor 
compared with a full-frame camera. The 
E-M5 II has a rather smaller 17.3 x 13mm 
Four Thirds sensor with a 2.0x crop 
factor. Considering that both sensors 
have an almost identical pixel count, a 
little over 16MP, this results in the E-M5 
II having smaller photosites, which 
makes high dynamic range and signal-
to-noise ratio more of a challenge.

Backed by an EXR II processor, the 
X-T1’s X-Trans II image sensor features 
a hybrid autofocus system that combines 
both phase-detection and contrast-
detection for speed and accuracy. The 
architecture of the sensor, with its 
randomly patterned colour filter array, 
also avoids the need for an optical 
low-pass filter, which brings a potential 
boost in retaining fine detail and image 
texture. For its part, the E-M5 II uses 

Website   www.canon.co.uk
Street price (body)   £1,130/$1,400
Image sensor   20.2MP CMOS
Sensor size   23.6 x 15.6mm APS-C (1.5x)
Max image size   4,896 x 3,264
Image processor   EXR II
Low-pass filter   No
Viewfinder   Pentaprism, 0.71x, 97%
Lens mount  Fujifilm X
Viewfinder   Electronic, 2.36MP OLED
ISO range (expanded)   ISO 200-6,400 (100-51,200)
Autofocus points    Hybrid phase/contrast, 77-point
Shutter speeds    1/4,000 to 30 sec, Bulb 60 min
Flash   External, hotshoe
Max burst rate   8fps
Image stabilisation   Via lens
Video – max resolution   1080p, 60/50/30/25/24fps 
LCD screen   3.0-inch, 1,040k, tilt 
Memory   SD/SDHC/SDXC UHS-II
Wireless connectivity   Wi-Fi
Interface   USB 2.0, HDMI, mic
Body materials   Magnesium alloy
Body (W x H x D)   129 x 90 x 47mm
Weight   440g
Battery life (Cipa)   350 shots

Website   www.olympus.co.uk 
Street price (body)   £870/$900
Image sensor   16.1MP Live MOS
Sensor size   17.3 x 13.0mm 4/3 (2.0x)
Max image size   4,608 x 3,456
Image processor   TruePic VII
Low-pass filter   No
Viewfinder   Micro Four Thirds
Lens mount   Fujifilm X
Viewfinder   Electronic, 2.36MP OLED
ISO range (expanded)   ISO 200-3,200 (100-25,600)
Autofocus points   Contrast, 81-point
Shutter speeds    1/8,000 to 60 sec, Bulb 30 min
Flash   External, hotshoe
Max burst rate   8fps
Image stabilisation   Sensor-shift (5-axis)
Video – max resolution   1080p, 60/50/30/25/24fps
LCD screen   3.0-inch, 1,037k, pivot, touch 
Memory   SD/SDHC/SDXC UHS-I
Wireless connectivity   Wi-Fi
Interface   USB 2.0, HDMI, mic
Body materials   Magnesium alloy
Body (W x Hx D)   129 x 90 x 47mm
Weight   440g
Battery life (Cipa)   350 shots

a Live MOS sensor coupled to a TruePic 
VII processor. Autofocus is purely of the 
contrast-detection variety, which is 
renowned for being somewhat sluggish. 
Again, there’s no optical low-pass filter to 
cloud resolution, and the E-M5 II has the 
additional sharpness boost of a five-axis 
sensor-shift image stabilisation. 

The X-T1 relies on optical stabilisation 
which, naturally, is only available when 
using stabilised lenses. Not only is the 
E-M5 II’s stabilisation extremely good, 

it enables a trick high-res shooting mode. 
This uses the stabiliser to sequentially 
shift the sensor slightly, throughout 
a number of shots, then builds up an 
ultra-high-resolution 40MP image 
(64MP in raw mode) that combines 
the shots in-camera.

Something of a speed demon, the 
subsequently launched Fujifilm X-T1 
Graphite edition boosted shutter speeds 
to as fast as 1/32,000 sec when using 
the camera’s electronic rather than 
mechanical shutter. The main benefit 
is that you can use wide apertures 
even in bright conditions. However, the 
original X-T1 soon caught up, courtesy 
of a firmware upgrade. The E-M5 II beats 
the X-T1 for mechanical shutter speed, at 
1/8,000 sec compared with 1/4,000 sec, 
but has a slower maximum electronic 
shutter of 1/16,000 sec.

Autofocus and metering points are 
quite evenly matched, but the E-M5 II 
draws slightly ahead. The X-T1 has 77 AF 
points and 256 metering zones; the E-M5 
II has 81 AF points and 324 metering 

While the external 
design looks very 
similar, there’s a major 
difference between 
the two in terms of 
their image sensors
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1   
A conventional shooting mode 
dial includes full auto, PASM, 
art filters and scene modes.

2    
There’s no pop-up flash 
module, but a hotshoe is  
on hand for connecting  
an external flashgun.

3   
The knurled forward  
command dial encompasses 
the shooting button, so it’s 
within easy reach.

4   
A flash terminal socket is 
positioned on the front of the 
camera, as with the X-T1.

5   
The rear dual-mode lever can 
alter the functions of the main 
and sub-command dials.

6   
The LCD is a touchscreen as 
well as being fully articulated, 
for shooting from any angle.

1    
The exposure compensation 
dial lacks a locking button 
and is rather prone to being 
nudged accidentally.

2   

The layout of top-panel  
dials gives immediate  
access to wide-ranging 
shooting settings. 

3    
Just below the shutter 
button, the forward 
command dial is neatly 
recessed into the finger grip.

4    
Control dial turrets have 
drive and exposure mode 
dials on the lower decks.

5    
A tilt facility is nice to  
have, but the LCD screen 
lacks full articulation or 
touch-sensitivity.

6    
Pressing the Q button 
displays a quick menu.

zones. For sensitivity, the X-T1 has a 
native range of ISO 200-6,400 (ISO 
100-51,200 expanded, but only in 
JPEG mode), beating the E-M5 II’s ISO 
200-3,200 (ISO 100-25,500 expanded). 

With the latest firmware installed, 
both cameras can deliver 1080p full HD 
video at frame rates of between 24 and 
60 frames per second. The E-M5 II adds 
4K UHD video, albeit only for time-lapse 
sequences. Both cameras have built-in 
Wi-Fi for sharing and remote shooting.

Build & handling
At a glance, the top panels of both 
cameras look vaguely similar. Closer 
inspection reveals that the X-T1 has 
a more extensive set of hands-on 
controls, which are arguably better 
suited to enthusiast photographers.

For starters, the two main control 
turrets on either side of its viewfinder 
are double-deckers, with dials for ISO 
and drive mode on the left, and shutter 
speed and metering mode on the right. 
These work particularly well in 

conjunction with Fujifilm’s R-series of 
X-mount lenses, which have a physical 
aperture ring. For example, selecting the 
Auto mode on the shutter speed dial or 
the aperture ring selects the Aperture 
Priority or the Shutter Priority shooting 
mode respectively – or Program mode if 
both are set to the A position. As in the 
E-M5 II, the ability to preview exposure 
and white balance settings is a bonus. 
For a more natural view, you can cancel 
these options and use the viewfinder 
more like a purely optical unit.

A third rotary dial at the extreme 
right of the X-T1’s top panel enables up 
to +/-3EV of exposure compensation, in 
one-third click stops. However, we found 
that the exposure compensation dial was 
prone to getting rotated accidentally, 
especially when putting the camera into 
a bag. We’d prefer to see a locking button 
on top of the dial, like the one used for 
the camera’s ISO and shutter speed dials.

For its part, the E-M5 II turns out 
to be relatively basic on top. A more 
conventional, beginner-oriented mode 

dial gives obvious access to PASM modes 
as well as full auto, scene modes and art 
filters. The two right-hand dials, which 
sit fairly high and proud, are actually 
regular front and rear command dials, 
which the X-T1 incorporates in addition 
to its other top panel controls. On the 
plus side, the E-M5 II manages to 
squeeze three of its customisable 
function buttons onto the top panel, 
one of which gives access to an HDR 
mode that’s lacking in the X-T1.

Around the back, both cameras have 
a further range of control buttons, the 
usual four-way pad, and the ubiquitous 
LCD screen. The X-T1’s screen is a 
fairly basic 3-inch LCD with a 1,040k 
resolution and a tilt facility. It doesn’t 
allow the screen to flip right over for 
selfie shooting, but it’s still useful for 
high-level and low-level shooting.

The E-M5 II wins the LCD battle by 
adding touchscreen facilities and full 
articulation instead of just tilt. Even so, 
we feel that Olympus missed a trick by 
not adding touch navigation to its menu 

olympus  
om-D e-m5 ii

FujiFilm X-t1

head to headK i t  z o n e
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system, which would have given easy 
adjustment of shooting parameters. 
Instead, you’re stuck with the more 
conventional button-based procedure 
for trawling menus – which brings us 
to another point. While the X-T1’s 
menus are relatively intuitive and 
straightforward, those of the E-M5 II 
can seem positively arcane. You easily 
get lost in menu land, hunting for 
particular camera settings that are 
hard to find. And if you change any of 
the default function button settings, 
things can get really confusing.

Ultimately, the X-T1 wins out for 
handling. The E-M5 II feels like more 
of a ‘Marmite’ camera when it comes 
to the adjustment of controls and 
settings. There are those on our team 
that absolutely love it, and others who 
are, well, less enamoured. 
 
Performance 
Let’s start with autofocus speed. Fujifilm 
makes great claims for the performance 
of the X-T1’s hybrid autofocus system. It 
certainly proved very quick throughout 
our tests, even in fairly dull lighting. 

However, the purely contrast-detection 
system of the E-M5 II was very close 
behind, and every bit as accurate. A 
speed advantage of the E-M5 II in real 
terms is that you can simply ‘point’ to the 
subject on which you want to focus, using 
the touchscreen.

Metering is another close-run battle. 
Both cameras work particularly well in 
Multi or evaluative metering modes. The 
E-M5 II tends to err slightly more on the 
side of caution, sometimes delivering 
marginally darker images to avoid blown 

highlights. The X-T1 generally gives 
slightly brighter images and also has 
a dynamic range expansion mode that 
uses selective ISO adjustments across 
the image frame.

The X-T1 surges ahead of the E-M5 II 
when it comes to auto white balance, 
delivering natural-looking images under 
pretty much any lighting conditions. The 
E-M5 II strays to much warmer colour 
temperatures, regardless of whether or 
not the ‘keep warm colour’ option is 
enabled. Some might prefer the extra 

Fujifilm Olympus

White Balance      The X-T1’s auto white balance system is highly accurate in wide-ranging 
lighting conditions, whereas the E-M5 II is often very warm, whether in direct sunlight or in the shade.

image test

Around the back, 
both cameras have  
a further range of 
buttons, the usual 
four-way pad, and the 
ubiquitous LCD screen
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Fujifilm

Fujifilm

Fujifilm

Olympus

Olympus

Olympus

Colour      Colour rendition from the X-T1 looks a little fresher and more life-like, aided by the  
better white balance accuracy. Saturation is a little richer, and there tends to be greater vibrancy.

Metering      Exposure from the X-T1’s Multi metering is spot-on, with good detail throughout 
lowlights and highlights. The E-M5 II’s matching mode has produced a slightly gloomier-looking result.

Low light      Shot at ISO 6,400, the image from the X-T1 is noticeably cleaner and more 
noise-free than that of the E-M5 II, along with considerably better retention of fine detail.
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warmth for skin tones, while others 
won’t like the yellowish tinge that usually 
arises from using Auto white balance.

When you need to push sensitivity 
settings beyond ISO 1,600, image noise 
becomes much more obvious in the  
E-M5 II’s images, which can take on 
a comparatively grainy appearance. 
The X-T1 keeps images cleaner, while 
also doing a better job of preserving 
fine detail. You could argue that, in 
some situations, you don’t need to push 
the E-M5 II’s ISO so far anyway, thanks 
to its excellent built-in stabiliser. Really 
though, stabilisation is only a bonus for 
shooting static subjects.

In the continuous shooting race, the 
E-M5 II romps ahead with a 10fps burst 
rate, but the X-T1 doesn’t exactly lag 
behind at 8fps. Looking at the bigger 
picture of shooting speed, the X-T1’s 
superior control layout enables you to 
react faster. You can more easily get at 
the settings you want and make quick 
changes before the shooting opportunity 
is lost forever.
Matthew Richards 

In the continuous 
shooting race, the 
E-M5 II romps ahead 
with a 10fps burst rate, 
but the X-T1 doesn’t 
lag behind at 8fps

these two impeccably built cameras 
are things of beauty in their own right. 
More than that, they’re genuine alternatives 
to SLR cameras, in terms of control, 
versatility and image quality. That said, 
neither has the full-frame sensor advantage 
of Sony’s Alpha 7 compact system cameras. 

There are things we love about the 
Olympus OM-D E-M5 II, like its creative Live 
Bulb setting, which enables you to watch 

long exposures develop on the screen. It’s 
a little more compact than the Fujifilm X-T1 
and has twice the stamina. The E-M5 II’s 
fully articulated touchscreen and five-axis 
sensor-shift image stabiliser are further 
attractions. Ultimately, however, we prefer 
the handling of the X-T1. It puts pretty much 
all advanced shooting controls under your 
thumb, and its menu system is quicker and 
easier to navigate. 

Raw scores are better than in JPEG mode but, 
either way, high-ISO shots tend to look noisy.

Highlights are almost always well-preserved,  
but shadows can be a little murky.

raW* signal-to-noise ratio higher is better; raw results use images cOnverted FrOm tiFF

raW* DynamiC range higher is better; raw results use images cOnverted FrOm tiFF

The auto white balance system usually skews colour 
accuracy, producing overly warm results.

There’s very little in it for raw signal-to-noise, but 
the X-T1 delivers cleaner high-ISO images.

Scores aren’t great on paper, but highlights  
and shadows are usually well-detailed.

Despite almost identical lab scores, the X-T1 is more 
accurate in real-world shooting.
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Centre 0.16 Mid 0.21 Edge 0.74

The Sony is equally adept as a close-up 
macro lens and a short telephoto with 
attractive bokeh, but UK pricing is high.

WE SAY...

K i t  z o n e
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SONY FE 90MM F/2.8 MACRO G OSS

It’s not just the devil that’s in the detail

Released too 
late for our major 
group test of 
macro lenses 

in issue 171, Sony’s new 
offering is now present, and 
looks very much correct. It’s 
a full-frame format E-mount 
optic that’s ideally suited to the 
Alpha 7 series of camera bodies, 
further extending the appeal of 
Sony’s Alpha E-mount system.

A prime lens in every way, it 
boasts excellent build quality and 
a host of high-end features, along 
with a short telephoto focal length 
and full 1.0x or 1:1 magnification 
at its shortest focus setting.

Build & handling
The quality glass includes 
aspherical, ED and Super ED 
elements, plus Nano AR coating. 
There are 15 elements in all, 
arranged in 11 groups. Further 
highlights include DDSSM 
(Direct Drive Super Sonic-wave 
Motor) autofocus; an OSS 
(Optical SteadyShot) stabiliser; 
a three-position autofocus limiter 
switch that includes full-, short- 
and long-range settings; a focus 

hold button on the side of the lens 
barrel; and a well-rounded 
nine-blade diaphragm.

There’s no full-time manual 
override of autofocus as such. 
Instead, you can switch between 
autofocus and manual focus by 
nudging the focus ring forwards 
or backwards.

The manual focus ring has 
a fairly long travel and operates 
very smoothly, enabling precise 
adjustments. One downside of 
the system, however, is that the 
focus distance scale is inactive 
during autofocus. 

Performance
Autofocus is fairly fast, near-
silent and, coupled with an 
A7-series camera, extremely 
accurate. Sharpness and contrast 
are very good, even at the widest 
available aperture of f/2.8, which 
enables a tight depth of field for 
portraiture and other short 
telephoto shots. 

As with competing stabilised 
macro lenses, the effectiveness of 
the stabiliser is greatly reduced at 
very short focus distances.
Matthew Richards

Sony FE 90mm f/2.8 
macro g OSS £900/$1,100

1

The focus ring has 
a push-pull action for 
switching between 
swift, quiet autofocus 
and smooth, precise 
manual focus.

2

The focus hold button 
locks autofocus even 
if the camera is in 
continuous AF mode, 
and can be useful for 
both telephoto and 
macro shooting.

3

A bonus for both 
macro and telephoto 
shooting, the 
autofocus range 
limiter includes both 
long and short 
settings, operating 
either side of 0.5m.

Full-frame compatible      Yes
Focal length       90mm full-frame;  
135mm APS-C
Image stabiliser      Yes
Min focus distance      0.28m
Max magnification factor      1.0x
Manual focus override      Push-pull focus ring
Focus limit switches      Yes
Internal zoom/focus      N/A / Yes
Filter size      62mm
Iris blades      9 (rounded)
Weather seals      Yes
Accessories      Lens caps, hood
Dimensions (D x L)      79 x 131mm
Weight      602g

M A C R O  P R I M E  L E n s  w w w. s o n y . c o . u k

 VErDiCt  

 OVErAll  

 BUilD & HANDliNg  

 PErFOrmANCE  

 VAlUE  

 FEAtUrES  

SPECiFiCAtiONS

Sharpness levels are typical of current  
macro lenses with similar focal lengths.

SHArPNESS

Good colour fringing performance is  
about average for this type of lens.

The marginal amount of barrel distortion will 
be almost impossible to spot in most images. 
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t H e  B e St  P H OtO  P rO D U Ct S  O f  t H e  y e a r

VOt e  tO Day !
w w w. b i t . l y/ d c a 2 01 6

c l o s i n g  d a t e :  M o n d a y  8 t h  Fe b r u a r y

Have your say
We’ve seen some amazing cameras, 
lenses and accessories over the last 
12 months. Now it’s time to decide 
which one should become worthy 
winners of a Digital Camera Award. 
Over the page are our shortlists of 
gear across 18 award categories, 
from high-end cameras to phones 
for photographers, and from lenses to 
tripods. There will also be an award for 
the best overall camera, picked by the 
judges from the five winners of the 
individual camera categories. 

The winners of the DCAs will be 
chosen by a combination of this public 
poll and the votes of our judging panel. 
Visit www.bit.ly/dca2016 now to have 
your say – it’s quick and easy!
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High-End Compact
 
•  canon PowerShot G3 X
•  Fujifilm X100T
•  Leica Q
•  Panasonic Lumix DMc-LX100
•  ricoh Gr II

Enthusiast Lens
 
•  Fujifilm XF 16-55mm f/2.8 r 
LM Wr

•  Nikon aF-S DX Nikkor 
16-80mm f/2.8-4E ED Vr

•  Nikon aF-S Nikkor 
200–500mm f/5.6E ED Vr

•  Sigma 18-300mm f/3.5-6.3 
Dc Macro OS hSM c

•  Sigma 150-600mm F5-6.3 DG 
OS hSM | S

Enthusiast Camera
 
•  canon EOS 760D
•  Fujifilm X-T10
•  Nikon D5500
•  Nikon D7200
•  Olympus OM-D E-M5 II
•  Panasonic Lumix DMc-GX8
•  Pentax K-3 II

Compact or 
Bridge Camera
 
•  canon PowerShot G5 X
•  Fujifilm X30
•  Panasonic Lumix DMc-TZ70
•  Sony cyber-Shot DSc-hX90
•  Sony cyber-Shot DSc-rX100 IV

Action Cam
 
•  Garmin Virb XE
•  GoPro hero4 Black
•  GoPro hero4 Session
•  Isaw Edge
•  TomTom Bandit

Entry-level Camera
 
•  canon EOS 750D
•  canon EOS M3
•  Fujifilm X-a2
•  Nikon 1 J5
•  Olympus OM-D E-M10 II
•  Panasonic Lumix DMc-GF7

Pro Lens
 
•  canon EF 11-24mm f/4L USM
•  canon EF 35mm f/1.4L II USM
•  canon EF 100-400mm f/4.5-5.6L 
IS II USM

•  Sigma 24mm f/1.4 DG hSM | a
•  Sigma 24-35mm f/2 DG hSM | a
•  Sigma 35mm f/1.4 DG hSM | a

Drone
 
•  3Dr Solo
•  DJI Phantom 3 Professional
•  DJI Phantom 3 Standard
•  Parrot Bebop 2
•  Yuneec Typhoon Q500 4K

VOt e  By  8 t H  f e B r U a ry

c h o o s e  a  w i n n e r !  Vo t e  fo r  yo u r 
fa vo u r i t e  c a m e ra  p ro d u c t s  t o d a y !

CategOry 4 CategOry 5

High-End Camera
 
•  canon EOS 5DS
•  Leica M Monochrom
•  Leica SL
•  Pentax 645Z
•  Phase One 645DF+ IQ250
•  Sony alpha 7r II
•  Sony alpha 7S II

CategOry 1 CategOry 2 CategOry 3

CategOry 7 CategOry 8 CategOry 9

CategOry 6
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Storage Solution
 
•  G-Drive ev aTc
•  Samsung Pro+ SD
•  Seagate Seven
•  WD My cloud EX4100
•  WD My Passport Wireless

Accessory
 
•  Epson Surecolor Sc-P800
•  hähnel captur
•  Lastolite Perspective 
Backgrounds

•  Lowepro ProTactic
•  TurnsPro

Tripod
 
•  Benro Travel angel FTa18cc
•  Gitzo Traveller  
Kit Series 2

•  Manfrotto 190 Go!
•  Nest Traveller  
NT-6264cK

•  Sirui N-3204X

Camera Phone
 
•  apple iPhone 6S
•  LG G4
•  Panasonic Lumix DMc-cM1
•  Samsung Galaxy S6
•  Sony Xperia Z5

Photo Lab
 
•  Jessops
•  Loxley colour
•  One Vision Imaging
•  Peak Imaging
•  WhiteWall

Innovation of the Year
 
•  DJI Osmo
•  Lee Filters SW150 series 
adaptor for ultra-wide-angle

•  Olympus hi-res shot mode
•  Panasonic 4K Photo mode
•  Trace action tracker for 
GoPro cameras

w w w. b i t . l y/ d c a 2 01 6

CategOry 13 CategOry 14

Software
 
•  adobe Photoshop cc 2015
•  adobe Photoshop 
Elements 14

•  adobe Photoshop Lightroom 
cc 2015

•  DxO Optics Pro 10
•  Phase One capture One Pro 9

CategOry 10

Flashgun
 
•  canon Speedlite 600EX-rT
•  Gloxy GX-F990 TTL
•  Metz mecablitz 64 aF-1
•  Nikon Speedlight SB-700
•  Phottix Mitros+

CategOry 11

Studio Lighting
 
•  Elinchrom ELB 400
•  Ic12 LED Light cube
•  Interfit S1
•  Phottix Indra360
•  Profoto B2 airTTL

CategOry 12

CategOry 16 CategOry 17 CategOry 18

CategOry 15
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35mm 
primes

the contenders
1  canon EF 35mm f/2 IS USM, £400/$600

2  nikon AF-S 35mm f/1.8G ED, £430/$530

3  hd Pentax DA f/2.8 35mm Macro, £470/$500

4  samyang 35mm f/1.4 AS UMC AE, £360/$450

5 sigma 35mm f/1.4 DG HSM | A, £640/$900

6 sony FE 35mm f/2.8 ZA Carl Zeiss Sonnar T*, £530/$800

7  tamron SP 35mm f/1.8 Di VC USD, £550/$600

8  Zeiss Milvus 35mm f/2, £830/$1,120

ith a moderately wide 
viewing angle, natural 
perspective, fairly 

fast maximum aperture and 
reasonably compact build, 
35mm prime lenses have long 
been the darlings of reportage 
photography. Compared with 
conventional reportage or 
photojournalism, street 
photography can demand even 
faster reactions. It’s often about 

anticipating what’s going to 
happen next, and seeing the 
shot before it’s even there. 

Fast autofocus can be a 
boost. Wider apertures can help 
when you need to take a shot in 
the dark. Image stabilisation can 
beat the shakes when you’re 
pounding the streets on a cold 
winter’s day. The lenses in this 
group test have all, some or 
even none of these attractions. 

Matthew Richards picks out the best 
lenses for street-smart photographers

W
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Canon EFFull-frame Full-frameAPS-C APS-C Nikon FX
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35mm STREET PRIMESK I t  Z o n e

It can be your stable mate Quite quick, narrow and lightweight

canon eF 35mm  
f/2 Is Usm
£400/$600 

nikon aF-s 35mm  
f/1.8g ed
£430/$530 

ot quite as ‘fast’ as 
the f/1.4 and f/1.8 
lenses on test, this 

Canon is nevertheless one of 
only two in the group to 
feature optical stabilisation, 
along with the Tamron. It’s not 
a pro-grade L-series lens, so there 
are no weather seals and you have 
to buy the hood separately. Even so, 
it feels fairly robust and well-made, 
with a smooth-acting focus ring 
and good handling overall.

The ring-type ultrasonic 
autofocus is typically quick and 
quiet. Unlike Canon’s recent 
stepping motor lenses, including 
the 40mm f/2.8 STM and the 
50mm f/1.8 STM, this more 
conventional USM lens features 
a focus distance scale.

Performance
Centre-sharpness is excellent even 
at the widest aperture, and the 
extreme corners are also pin-sharp 
by the time you hit f/4. Despite the 
lack of a really wide aperture, 
bokeh is pretty good, and the 
eight-blade diaphragm gives a 
fairly well-rounded aperture. 

The image stabiliser is definitely 
worth having, with a decent  
boost that’s equivalent to nearly 
four f-stops.

ne third of an f-stop 
faster than the Canon 
lens, this Nikon is also 

less chunky. It has a 58mm filter 
thread compared with the Canon’s 
67mm, and is 30g lighter. Unlike 
the Canon lens, it also has a 
weather-sealed mounting plate 
and comes complete with a hood 
and carrying pouch. 

It has similarly fast and quiet 
ring-type ultrasonic autofocus, but 
with less travel in the manual focus 
ring. This makes precise focus 
adjustments just a little trickier, 
despite the Nikon’s focus ring  
being much wider and considerably 
more finger-friendly.

One thing that’s notably absent 
in the Nikon lens is VR, or optical 
vibration reduction. That’s more 
the norm than the exception in this 
test group, but it can impact on 
hand-held street photography.

Performance
Sharpness isn’t stellar at f/1.8, but 
really picks up across most of the 
frame between f/2.8 and f/16. 
Edge-sharpness takes rather 
longer to kick in as you narrow the 
aperture, and unfortunately is 
generally disappointing. In other 
respects, though, image quality 
is good on the whole.

N O

 VerdIct  

 oVerall  

 BUIld & handlIng  

 PerFormance  

 ValUe  

 FeatUres  

sharPness higher is better

f/2.8 0.75 f/8 0.79 f/16 0.75

Sharpness is both very good and consistent 
through most of the aperture range.

sharPness higher is better

Colour fringing scores are among the best 
here, with minimal levels even in corners.

There’s a touch of barrel distortion, but  
it’s of a low order and no real problem.

FrIngIng at edge; Lower is better

dIstortIon Nearer 0 is better
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sharPness

f/2.8 0.99 f/8 0.98 f/16 0.99

Edge-sharpness is poor at apertures wider 
than f/5.6, but centre-sharpness is excellent.

There’s very little colour fringing; the Nikon 
almost matches the Canon lens for this.

Barrel distortion is a little higher here than 
average, but it’s reasonably well restrained.
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It’s more close than wide It’s a hands-on affair

hd Pentax da  
f/2.8 35mm macro

£470/$500 

samyang 35mm  
f/1.4 as Umc ae

£360/$450 

entax was keen for us 
to review this lens 
instead of its 35mm 

f/2, even though it’s not 
compatible with full-frame 
cameras. That’s a moot point 
anyway, as Pentax hasn’t yet 
brought a full-frame digital SLR to 
market. Instead, this 35mm lens, 
available in black or silver, acts 
more like a standard 50mm lens on 
current APS-C format bodies, but 
adds the attraction of full 1.0x 
macro magnification at its closest 
focus setting.

Nicely engineered with an 
aluminium body, the lens features 
a built-in retracting hood and HD 
(High-Definition) coatings to 
reduce ghosting and flare while 
maximising light transmittance. 
There’s no built-in autofocus 
motor, so AF needs to be driven 
by a motor in the host camera.

Performance
Autofocus is fairly fast, but quite 
noisy. Levels of sharpness are good 
throughout most of the aperture 
range, and the lens hits its sweet 
spot at f/4. As you’d hope for in a 
macro lens, distortion is quite 
minimal, but the narrowest 
aperture is only f/22, where 
sharpness drops off noticeably.

he Nikon edition 
of this lens looks 
particularly old-

school, with its aperture ring 
and densely packed depth of 
field scale. The Canon edition 
ditches the aperture ring but looks 
identical in other respects. Both 
are strictly manual-focus affairs, 
with no autofocus facility.

Optically identical Samyang 
35mm lenses are available in other 
fit options as well, but the Nikon 
and recently updated Canon 
versions add electronics. This 
makes it possible to adjust the 
aperture from the host camera, 
while enjoying a bright viewfinder 
image without having to manually 
stop down to the aperture at 
which you want to shoot. Focus 
confirmation indicators are 
enabled in the camera’s viewfinder 
display, making manual focusing 
less of a hit-and-miss business.

Performance
Despite being the largest lens in the 
group, vignetting is still noticeable 
at f/1.4, where sharpness and 
contrast drop off very noticeably. 
At f/2.8 and narrower apertures, 
overall image quality is very good, 
and the smooth long-travel focus 
ring makes manual focusing easier.

P T
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 FeatUres  

sharPness

f/2.8 0.85 f/8 0.96 f/16 1.08

It’s good at wide-to-medium apertures but 
poor at f/22, an issue for macro photography.

Chromatic aberration is low, especially at 
the wider end of the aperture range.

Barrel distortion is barely perceptible, 
which is fitting for a macro lens.

FrIngIng
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sharPness

f/2.8 1.03 f/8 0.8 f/16 0.81

It’s poor at f/1.8 but impressive at apertures 
between f/2 and f/11, right across the frame.

Colour fringing can be a little noticeable  
at f/1.4, but things improve at f/2.8.

Barrel distortion is more pronounced than 
with any other lens in this test group.
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Ready for your art class? It’s the baby of the group

sigma 35mm  
f/1.4 dg hsm | a  

£640/$900

sony Fe 35mm f/2.8 Za 
carl Zeiss sonnar t*

£530/$800

e’ve recently given 
rave reviews to 
Sigma’s 50mm and 

24mm f/1.4 Art lenses, which 
won our group tests in issues 
169 and 170 respectively. This 
35mm edition fills the gap in terms 
of focal length, while retaining 
the same wide f/1.4 aperture and 
overall design philosophy. As such, 
it’s immaculately built and features 
top-quality glass, a well-rounded 
nine-blade diaphragm and fast 
ring-type ultrasonic autofocus.

The Sigma is smaller and 
a little lighter than the competing 
Samyang f/1.4 lens, but still 
noticeably larger and heavier than 
the Canon and Nikon f/2 and f/1.8 
lenses. It has a relatively complex 
arrangement of 13 elements in 11 
groups, and comes complete with 
a hood and a soft case.

Performance
One thing we’ve noticed with 
Sigma A-series prime lenses is 
that they tend to give excellent 
sharpness across the whole frame, 
with great contrast, even when 
used at their widest aperture. 
The 35mm is no exception, and 
backs this up with spectacular 
performance in all areas of image 
quality and handling.

ext to the relatively 
hulking Samyang, 
Sigma and Tamron 

lenses on test, this Sony 
offering is positively tiny. It’s 
more of a pancake lens, with an 
unfeasibly small front element. So 
while the Samyang tips the scales 
at 700g, the Sony tiptoes on at just 
120g. It certainly looks very much 
in keeping with the slimline design 
ethic of Sony’s Alpha 7 series of 
full-frame CSCs.

One factor that helps the lens’ 
shrinking process is that the widest 
available aperture is just f/2.8, 
rather than f/1.4 or f/1.8. This 
makes the Sony two whole f-stops 
slower than the Samyang and 
Sigma lenses on test. Autofocus 
comes courtesy of a stepping 
motor, with the availability of 
full-time manual override via 
in-camera menus.

Performance
We have no complaints about 
centre-sharpness, which is 
impressive even at the widest 
aperture. However, middle-to-
edge sharpness can be lacklustre, 
especially towards either end of the 
aperture range. Overall, though, 
performance is good and image 
quality is pleasing.
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sharPness higher is better

f/2.8 1.33 f/8 0.73 f/16 0.64

Sharpness is superb across the whole frame 
and throughout the entire aperture range.

sharPness higher is better

There’s remarkably little fringing, especially 
at medium-to-narrow aperture settings.

Barrel distortion is of a very low order  
and will generally go unnoticed in images.

FrIngIng at edge; Lower is better

dIstortIon Nearer 0 is better
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Relatively poor sharpness away from the 
centre of the image frame is a let-down.

There’s hardly any colour fringing, even 
towards the extreme corners of the frame.

Unusually, the Sony shows marginal 
pincushion instead of barrel distortion.
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Full-frame Canon EF Nikon FXAPS-C Full-frame Canon EF Nikon FXAPS-C
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The start of something new It’s a manual maestro

tamron sP 35mm  
f/1.8 di Vc Usd

£550/$600 

Zeiss milvus  
35mm f/2  
£830/$1,120

acro lenses aside, 
Tamron hasn’t made 
any prime lenses for 

the digital era – at least, not 
until now. The new SP (Super 
Performance) 35mm and 45mm 
lenses bring together all of 
Tamron’s recent innovations, 
including VC (Vibration 
Correction), USD (Ultrasonic 
Silent Drive) autofocus and eBand 
nano-structured coatings to 
reduce ghosting and flare.

Build quality is a close match 
to that of the Sigma 35mm on test, 
with a metal outer barrel and 
a really high-precision feel 
throughout. However, the Tamron 
adds weather seals and optical 
stabilisation – both lacking in the 
Sigma. On the other hand, the 
Tamron’s narrower f/1.8 aperture 
makes it harder to get a tight 
depth of field, unless you can take 
advantage of the unusually close 
0.2m minimum focus distance.

Performance
Lab scores for sharpness aren’t 
great but, even wide-open at f/1.8, 
the Tamron delivers plenty of bite 
and contrast. Overall image quality 
is pleasing and, while autofocus 
isn’t massively fast, it’s almost 
completely silent.

he new line of Zeiss 
Milvus prime lenses 
for Canon and Nikon 

SLRs continues in the same 
vein as the Otus range. It aims 
for ultimate image quality and 
handling, but at a much more 
reasonable selling price.

This lens is strictly a manual-
focus affair, just like the Samyang 
35mm on test. Further similarities 
include a fast f/1.4 aperture, 
built-in electronics to enable the 
aperture to be set from the host 
camera, and activation of the focus 
confirmation lamp in the camera’s 
viewfinder. Again, the Nikon-fit 
version has an aperture ring but 
this time it has a click-free option, 
suitable for shooting video. 

The Milvus lens is completely 
weather-sealed and superbly 
well-engineered, with an 
impeccably turned-out metal body 
and a matching metal lens cap.

Performance
Despite a no-compromise design 
that places optical excellence above 
the inclusion of autofocus, the 
Milvus lost out (albeit marginally) 
to the Sigma 35mm lens in all 
of our lab tests. Even so, it’s a 
beautifully crafted lens that can 
deliver spectacular results.

M T

 VerdIct  

 oVerall  

 BUIld & handlIng  
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sharPness

f/2.8 1.18 f/8 1.27 f/16 1.24

Less than inspiring in the lab, sharpness 
proved very acceptable in the field.

Colour fringing is pretty minimal, even 
towards the extreme corners of the frame.

There’s marginally more barrel distortion 
than from the Sigma, but it’s still very low.
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sharPness

f/2.8 2.34 f/8 1.52 f/16 1.3

Sharpness is almost as impressive as from 
the Sigma, throughout the aperture range.

Colour fringing is fairly minimal, but the 
Zeiss has the worst lab scores for this.

There’s a little barrel distortion, which is 
worse than from the Sigma and others.
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the VerdIct

sigma is king of the road
The Sigma 35mm f/1.4 DG HSM | A rules the street

ontinuing the excellence of 
Sigma Art-series lenses, the 
35mm f/1.4 is robust, well-

engineered and delivers sublime image 
quality. Corner-to-corner sharpness is 
particularly impressive, even when shooting 
wide-open. We’re also fans of the new Tamron 
35mm which, while being two-thirds of a stop 
slower, has excellent build quality and handling. 
The Tamron adds weather seals and optical 
stabilisation that are lacking in the Sigma. It’s 
not as sharp as the Sigma, but still delivers 
plenty of contrast even at its widest aperture.

The Zeiss Milvus is fabulously well-
engineered but, as with the Samyang that’s 
also on test, the lack of autofocus slows you 

down for street photography. The Pentax and 
Sony lenses both deliver good image quality 
and are small and lightweight, although off- 
centre sharpness from the Sony is questionable.

It comes to something when Sigma and 
Tamron, arguably renowned for budget 
lenses, are coming up trumps for build quality 
and performance. Canon, Nikon and Sony 
make top-notch, pro-grade 35mm f/1.4 lenses 
but, with price tags of between £1,300/$1,600 
and £1,800/$1,800, they hardly qualify as 
‘street lenses’. The Nikon is good overall but 
has relatively poor corner-sharpness. 

The Canon is good value and adds an 
effective optical stabiliser, even if its build 
quality isn’t as good as the equivalent Tamron.

C

how the 
LeNses 
compare

Canon EF 35mm 
f/2 IS USM

Nikon AF-S 
35mm f/1.8G ED

HD Pentax DA 
f/2.8 35mm 

Macro

Samyang 35mm 
f/1.4 AS UMC AE

Sigma 35mm 
f/1.4 DG HSM | A

Sony FE 35mm 
f/2.8 ZA Carl 

Zeiss Sonnar T*

Tamron SP 
35mm f/1.8 Di 

VC USD

Zeiss Milvus 
35mm f/2

Contact www.canon.co.uk www.nikon.co.uk www.pentax.co.uk www.syopt.com www.sigma-
imaging-uk.com

www.sony.co.uk www.tamron.
co.uk

www.zeiss.co.uk

Street price £400/$600 £430/$530 £470/$500 £360/$450 £640/$900 £530/$800 £550/$600 £830/$1,120

Mount options

Full-frame 
compatible Yes Yes No Yes Yes Yes Yes Yes

Elements/Groups 10/8 11/8 9/8 12/10 13/11 7/5 10/9 9/7

Diaphragm blades 8 blades 7 blades 9 blades 8 blades 9 blades 7 blades 9 blades 9 blades

Autofocus type Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

From camera 
motor

Manual focus only Ultrasonic 
(ring-type)

Stepping motor Ultrasonic 
(ring-type)

Manual focus only

Manual AF override Full-time Full-time Quick-shift N/A Full-time Full-time Full-time N/A

Min focus 
distance 0.24m 0.25m 0.14m 0.3m 0.3m 0.35m 0.2m 0.3m

Max magnification 
factor 0.24x 0.24x 1.0x 0.19x 0.19x 0.12x 0.4x 0.19x

Minimum aperture f/22 f/16 f/22 f/22 f/16 f/22 f/16 f/22

Optical stabilizer Yes No No No No No Yes No

Filter size 67mm 58mm 49mm 77mm 67mm 49mm 67mm 58mm

Included 
accessories None Hood, pouch

Hood (built-in), 
soft case

Hood, pouch Hood, soft case Hood Hood Hood

Dimensions  
(D x L) 78 x 63mm 72 x 72mm 63 x 47mm 83 x 110mm 77 x 94mm 62 x 37mm 80 x 81mm 75 x 78mm

Weight 335g 305g 214g 700g 665g 120g 480g 702/649g (C/N)

 BUIld & handlIng 
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Multi-rotor drones are the latest imaging buzz, enabling the capture of aerial scenes

imagiNg DrONes

 OVerall  

3D Robotics has taken multi- 
rotor design to another level 
with the Solo drone. The very 
sleek, no-fuss design has been 
refined for image capture 
rather than simply catering 
to the needs of the radio-
controlled device enthusiast. 

Auto-flight features include 
Cable Cam, Orbit and Follow 
Me, which are straightforward 
to set up through the free 3DR 
Solo app. All of these features 
enable you to capture the 
action without needing to 
control the craft manually.

The Solo is the only multi-
rotor in this test group not to 
include a gimbal or camera in 
the box. Instead these need to 
be purchased in addition to the 
basic kit. The gimbal is also 
manufactured by 3D Robotics, 
and is designed to hold a GoPro 
Hero4 camera. The price we 
quote above includes the 
gimbal, but not the camera.

The Solo offers complete 
GoPro integration. Once the 

camera is mounted into the 
gimbal and the app, for iOS 
or Android, is loaded to your 
mobile device, you have fast 
access to flight features and 
camera and gimbal operation, 
as well as a Live View stream.

Video choices
As the Solo uses a Hero4, 
you have a huge array of video 
options, from 4K at 30fps to 
1080p at 120fps. The Hero4’s 
image quality is excellent, 
but the camera suffers from 
pronounced fish-eye distortion.

The Solo costs more than 
the competition, especially 
once the essential extras are 
taken into account, but there is 
no arguing about the overall 
quality of this product, or with 
the ease of set-up and use. 
There’s also the significant 
advantage that its auto-flight 
features offer for capturing 
aerial imagery.

DJI has a proven track record 
with multi-rotors and is the 
company that popularised 
the technology. The third 
generation of Phantom has 
refined the design, with the 
Professional model catering to 
those wanting to capture aerial 
footage and stills. It features 
a 4K camera capable of 24fps 
PAL video capture, as well as 
plenty of other resolutions, 
including full 1080p at 60fps.

DJI has really worked on the 
ease of flight and usability of 
the camera. The DJI Go app, 
for both iOS and Android, has a 
clean design and enables quick 
control over the camera and 
gimbal, ensuring that you 
capture the shots you need.

The camera features a 
Sony Exmor 1/2.3-inch sensor. 
which captures scenes through 
the 94 degree or 20mm 
(35mm equivalent) lens; this 
offers less distortion than the 
lens in the Hero4. Image quality 
is excellent, and video is bright 

and crisp, with little sign of 
significant flare. Noise is 
handled well, but becomes 
apparent when the light drops.

Easy to use
Control of the camera and 
gimbal is through either the 
mobile app or directly through 
the handset, which makes it 
exceptionally easy to use. 
Auto-flight features include 
Follow Me, Point of Interest and 
GPS Waypoint, which are all 
easy enough to programme 
and use through the app.

The Phantom is the most 
responsive multi-rotor of this 
group. It’s incredibly quick to 
manoeuvre, although this can 
be a good and a bad trait. For 
high-level imaging work, its 
speed enables the Professional 
to cover a great distance 
quickly. For low-level work, 
however, a little more flying 
skill is required.

w w w. 3 d ro b o t i c s . c o m

3Dr solo
£1,358/$1,399 inc gimbal

w w w. d j i . c o m

DJi Phantom 3 Professional
£1,048/$1,163

 OVerall  
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What to look for in a multi-rotor drone
Without a licence from the Civil 
Aviation Authority, any drone you 
fly must be under 20kg, fully 
equipped. This limits you to a 
drone with a built-in camera or 
one that can hold a GoPro Hero 

camera. A video resolution of 
1080p and stills capture of 12MP 
should be the minimum spec you 
look for. Essentials also include 
a motorised gimbal, a Live View 
feed and smart flight controls.

It would be easy to dismiss 
the Bebop 2 as just a toy, 
especially as it weighs 
so little at just 500g – 
comfortably the lightest in 
this test group. However, the 
Skycontroller more than makes 
up for the Bebop 2’s small size: 
it’s almost twice the size of the 
controllers supplied with the 
other multi-rotors. 

The Skycontroller is able 
to operate the Bebop 2 with 
or without a tablet, and 
extends the Wi-Fi range up 
to 2 kilometres (1.2 miles), 
subject to local regulations.

The Bebop 2 really shouldn’t 
be underestimated when it 
comes to speed and durability, 
though. Even when used in 
windy conditions, it is able to 
utilise its GPS features to hold 
its position well.

The Bebop 2 is the only 
multi-rotor design here not to 
rely on an external camera or 
gimbal: instead it incorporates 
the camera into the nose cone 

of the body. The camera is 
limited to Full HD 1080p at 
30fps and has a 180° field of 
view from its f/2.3 lens.

Video and still quality don’t 
quite match that of the other 
three drone cameras on 
test here, but they have the 
convenience of three-axis 
image stabilisation and the 
ability to tilt the camera from 
the mobile app or controller.

Good for beginners
The auto-flight features in the 
Bebop 2 are incredibly well 
thought out, although you have 
to make an in-app purchase 
within the otherwise free-of-
charge FreeFlight 3 app in 
order to plot auto-flight routes 
through GPS waypoints.

The Bebop 2 is a strong 
choice if you’re just starting out 
and need a durable, easy-to-fly 
drone. It supplies more than 
you’d expect for its small size. 

w w w. p a r ro t . c o m

Parrot Bebop 2 with skycontroller
£749/$799

w w w. y u n e e c . c o m

Yuneec typhoon Q500 4K
£1,237/$1,299

Yuneec has a good standing 
in the enthusiast multi-rotor 
world. The quality of the 
company’s multi-rotors has 
recently been realised with its 
partnership with Manfrotto.

The Typhoon’s design 
reflects the hobbyist market 
in which this drone originated, 
with a sleek style resembling 
some type of spacecraft. The 
Typhoon also comes with more 
kit than any of the other drones  
on test here. 

It arrives in a decent-quality 
metal flight case, along with 
two batteries, a handset 
with Live View display, a 
gimbal, a camera and, to top 
it off, a separate handheld 
gimbal for ground work.

The contents of the kit 
are very impressive, and the 
auto-flight features such as 
Auto Takeoff and Landing, 
Watch Me and Follow Me are all 
well-conceived. The real winner 
for videographers, though, is 
the slow mode, which can be 

quickly selected directly on the 
handset. This mode slows the 
speed of the Typhoon down, 
enabling easy capture of 
panning and other usually 
tricky shots.

All-in-one solution
The image quality from the 
gimbal-mounted camera is 
excellent at 4K at 30fps in 
bright conditions, but 
unfortunately noise becomes 
increasingly apparent as the 
light dips. There are also some 
issues with image flare. 

The CG03 camera features 
a 1/ 2.3-inch sensor and a lens 
with a 115° field of view at 
14mm (35mm equivalent).

The Yuneec Typhoon Q500 
4K makes for a good all-in-one 
solution at an amazing price, 
considering everything you get; 
but compared with the others 
on test, it just isn’t quite as 
durable or refined. 

3 4

 OVerall   OVerall  
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Fire your camera when movement or other effects are detected with this sextet

2

5

3

6

Camera trigger systems

w w w. m i o p s . c o m

miops 
smart

£180/$239

The size of a card pack and with a 
colour screen, the Miops trigger is 
simple to navigate and quick to set up. 
The unit can be controlled wirelessly 
from a smartphone, although cables 
(included) are needed to trigger a flash 
or camera when the unit senses a light or 
sound change. The Smart has 11 modes, 
including time-lapse, HDR, and Scenario, 
for choosing how the unit reacts when 
triggered. There’s an expansion port for 
an external sensor, but you’ll need a laser 
source to use the laser-tripping function. 
The build is also lightweight, and while 
the Smart can be fitted to a hotshoe, 
it can’t be locked in place.

w w w. s a b re sw i t c h . c o . u k

sabre switch 
triggersmart

£238/$350

This is the most substantial device 
on test. With three dials and six touch 
switches, the MCT-1 control unit is 
defiantly retro. The kit includes one IR 
transmitter/sound sensor and one IR 
receiver/light sensor, each of which can 
be attached separately to the MCT-1 via a 
3m cable or daisy-chained together, plus 
two mini-tripods that are easily pulled 
over, a camera trigger lead (with a 2.5mm 
jack, so you may need a new connection 
cable) and two baffles to narrow the IR 
beam. It offers a high degree of control 
and its tight beam is good for high-speed 
indoor close-ups, but it lacks the 
Triggertrap’s take-anywhere appeal.

w w w. t r i g g e r t r a p . c o m

triggertrap mobile 
remote Dongle Kit

£30/$37

This is the most entertaining remote 
trigger of the group. There’s not much 
to it: a dongle to attach to the headphone 
port of your iOS or Android device, and 
a cable to connect the dongle to your 
camera. Download the free Triggertrap 
app to your device and crank up the 
headphone volume, and you’re ready. 
Sound, vibration, motion and facial 
recognition can all be employed, where 
supported by your device. There are 
numerous modes; TimeWarp, which lets 
you adjust the time-lapse effect, is fun. 
The limitation is the phone’s battery life, 
making it less useful for remote wildlife 
work than some other triggers.

 OVerall   OVerall   OVerall  

c a c t u s - i m a g e . c o m

Cactus laser 
 trigger lV5

£90/$110

This laser-based system boasts a 
150-metre transmission distance in 
the dark and up to 20m in sunlight, 
making it a good choice for wildlife 
photography. The emitter’s battery life 
is specified as 80 hours with four AAAs. 
Although the two LV5 units are quite easy 
to align, if you’re not careful positioning 
the emitter you may end up with a red 
laser dot on the subject in the photo. 
Using the channel dial to set the freeze 
and interval settings isn’t ideal: it’s too 
easy to press the power button by 
accident. You’ll need an extra shutter 
release cable and V5 Wireless Shutter 
Release to make the most of the system.

u k . h a m a . c o m

Hama ir light sensor 
remote Control

£80/$93

hama’s option is a no-frills two-part 
system that can also work as an 
infrared motion trap. The transmitter 
and receiver each require two AAA 
batteries to operate and feature metal 
tripod mounts; the receiver can also be 
attached to a hotshoe using a locking 
knob. (You’ll need an adaptor cable as 
well to trigger the camera.) The 5m 
working distance between receiver 
and transmitter is less than the Captur 
Module Pro’s 12m, and it was tricky to 
find the sweet spot of alignment between 
the two; we found it decent at detecting 
larger objects, but less responsive with 
smaller, fast-moving ones.  

w w w. h a h n e l . i e

Hähnel Captur  
module Pro

£100/$120

hähnel’s modular approach with its 
Captur system lets you mix and match 
items. The Module Pro comprises a TV 
remote-like control module and a smaller 
IR module for setting up a beam trap. The 
main module can be used as a wired or 
wireless remote, although you’ll need the 
Captur Remote Control and Flash Trigger 
pack (around £60/$90) for the latter. 
As well as light, sound, infrared and 
laser sensors, the Module Pro has an 
expansion port for optional sensors. The 
mono LCD screen and four-way control 
pad make adjusting settings easy, 
although fine-tuning was required to 
detect water drops in our tests.

 OVerall   OVerall   OVerall  
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Tool School
Match up objects shot at different 
angles for a montage, with the help 
of Photoshop’s Perspective Warp

136

Creative Spotlight
Transform a single object in a shot 
by changing its colour at will: discover 
four effective Photoshop techniques

132

Artist Insight
It’s the fine details that make a portrait, 
says Glyn Dewis, as he reveals a simple 
workflow for smoothing skin

ligHtrOOm 
SKillS
128   Find out how 

Lightroom can 
help make shots sharper

wATCh  
vIdeoS!  

www.bit.ly/ 
dc174video



Local sharpening
Take control of precisely where you apply these effects

To apply sharpening only to areas 
of the image you select, you need 
to use one of the local tools: the 
Adjustment Brush, the Grad Filter 
or the Radial Filter. For accuracy, 
I recommend the Adjustment Brush.

Choose from the A or B brush 
and set Size and Feather to suit your 
task; Feather controls the softness 
of the edge of the brush. Reset the 
brush by double-clicking the Effect 
label, then use the Sharpness slider 
to set the level of Sharpening.

You’ll notice that you can have 
negative Sharpness as well as 
positive. Between 0 and -50, this 
removes sharpening from the areas 
you brush. Below -50, it acts as a 
lens blur, so you can create tilt-shift 
or other lens blur effects.

Use Lightroom to discover three 
straightforward ways to make  
your favourite photos look sharper 
and much more detailed...

Sean 
MccorMack 

Photographer 
and writer

Sean McCormack  
is an experienced 
photographer and 
writer based in 
Galway. He is the 
author of The 
Indispensable Guide 
to Lightroom CC.  
seanmcfoto.com

SoFTWare Lightroom 6 GeT IT FroM www.adobe.com/creativecloud

GeT STarT FIleS FroM www.bit.ly/dc174files

nsel adams may 
have said “There’s 
nothing worse than 

a sharp image of a fuzzy 
concept”, but sharpening 
can make or break a photo. 
Lightroom has three forms of 
sharpening: global sharpening, 
via the Detail panel; local 

sharpening, via the Brush/
Grad Filter or the Radial Filter; 
and output sharpening in 
Export, Print and Web.

Many modern cameras 
have an anti-aliasing filter that 
works to remove the stair-
stepping effect. This actually 
blurs the photo, so some 

sharpening is needed to 
restore sharpness.

Lightroom automatically 
applies a Sharpening amount 
of 25 to every raw file for this 
reason. Processed file formats 
like JPEG and TIFF are assumed 
to be sharpened already, and 
have no sharpening applied.

A

lightroom

EXPERT
TIP

Make shots 
look sharper 
with lightrooM

Radius
Sharpening 
works by 
creating 
contrast around 
edges. Radius 
controls how far 
from the edge 
the sharpening 
is effective.

amount
This sets the 
strength of the 
sharpening. 
Originally this 
went from 
0-100, but at 
the request  
of users it was 
changed to 
150. Anything 
above 100, 
safeguards are 
off, so the image can become 
really crunchy.

watch  
video  
www.bit.ly/ 
dc174video
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alt key magic
The Alt key trick for Masking 
actually works on all four 
Sharpening sliders. On Amount 
you see a luminosity version of 
the image. Used with Radius, 
Alt shows the pixels being 
affected; 
and on 
Detail you 
see the 
haloes and 
detail 
sharpening.

100% shaRpening
Any preview of 
sharpening you see in 
Lightroom is only an 
approximation unless 
you’ve zoomed into 1:1. 
The window in the Detail 
panel offers a correct 
view if you’re at another 
zoom level. This is 
because of the processing 
required for an accurate 
preview, so Lightroom 
errs on the side of speed.

LiGhtRooM aNatoMY

aFt
er

masking
You don’t need to sharpen 
everything in a photo, for example 
skin or sky in a shot. Masking 
detects edges, and uses these 
to reduce the areas being 
sharpened. Hold down the Alt key 
to see the affected areas change 
as you slide.

detail
This slider has two opposing effects. Increasing 
it accentuates high-frequency detail like textures 
or leaves in shots of woods, but also increases 
haloes. Decreasing Detail will remove haloes on 
edges, but reduce the level of detail.

Be
FO

re

D i g i ta l  Da r k ro o m
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Learn how to use one of Photoshop’s newest 
and most powerful warp tools, and change 
the perspective of objects and scenes 
so they match up with each other

align objects in 
a composite with 
perspective warp JAMES 

PATERSON 

Editor, Practical 
Photoshop

With a decade as a 
working writer and 
photographer behind 
him, James knows 
exactly which 
Photoshop and 
Lightroom tools and 
techniques matter 
the most to you.

SOfTwARE Photoshop CC   GET iT fROM www.adobe.com/creativecloud

GET START filES fROM www.bit.ly/dc174files

Photoshop

Warp the bus
Click outside the first grid to add a 

second. Drag a corner pin to the edge of 
the first grid to snap the two together, then 
adjust the second grid to match the front 
of the bus. Next, click Warp in the options. 
Drag the corner points to change the 
perspective to match the background.

step by step
Add wArp grids

plot perspective points
Open the start files cut_out_bus 

and bus_background. Copy over the bus 
and roughly position it. Select Edit > 
Perspective Warp. Click the bus to make 
a grid box, then drag the sides and corners 
until the box matches the bus side.

1

2

BE
FO

RE

wAtch  
videos  
www.bit.ly/ 
dc174video
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Make believable montages
Finishing touches to make a convincing composite

Matching the perspective of the bus 
to the wide-angle scene gets us 
halfway to a believable montage, 
but there’s still work to be done. 
First we need a shadow to ground 
the bus. If we look at the existing 
shadows [1], we can see the shadow 
cast by the bus should fall down to 
the left. To paint shadows, click the 
New Layer icon [2] and drag this 
layer below the bus layer [3]. Grab 

the Brush Tool; press D to set the 
colour to black [4] and 5 for 50% 
opacity [5], then paint under the 
bus to darken the area [6].

Next, get everything to gel. 
We’ve used Adjustment Layers to 
add a warm tone [7] then merged 
a layer with Ctrl/Cmd+Shift+Alt+E 
[8] before taking it into the Camera 
Raw filter (Filter > Camera Raw 
Filter) for final toning.

EXPERT
TIP

Make a SMart 
Object
If you 
make a 
layer into 
a Smart 
Object 
(right-
click it and choose Convert 
to Smart Object) before 
applying the warp, you can 
double-click the Smart 
Filter on the layer later to 
access the warp controls.

Warp cOntrOlS
Once you’re happy that 
the grids match the 
perspective of the object, 
switch to Warp mode using 
the button in the options. 
Now you can drag the 
corner points to change 
the perspective of the 
object. If you need to go 
back and adjust the grid 
position, you can switch 
back to Layout mode at 
any time.

autO buttOnS
There are three buttons 
in the options that 
automatically apply either 
vertical, horizontal or 
vertical-plus-horizontal 
straightening to the grid 
lines. Auto-vertical is the 
most useful: it straightens 
all upright lines, so it’s 
good for fixing keystoning.

Straighten 
verticalS
Shift-click an upright line 
and it will snap to a perfect 
vertical and turn yellow. 
The line will stay straight 
during any 
further 
edits if you 
move it 
around; 

photoshop ANAtoMY

1
2

5

6

3

4

7
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Snap grid bOxeS
Once your first grid box is 
matched to a plane in your scene, 
the next step is to add another and 
adjust it to fit a second plane. You 
can add as many grids as you like. 
Extra grids should be locked to the 
first one; to do this, drag a point 
near the side of the first grid until 
the sides of each turn blue.

grid pOintS
Perspective Warp works in two 
stages. First we add a grid and 
adjust it to match the planes of 
our object; then we switch to Warp 
mode to change the perspective. 
It works best with blocky objects 
like vehicles or buildings. When 
plotting a grid, try to match the 
grid lines to the natural lines in the 
scene, like those on the bus here.

Warping tipS
Try a few keyboard 
shortcuts when warping. 
Press H to toggle the grid 
view on or off. Pressing L 
takes you to Layout mode, 
and W to Warp mode. 
While in Layout mode, you 
can press Return to go to 
Warp mode, then Return 
again to apply the edit.
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Discover a quick, easy and convenient 
way to make your portraits look more 
polished and professional. If you’re 
after smooth skin, give this a try...

Realistic skin 
smoothing in 
PhotoshoPGLYN DEWIs 

Photographer  
and author

Glyn is a commercial 
photographer, 
retoucher and 
also an Adobe 
Community 
Professional trainer. 
He is the author of The 
Photoshop Workbook. 
www.glyndewis.com

sOFTWARE Photoshop CC GET IT FROM www.adobe.com/creativecloud  

GET sTART FILEs FROM www.bit.ly/dc174files

Photoshop

hen it comes to 
retouching techniques, 
the number of ways to 

smooth skin seems endless. From 
blurring through to third-party 
plug-ins, all will produce different 
results. But when it comes to 
portraits, the goal should be 
smooth skin that retains a level 
of texture and looks realistic. I want 
to show you a technique I turn to 
again and again because it does 

exactly that: it maintains texture 
and looks realistic, but also gives 
you total control over how much of 
the effect you wish to apply.

I’m a big believer in building up a 
virtual Photoshop toolbox where 
you have a number of techniques 
that give similar results, and this is 
no different. Give it a go a few times 
so you become familiar with the 
steps – and maybe record them as 
an Action you can apply quickly.

W
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watch  
video  
www.bit.ly/ 
dc174video



Create a smooth skin layer
With your image open in Photoshop, let’s start off by 
creating a duplicate layer by selecting Layer > New > Layer 
Via Copy or by pressing Ctrl/Cmd+J, then rename it 
‘Smooth Skin’. We do this so that our original is safe but, 
as you’ll see later, we can also use it to control exactly how 
smooth we want the skin to be.

add a high Pass filter
Next, select Filter > Other > High Pass. For a high-resolution 
picture, a Radius of around 20 pixels should be perfect.  
(For lower-resolution images, you’ll need to add in a lower 
amount.) We now need to add a small amount of blur, so go 
to Filter > Blur > Gaussian Blur. For high-resolution images,  
a Radius of around 3 is all we need.

add a ViVid light effeCt
Now that we have a duplicate of our original image in the 
Layers panel, we can start by changing its Blend Mode to 
Vivid Light. This will create what looks like a very high-
contrast version of our picture. Next, go to Image > 
Adjustments > Invert, or simply use the keyboard shortcut 
of Ctrl/Cmd+I.

Blending oPtions
The actual smoothing has been applied – however at this 
stage, you’ll see that our picture doesn’t look quite right: 
we’ve lost the highlights and blacks in the all-important 
areas. So the next step is to click the Add Layer Style icon 
(the fx symbol) at the bottom of the Layers panel and 
choose Blending Options from the pop-up menu.

Whiter  
teeth
A simple way to lighten 
your model’s teeth in  
just a few seconds

When it comes to whitening 
teeth, rather than taking 
considerable amounts of 
time to make an accurate 
selection, try this quick and 
easy trick. Simply use the 
Lasso Tool and make a rough 
outline around the teeth. 
Then add a Hue/Saturation 

Adjustment Layer and 
instead of Master, choose 
Yellows from the 
drop-down menu. 
Drag the Lightness 
slider to the right 
until you get the 
desired amount  
of whitening.

1

EXPERT
TIP

2

3 4
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restore highlights
Within the Blending Options are the Blend If sliders. These 
can bring the image back to looking normal but retain the 
smoothness we’ve applied. We’ll be using the upper-most 
slider, This Layer. With the Alt key held down, click the black 
marker on the far left. This splits the marker in half. Drag the 
one half to the right until you get a reading of about 0/200.

target the effeCt
Our entire picture has the smoothing applied to it, so we 
now need to restrict where the effect is applied and reduce 
it. To hide the smoothing, Alt-click the Add Layer Mask icon 
at the bottom of the Layers panel. With a soft white brush 
at 100% opacity, paint the effect back in over the skin then 
lower the opacity of the layer to around 40%.

add some Contrast
We’ve given our subject smooth skin and kept a realistic 
amount of detail. Adding a bit more contrast finishes the 
smoothing effect. Create a merged/stamp layer at the top of 
the layer stack by choosing Select > All, Edit > Copy Merged, 
Edit > Paste, then Filter > Sharpen > Unsharp Mask. An 
Amount of 10%, Radius of 10 and Threshold of 0 work fine.

restore shadows
The previous step brought back some of the lighter parts of 
the image, so now we need to being back the darker areas, 
especially around the eyes, nose and mouth. To do this, hold 
Alt again and click the white marker on the far right to split it 
in half and then drag it to the left until you get a reading of 
approximately 60/255.

7 8

Eyes  
that pop
Brush in brightness  
and colour to achieve 
lovely bright eyes

With the enhancements to 
Camera Raw (and Lightroom), 
there is so much more we can do 
now that previously would have 
meant a number of new layers 
and Adjustment Layers in 
Photoshop. The Adjustment 
Brush gives us incredible 
enhancement possibilities 

for the eyes. In a picture 
like this one, with the 
Adjustment Brush increase 
Exposure to +0.40, Clarity 
to +38 and Sharpness to 
+55 to make the eyes stand 
out more. You can use 
Temperature or Tint to 
enhance the colour.

5 6
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TIP
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From making simple hue adjustments 
to adding detailed floral patterns, 
learn how to control and modify 
coloured objects in your images

Alter selected 
colours within 
your photogrAphJAMES 

PATERSON 

Editor, Practical 
Photoshop

With a decade as a 
working writer and 
photographer behind 
him, James knows 
which Photoshop and 
Lightroom tools and 
techniques matter 
the most to you.

SOFTWARE Photoshop CC GET IT FROM www.adobe.com/creativecloud

GET START FIlES FROM www.bit.ly/dc174files

Photoshop

TargeTed Hue sHifTs  
in Camera raw 
Right-click the start image in 
Bridge and choose Open in 
Camera Raw. One of the most 
useful tools for altering or 
boosting colour is found in the 
toolbar: the Targeted Adjustment 
Brush. Grab it, then right-click in 
the image and choose Hue. Drag 
left or right over the dress to alter 
the colours. Next, right-click and 
choose Luminance, then drag 
again to alter the brightness of 
the colour.

seleCTive Colour  
blends in PHoTosHoP
Open the image in Photoshop, 
then select Layer > New 
Adjustment Layer > Selective 
Color. Choose a target colour 
from the drop-down menu, 
then adjust the other sliders 
to change it. To create a colour 
blend, make two different colour 
adjustments on separate layers, 
then add a layer mask to the top 
one. Grab the Gradient Tool and 
plot a black-to-white gradient to 
blend the two together.
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video  
www.bit.ly/ 
dc174video
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PreCise Colour CHanges 
wiTH lab Color
Lab Color mode separates 
colour from brightness. Go to 
Image > Mode > Lab Color. 
Select the dress with the Quick 
Selection Tool, then add a 
Curves Adjustment Layer. Go to 
the Channel drop-down and 
choose either A or B. Drag the 
top-right and bottom-left points 
on the curve up or down to 
change colours, experimenting 
with both channels. Once done, 
go back to Image > Mode > RGB.

blend PaTTerns using 
masks and filTers
First cut out and desaturate (Ctrl/
Cmd+Shift+U) the dress. Hide all 
other layers then save as a PSD. 
Next, drop in a pattern (we found 
this one in the Creative Cloud 
App’s Assets) and make sure it 
covers the whole dress. Right-click 
the layer and choose Create 
Clipping Mask, then change the 
Blend Mode to Multiply. Go to 
Filter > Distort > Displace. Set 
both Horizontal and Vertical to 
about 50 and click OK.

AFT
ER

AFT
ER
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Lab Color explained
The Lab Color Mode is particularly 
useful for colour control, as it 
separates the brightness values in 
the image from the colour values. 
This means that you can alter one 
value without affecting the other. 
You can easily convert an image 
to Lab Color Mode (as in step 3, 
below), then add either a Levels 
or Curves Adjustment Layer.

The drop-down menu at the  
top of each adjustment that 
normally shows Red, Green and 
Blue channels will instead display 
Lightness, A and B channels. The 
Lightness channel affects 

brightness. The A and B channels 
contain all the colour information: 
A enables you to shift between 
green and magenta, and B controls 
yellow and blue.

Not only can you alter colours, 
you can also give dull images an 
amazing colour boost. To do this, 
you simply need to add a Levels 
Adjustment Layer, go to the A 
channel and drag the black and 
white sliders in by the exact same 
value on the 0-255 scale (for 
example, white 55 and black 200). 
Once you have done this, you just 
need to repeat on the B channel.

EXPERT
TIP
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hich photographers 
(living or dead) would 
you like to have round  
for dinner?

I don’t really follow the work of other 
photographers so much, but I do 
watch a lot of movies, so I’ll say… 
Alfred Hitchcock.

What’s your favourite place?
Asia. Give me anywhere in Asia  
and I’ll be as happy as a pig in ****.

What’s on your memory  
card right now?
Stock animation for a food brand – 
animated recipes.

What’s at the very top of your 
bucket list?
Nothing. I’m quite happy with 
everything I have done.

Tell us a secret about your 
photography you haven’t  
told anyone before…
I failed photography at high school  – 
I got a D.

How would you describe your 
photographic work?
Vibrant and full of life.

What kind of photography are you 
bad at?
Pack shots.

To crop or not to crop?
For me, to crop; for a designer, not  
to crop.

What’s on your screen-saver?
Pastries at the Dorchester Hotel.

How many pictures do you shoot?
Loads. I shoot a ton.

What’s in your kit bag right now?
Nikon D810 SLR, Sony Alpha 7 Mark 
II, Zeiss Loxia f/2 50mm, Zeiss  
Macro Planar f/2 100mm macro lens, 
the Otus 55mm f/1.4, the Nikon 
85mm tilt-shift, and a Jambox 
Bluetooth speaker.

Which books should every 
photographer read?
Damn Good Advice (For People with 
Talent) by George Lois.

What’s the most you’ve ever sold  
a picture for?
Probably the £5,000 prize money 
I got for the Food Photographer of the 
Year awards.

Whose work do you most admire?
Henri Cartier-Bresson.

If you weren’t a photographer, what 
would you have done instead?
I’d have been an architect.

What words of wisdom can you give 
aspiring pros?
Don’t be afraid to make mistakes, but 
make sure you learn from them.

Do you have any regrets from your 
career so far?
When travelling, there have been 
images I have been perhaps too polite 
to capture, as I have been too worried 
about people’s sensibilities. It’s better 
to ask for people’s forgiveness than 
their permission!

Do you have any unfulfilled 
photographic ambitions?
I have a studio in Cornwall; I also want 
to build one in France and one in 
Australia. I want to travel between 
them, shooting food.

What is your desert-island D-SLR 
(or CSC)?
Apart from an iPad... The Sony Alpha 
7 Mark II – it’s so robust.

Food Photographer  
of the Year, 2015

David Griffen

DESERT 
ISLAND 
D-SLR

www.davidgriffen.co.uk
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    aperture & depth of field
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    backlit portraits

    spirograms

    twilight seascapes

    pet caricatures

    city light trails

    moody outdoor flash
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front-curtain sync

rear-curtain sync

    flash sync: front or rear?

1. Main exposure 
starts; flash fires

1. Main exposure 
starts

2. Blur appears 
ahead of subject

2. Flash fires 
just before 

exposure ends



aperture & dOF

how to make more or less of 
a scene appear sharply focused

   Depth of field (DoF) 
When you focus on a point in a scene, 
there will be an area in front of and 
behind the point that also appears sharp. 
This is the depth of field, and it can be 
expanded or contracted by changing the 
aperture. Aperture sizes are referred to 
as f-numbers, such as f/8.

   Small f-numbers = smaller DoF 
Choose a small f-number (f/1.4, f/1.8, 
f/2.8…) for a shallow depth of field. This 
is useful for blurring a background in a 
photo – try this when taking a portrait. 

   Big f-numbers = bigger DoF 
Larger f-numbers (f/11, f/16, f/22…) 
increase the depth of field, allowing more 
of a scene to appear sharply focused. Try 
using them when shooting landscapes.

backlit pOrtraits

for your first shot, try...

Exposure mode� aperture priority

Aperture� f/2.8-5.6

ISO 100

Focal length� 70-200mm

to improVe your shot…
   Position your model so that they block the 
sun, adding a halo-like glow to their hair.

   If the person is plunged into darkness in the 
image, apply exposure compensation of +1 
or +2EV and try another shot. 

   Use a reflector to bounce light onto your 
subject and provide a catchlight in the eyes.

tOp tip: Focusing towards the sun can 
cause autofocus problems, so be prepared 
to switch to manual focus instead.

spirOgrams

for your first shot, try...

Exposure mode� bulb

Aperture� f/16

Shutter speed 1 min+

ISO� 200

to improVe your shot…
   Attach a small torch to a length of string 
and pin the string to the ceiling.

   Set up your camera directly underneath 
the torch, with the lens facing up.

   Swing the torch and use a shutter release 
to take a test shot. Check that the full swing 
is captured; if not, zoom out. 

tOp tip: Release the shutter when the 
torch is at the centre of the swing. End the 
exposure when it’s back in the centre.

twilight seascapes

for your first shot, try...

Exposure mode� aperture priority

Aperture� f/11-16

Shutter speed auto

ISO� 100

to improVe your shot…
   Shoot before the sun has risen, or after it 
has set, and you can use longer shutter 
speeds without the need of an ND filter.

   Include wet sand or rocks in the frame 
to reflect the sky’s twilight colours.

   Use a remote release to fire the shutter as 
waves are receding rather than advancing.

tOp tip: If the sky is much brighter than 
the sea, take two shots – one well-exposed 
for each area – and merge them later.

mOrning dew

for your first shot, try...

Exposure mode� aperture priority

Aperture� f/4-11

ISO 200

Focal length� 100mm

to improVe your shot…
   Choose a macro lens; the longer the 
focal length, the less likely it is that you’ll 
inadvertently knock the blades of grass.

   A wide aperture, such as f/4, will blur the 
background, but a narrower aperture will 
keep more of the image sharp.

    Shoot early in the day: it’ll be less breezy.

tOp tip: Switch to manual focus, but 
take care not to focus on reflections or 
below the surface of the water.

mOOdy OutdOOr Flash

for your first shot, try...

Exposure mode� manual

Shutter speed� 1/200 sec

Aperture Varies

ISO� 100

to improVe your shot…
   Shoot from a low angle so that the person 
is framed against the sky.

   With the flash off, adjust the aperture so 
that the scene is two stops underexposed 
(such as f/5.6 to f/11 in this example).

   Set the flashgun to Manual mode, then take 
test shots while adjusting the flash power.

tOp tip: Use two flashguns: one behind 
the subject to act as an edge light, and the 
other lighting them from the front.

Flash: FrOnt Or rear?

choose when the flash fires by 
changing the flash sync mode

   Front- or first-curtain sync 
By default, a flash fires when the shutter 
curtains open to expose the camera 
sensor to light, enabling you to time shots 
to perfection. However, any movement 
recorded by the main exposure will appear 
in front of the flash-lit subject.

   Rear- or second-curtain sync 
In this mode, the flash fires at the end of the 
main exposure. Any motion blur recorded at 
the start of the exposure will  trail behind the 
subject, creating a more natural result. The 
drawback is that it’s harder to time shots.

tOp tip: The effects of rear-curtain sync 
flash are only obvious at slower shutter 
speeds. Try using it at night when shooting 
cars: the trails created by the headlights will 
add a real sense of speed.

pet caricatures

for your first shot, try...

Exposure mode� aperture priority 

Aperture� f/4-8

Shutter speed auto

ISO� 400

to improVe your shot…
   Choose a wide-angle lens and get close to 
the animal to create the distorted effect.

   Use One-Shot autofocus and select an AF 
point that corresponds with an eye.

    Check the edge of the frame to make sure 
you’re not inadvertently  trimming off the 
tips of the ears, paws or whiskers.

tOp tip: Consider removing an animal’s 
collar before you start shooting: it might 
take a viewer’s focus away from the eyes. 

city light trails 

for your first shot, try...

Exposure mode� manual

Aperture� f/11

Shutter speed 20 sec

ISO� 100

to improVe your shot…
   Use the above settings as a starting point; 
if the picture comes out too light, choose a 
higher f-number.

   Two-way streets work best. Time your 
shots so that both lanes are moving. 

   Use a tripod and a remote release so the 
camera doesn’t move between shots.

tOp tip: To combine trails from several 
shots in Photoshop, copy the images into 
layers and use the Lighten blend mode.

Your exclusive digital camera tip cards

Visit our shop at www.myfavouritemagazines.co.uk/photo
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Make instant improvements to your images with two of the 
most powerful tonal commands that Photoshop has to offer

hatever you like to photograph, 
tonal control is one of the most 
fundamental skills you can learn in 
digital photography. It’s important 
for a number of reasons. First, no 

matter how competent or careful a photographer 
you are, there will be times when exposure and 
white balance aren’t perfect. This is where tonal 
adjustments can come to the rescue. Second, if you 
shoot in a raw format, you may have noticed that the 
files can initially look a little flat compared with JPEGs. 
That’s because, unlike JPEGs, raws aren’t processed 
in-camera – camera manufacturers expect users to 
want to make their own enhancements. Naturally, 
a few tonal tweaks are therefore necessary. Third, 

control over tones enables you to interpret a scene 
however you like, not just how the camera sees it. 
This ultimately gives you complete control: you can 
create dramatic contrast, cool the colours, or even 
introduce an entirely new atmosphere.

Two of the most powerful tools for tonal control are 
Levels and Curves Adjustment Layers. This ebook is 
devoted to these two cornerstones of image-editing 
in Photoshop. As well as a complete guide to each 
command, we’ll give you practical advice on exactly 
how to approach your tonal tweaks, from reading 
a histogram to fixing colour channels. Plus, there are 
plenty of effects, tricks and tips to try out. There’s 
also a fine selection of videos and images among the 
project files for this ebook.



Get creative with LeveLs and curves

too dark (underexposed) too briGht (overexposed)

What is a histogram?
This is a graphical representation of all 
the pixels in your image, sorted by 

brightness on a scale of 0-255 (zero being black 
and 255 white). The left of the graph shows the 
shadow tones, the right displays the highlights, 
with all the shades of brightness in-between. 
Imagine all the pixels of a particular brightness 
value have been stacked on top of one another 
to form the peaks on the graph. Both Levels and 
Curves commands display a histogram, but it’s 
a good idea to check an image’s histogram on 
your camera’s LCD when you take the shot, to 
ensure you’ve recorded the scene correctly.

An introduction to...

The Levels command has 
been a key Photoshop 
feature since the early 

days. Available in both CS and 
Elements, this stalwart tonal tool 
lacks the depth offered by its 
more powerful cousin Curves. 
But simplicity has its advantages, 
especially if you want to make 
quick, precise improvements to 
your images. The key controls are 
three sliders running along the 

bottom of the Histogram, which 
allow you to adjust blacks, whites 
and midtones. Setting black and 
white points can help to boost 
contrast by making use of parts 
of the tonal range that are not 
initially present in the image, 
while the midtone slider lets 
you tweak overall brightness. 
With these simple settings, it’s 
possible to make a powerful array 
of tonal enhancements. 

Learn how to fix flat scenes and give 
your images an instant boost with Levels

Where to begin? 
A typical Levels adjustment is a two-step 
process. First, you drag the white and  

black points inwards to meet the edges of the 
histogram, thereby making the most of the full 
tonal range (unless, of course, there are clipped 
whites or blacks already present).

Once the white and black points have been set, 
use the midpoint slider to tweak the brightness by 
shifting midtones towards either end of the range, 
judging the effect by eye. 

LeveLs  and
histoGrams

start imaGe

Adjustment Layer or 
direct image adjustment?

Before you start using Levels or Curves, you need to 
make a choice: do you want to apply the command 

directly to your image (via Image > Adjustments), or would 
you rather add it as an Adjustment Layer (Layer > New 
Adjustment Layer)? The first option helps to keep things 
simple, but the effect is permanent. A Levels Adjustment 
Layer gives you far greater control: it sits on its own layer 
in the Layers Panel and affects all the layers beneath, so you 
can tweak the settings whenever you like, as well as adjust 
Opacity, paint a mask or experiment with Blend Modes.

watch  
video  
www.bit.ly/ 
dc174video



too fLat Just riGht

channeL drop-down
The RGB channel lets you 
control overall brightness, 
while the Red, Green or Blue 
channels let you alter colours.

bLack / white eyedroppers
Select the White Eyedropper, then click 
over a point in the image. Any pixels 
lighter than this point will go completely 
white. The Black Eyedropper works in 
the same way, but will make darker pixels 
completely black.

auto options
Click the Auto Button to apply auto 
correction for colour and tone. Hold Alt 
and click the button to access the Auto 
Color Correction Options box.

Grey 
eyedropper
Select the Grey 
Eyedropper, then 
click over a part of 
the image to set its 
colour as neutral.  
All other colours 
will be remapped  
around this new 
neutral point. 

white point sLider
Drag the White Point slider inwards 
to lighten the very brightest pixels 
by setting a new point at which pixels 
are completely white. Hold Alt while 
dragging to view any clipped pixels.

midtone sLider
Drag the Midtone slider 
to lighten or darken 
the image by setting a 
new point for the pixels 
that originally sat at 
127 on the tonal range, 
thereby compressing 
or stretching the tones 
towards the highlights  
or the shadows.

presets
Presets can be a useful starting point. 
Choose from the list, or save your own 
Levels settings as presets via the flyout 
menu to the right of the drop-down.

LEvELS AND HISTOGrAMS

bLack 
point sLider
Drag the Black Point 
slider inwards to darken 
the very darkest pixels 
by setting a new point 
at which pixels go 
completely black. Hold 
Alt while dragging for 
a view that displays 
any clipped pixels.

sLider vaLues
These three boxes 
reflect the settings of the 
three sliders above. The 
white and black values 
correspond to the tonal 
range (0-255) while the 
Midtone slider is set at 
1.00 (a gamma value 
rather than tonal value).

output LeveLs
Use the Output Levels slider to define the 
boundaries of the tonal range. This can be  
useful when preparing an image for printing, 
as it can help prevent loss of detail in the 
darkest and brightest areas.

What should I look  
for when shooting?

The graph’s left and right edges show the 
very brightest and darkest tones. When 

capturing an image, it’s vital to record detail in 
the highlights and shadows without blowing 
out, or ‘clipping’ whites and blacks. To get a 
pleasing exposure, check the histogram on 
your camera’s LCD screen to make sure the 
graph goes all the way down to the bottom line 
at either end. If it doesn’t, it means you’ve got 
clipped whites (on the right) or clipped blacks 
(on the left), and you may find an adjustment 
to the exposure will produce a better image. 



LeveLs and curves
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1 IMPROvE THE TOnAL RAnGE
Open levels_before.jpg. Go to the Layers 

Panel (Window > Layers), click the Create 
Adjustment Layer icon at the bottom and 
choose Levels. Hold down Alt and drag the 
Black Point slider inwards until pixels begin to 
appear at around 19. Use the same technique to 
drag the White Point slider to around 228.

3 IMPROvE THE Sky
Go to Select > refine Edge, then set radius 

to 1.9, Smooth to 2 and Output to Selection. 
Next, add a second Levels layer. Set Black Point 
to 48, Midpoint to 0.82 and White Point to 
189. Click the rGB drop-down menu above 
the histogram. Select red and set Midpoint 
to 0.92. Select Blue and set Midpoint to 1.15.

2 CORRECT THE COLOURS
Click the grey point eyedropper next to the 

histogram, then click over a point in the image 
that should be a neutral colour, such as the 
rocks. Next, grab the Magic Wand tool, set 
Tolerance to 20 and tick Contiguous. Click the 
blue sky, then hold down Shift and continue 
clicking to select the whole sky.

4 TWEAk THE LAnD
Create a third Levels layer. Alt-drag the 

Layer Mask thumbnail from the layer below 
onto the new layer. Approve the replace Mask 
question. Highlight the new mask thumbnail 
then press ctrl/cmd+i to invert it. Click the 
‘Levels 3’ layer and set the rGB Midpoint to 
0.94; red Midpoint 0.95; Blue Midpoint 0.95.

Learn how to

Sometimes a digital image looks 
different to the scene that you 
remember, particularly if there 

were problems with exposure or white 
balance. If colours look wrong and tones 
lack punch, then the Levels command can 
come to the rescue. Here, we’ll show you 
how to improve tones in seconds by 

adding depth, enhancing skies and fixing 
colours. As well as making universal 
adjustments to improve the tonal range, 
we’ll also select the blue sky and use it to 
alter both the sky and land independently 
of one another. With a few simple 
adjustments, you can transform the 
image and do the scene justice.

Take control of tones, fix colours and boost skies 
in landscapes with simple Levels adjustments

fix coLours 
with LeveLs

Step-by-step Using Levels



FIx COLOUr & CONTrAST

Shoot a grey card
The easiest way to correct a colour cast 
is to pick the grey point eyedropper 

(accessible in both the Levels and the Curves 
settings), then click over a tone in the image 
that should be neutral. Of course, this is only 
possible if there’s an obvious neutral tone 
available, such as in a road or a rock. If not, then 
you may need to click repeatedly over a few 
areas until you chance upon the right look. 
Another technique that some professionals use 
is to shoot a grey card under the same lighting 
conditions. Once that shot is corrected, the 
same settings can be applied to the main image.

watch  
video  
www.bit.ly/ 
dc174video
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LeveLs and curves

 The Curves command remains one of 
the most potent tools in Photoshop’s 
arsenal. versatile, powerful and 

intuitive, it’s the weapon of choice for most 
tonal tweaks. Unlike Levels, which only allows 
you to adjust the whites, blacks and midtone 

points, Curves lets you place up to 14 points 
(although you’ll rarely need more than four or 
five) to make precise adjustments to different 
parts of the tonal range. The fluid curve line 
ensures a smooth transition between these 
different tonal shifts.

curve controL

Curves values explained
Curves work by giving you intuitive 
control over brightness, which is mapped 

out on a scale of 0 (black) to 255 (white). The 
horizontal axis represents the original tonal 
values; the vertical axis represents the values 
after the curve settings are applied.  

In a sense, the Curves box shows a ‘before 
and after’ of the tonal tweak, with the 
horizontal axis the ‘before’ and the vertical axis 
the ‘after’. The curve line is initially at a 45- 
degree angle because the input and output 
tonal values start off the same, so each  
x-axis value has an identical Y-axis value, 
resulting in a 45-degree line. 

If you click right in the centre of the line then 
drag the point to three quarters of the way up 
the box, you’re targeting the midtone pixels 
that were originally at a brightness value of 127 
along the tonal range and giving them a new 
brightness value of around 191, or 75% white. 
If you make a second point a quarter of the way 
in from the left and drag this down to the 
starting line, you’re effectively resetting the 
pixels in that part of the tonal range to their 
initial value.

An introduction to...

How Curves work
Click on the diagonal curve line 
to add a point, then drag this up or 

down to lighten or darken the image. It’s 
important where you place points along 
the curve line: this affects different parts 
of the tonal range, from blacks (on the 
left) to whites (on the right). Add more 
points along the line, then use them to 
target and adjust the brightness of 
different tones. Anywhere the curve goes 
above the initial diagonal starting line will 
mean the tones will be made brighter, and 
in any parts where the line goes below it, 
they will be made darker.

Get to grips with the king of tonal control – the Curves command
watch  
video  
www.bit.ly/ 
dc174video



xxxxxxxx xxxxCUrvE CONTrOL

channeLs
Access different colour 
channels via this drop-down 
menu. For RGB images, you can 
choose Red, Green or Blue.

steep Line
 The steeper the curve line, 
the greater the contrast in 
that part of the tonal range; 
the more horizontal the line, 
the less contrast there is.

Grey 
eyedropper
Grab the Grey 
Eyedropper then 
sample a tone in the 
image to remap it as 
neutral – useful for 
correcting colours.

input
The Input box shows the value  
of the tones over the currently 
selected control point before 
any changes are made. 
Essentially, it’s the X-Axis value.

bLack/white 
eyedropper
Use the White Eyedropper 
to sample a point in the 
image to make it – and 
any brighter pixels – 
completely white. The 
Black Eyedropper will 
make darker pixels 
completely black.

auto options
Click the Auto Button to 
apply auto-correction, or 
Alt-click it for more options.

penciL and 
smooth vaLues
The pencil icon lets you 
draw a freehand curve 
line (or alternatively 
Shift-click between 
points to draw a straight 
line). Once drawn, the 
Smooth values option 
automatically improves 
the line.

white point sLider
Drag the white point inwards 
to set a new point at which 
pixels become completely 
white. Hold Alt while dragging 
to view clipped pixels.

controL point
Click along the curve to add up 
to 14 control points, then drag 
these points up or down to 
adjust the shape of the curve.

presets
Click the Preset drop-down to choose from a list of 
pre-made Curves settings such as Strong Contrast, 
Cross Process or negative. Click the fly-out menu to 
save new Curves presets.

bLack point sLider
Drag the black point inwards 
to set a new point at which 
pixels become completely 
black. Hold Alt while dragging 
to view clipped pixels.

hand icon
Toggle the Hand icon 
on, then click over parts 
of the image to set  
control points at their 
specific value on the  
tonal range. Drag up or 
down to lighten or darken 
these points.

output
The Output box shows the 
resulting change in tone over 
a currently selected control 
point after an adjustment has 
been made. Essentially, it’s the 
y-Axis value.

Camera raw and Lightroom’s Develop Module 
both feature the Tone Curve Panel which – bar 

a couple of minor differences – works in the same way 
as the Curves command in Photoshop. 

Camera raw’s Tone Curve Panel offers two tabs for 
curve control: Parametric and Point. (In Lightroom, you 
can toggle parametric sliders open via the panel’s 
bottom-right square icon.)

Parametric displays a set of sliders that let you  
tweak different parts of the tonal range, like shadows 
and highlights. It’s a useful control if Curves  
confuses you, as you can see exactly how the curve  
line relates to tones. 

For greater precision, head straight to the Points tab, 
which lets you place and drag points to adjust the curve 
in the same way as Photoshop Curves. 

Curves in Camera Raw and Lightroom
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overaLL
An S-shaped curve boosts 
contrast, while dragging 
down on the red curve 
adds cyan. Raising the 
lower part of the blue 
curve adds a hint of blue 
to the shadow tones.

How to control

Use selective

Images with punch will jump 
out of the screen compared 
with those with lifeless flat 

tones. The amazing S-curve will give 
your images this vitality with almost 
no effort. Create a new Curves 
Adjustment Layer, then drag a point 
up in the top half of the line and a 
second point down in the bottom 
half. (A third point at the centre 

anchors the midtones.) This curve 
brightens the highlights and darkens 
the shadows, resulting in greater 
contrast. There’ll be greater contrast 
wherever a curve is steeper, so the 
more pronounced the S-curve, the 
stronger the effect. Take a look at 
the Curves adjustments below to see 
how different curves affect the 
highlights and shadows.

One of the great things about applying Curves as an 
Adjustment Layer is the opportunity for selective 
control with masks. Adjustment Layers automatically 

come with an active Layer Mask attached. It’s usually easiest if 
you make this mask completely black, then paint with white to 
reveal the effect. Once you’ve added a Curves Adjustment Layer 
(Layer > New Adjustment Layer > Curves) and tweaked the 
curve, press ctrl/cmd+i to invert the mask to black, hiding the 
change in tone. Then simply grab the Brush Tool and paint with 
white to reveal the change in the areas of your choosing. This 
selective control is very effective on portraits because you can 
use masks to change different parts of the face, such as the eyes 
and lips, and even introduce colour shifts to enhance make-up.

Learn how to control contrast using Curves  
for maximum impact in all your images

Add some make-up to your images

tones &  
contrast

adJustments

inverted s-curve
Result: Reduced contrast

deep s-curve
Result: Heavy contrast

shaLLow s-curve
Result: Light contrast

anGLed s-curve
Result: Contrast overkill

Closer look The S-Curve



the eyes
A pronounced 
S-curve boosts 
contrast, while a 
mask restricts the 
effect to the irises.

Lashes
A slight downwards 
drag on the curve 
darkens the image, 
then a mask 
restricts the effect 
to the lashes.

bLusher
Dragging the reds 
up and the greens 
down adds red and 
magenta, while a 
mask restricts the 
effect to the cheeks.

the Lips
An increase in reds 
combined with a 
boost in overall 
contrast gives the 
lips extra impact.

eye make-up
Dragging up on 
the blue channel 
introduces blue. 
A Layer Mask 
restricts the effect 
to above the eyes.

 DIGITAL MAkEUP

watch  
video  
www.bit.ly/ 
dc174video
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red curve
Dragging the Red curve upwards 
adds red, and dragging it down adds 
cyan, so increasing the bottom half 
of the line adds red to the shadows, 
while lowering the top half 
introduces cyan into the highlights.

Green curve
Dragging one point downwards 
on the Green curve here adds 
a Magenta cast, which is 
particularly noticeable on the 
stem of the flower, because this 
is where most of the midtones are.

bLue curve
An upwards shift of the 
bottom-left point on the 
blue curve makes the 
blacks in the image look 
blue, thereby changing the 
colour of the background 
to a dark blue.

You can master

 Both Levels and Curves enable 
you to tweak an rGB image’s red, 
Green and Blue colour channels. 

This is useful if you need to correct a 
colour cast or remedy a white balance 
mistake, and also for creative or dramatic 
colour shifts to change the atmosphere 
of a scene. While Levels are fine for basic 
colour correction, the Curves command’s 
more intuitive interface makes it the best 
choice for creative colour shifts. 

By tweaking the colour channels you 
can make a huge range of effects. Just as 

the main rGB curve gives you precise 
brightness control, you can similarly 
restrict colour changes to parts of the 
tonal range by manipulating the individual 
channel curves. For example, dragging the 
bottom part of the Blue curve up then 
pinning the top half back into place will 
add a blue cast to the shadow tones only. 
You can also get dramatic colour shifts  
by dragging the top-right or bottom-left 
points on each colour channel to shift  
the brightest or darkest tones towards 
different colours.

Take precise creative control over the individual 
colour channels of your photos with Curves

curves and
coLour channeLs

LeveLs and curves
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Secrets of the pros

Improve your image editing workflow instantly with 
our pick of the top 20 tips for Levels and Curves

20 tips & tricks  
to try today

1 Better print detail
Printers can struggle to produce detail 
in tones above 245 or below 10 on the 

0-255 tonal range, so these tones may come 
out completely white or black on the print. 
If your prints lack detail in the shadows and 
highlights, experiment with Output Levels 
in the Levels command. Make a test print to 
determine the limits of your printer, then adjust 
the Output Sliders accordingly.  

2 Use the Info Panel
When correcting colours, the Info Panel 
(Windows > Info) makes it easier to 

determine which colours need adjusting by 
displaying the r, G and B values of the tones 
beneath your cursor. Equal amounts result in 
grey, so if an area that should be neutral 
displays unbalanced values, you’ll know  
which colours to adjust. 

3 Speedy S-curves
Speed up your workflow with an S-curve 
action. Go to the Actions Panel and click 

on the New Action icon. Assign a function key, 
then click record, make a shallow S-curve and 
click Stop. Now you can incrementally boost 
contrast by repeatedly pressing the function 
key that you defined. 

4 CMYk Curves control
Curves work differently depending on 
whether your image is in rGB or CMYk. 

Dragging up on the curve lightens an rGB 
image, but darkens a CMYk image. (This is 
because rGB values are measured in 
brightness, whereas CMYk values are 
measured in ink.) If you find this irritating, you 
can always set the CMYk curve to show light 
rather than ink via Curve Display Options in the 
fly-out menu in the top-right of the panel. 

5 Preserve colours
An S-curve boosts both the contrast 
and the saturation. If you would like to  

change the contrast while leaving colours 
unaffected, apply Curves as an Adjustment 
Layer, then change the Blend Mode of the  
layer to Luminosity.  

6 Curves on Layer Masks
Curves can tweak masks. Highlight a 
mask, then press ctrl/cmd+m. Drag the 

bottom-left black point up to make the mask 
more transparent, or drag the top-right point 
down to make the layer more transparent.

7 Selective masking
Once you’ve made an Adjustment Layer, 
press ctrl/cmd+i to invert the Layer 

Mask to black, then paint with white to 
selectively reveal the adjustment.

8 Clip the Curves
To restrict an Adjustment Layer so that 
it only affects the layer directly below, 

make a clipping mask by holding down Alt and 
clicking the line between the layers. 

9 Find neutral grey
If you’re struggling to find a neutral 
tone for your colour correction, try this: 

make a new layer, fill it with 50% grey (with Edit 
> Fill), then set the Blend Mode to Difference. 
Next, add a Threshold Adjustment Layer and 
drag the slider all the way to the left. Now, as 
you start to drag back to the right, the first 
pixels to appear are the ones most likely to be 
neutral in tone. Grab the Color Sampler Tool, 
click to mark the point, then delete both layers. 
Use the grey point eyedropper in Levels or 
Curves to fix the colours. 

10 Add control points
When using the Tone Curve in  
Camera raw or Lightroom, hold down 

Ctrl/Cmd and click areas of the image to set 
control points at the associated values along 
the Curves x-axis.

11 Duotone effects
To make a duotone effect, first convert 
an image to mono, then apply Levels or 

Curves. Double-click the black eyedropper and 
choose a colour, then click over a black point in 
the image to remap the colours. Do the same 
with the white eyedropper for the lighter tones.

12 Parametric Curve
When using Camera raw’s Parametric 
Curve sliders, you can change the tonal 

parameters of each slider (Highlights, Lights, 
Darks, Shadows) by dragging the three 
triangles directly below the Curve box.

13 Camera raw tool
ACr’s Targeted Adjustment tool can be 
used to adjust the Tone Curve. right-click 

with the tool, choose Parametric Curve, then 
drag over the image to adjust the tones.
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14 Move multiple points
When using Curves, hold down Shift and 
click multiple control points, then use the 

arrow keys on your keyboards to nudge all the 
points at once.

15 Last used Curve
Press ctrl/cmd+m for the Curves 
command and ctrl/cmd+alt+m to 

display Curves with the last used settings.

16 Nudge control points
Use the arrow keys to nudge Curves 
control points by increments of 1. Hold 

down Shift for bigger nudges.

17 Clipped pixels
Hold down Alt and drag white and black 
points in Levels and Curves for a view  

that shows clipped pixels.

18 Change the grid size
Hold down Alt and click the Curves graph 
to toggle between two grid sizes.

19 Channel shortcuts
Press alt+2-5 to display the different rGB 
curves channels (or alt+2-6 for CMYk).

20 Create the look
To create the punchy treatment for this 
flower image, we made an S-Curve on the 

rGB and Blue Channels, then dragged down on 
the red and Green channels. Then we added a 
texture image, with the Blend Mode set to 
Multiply, to finish.

Type this into your browser’s Address bar to 
download the image: www.bit.ly/dc174files
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Curves make it easy create a wide variety of vintage 
and contemporary colour effects in seconds

creative curves

Recreate classic solarisation
what is it?  Accidentally discovered when a light was 
turned on in a darkroom, and championed by the 

surrealist photographer Man ray, solarisation has the effect 
of inverting part of the tonal range to negative.

how to do it  First, convert the image to mono then add a 
Curves Adjustment Layer and click on the Curve Pencil Tool. 
Click in the top-left corner of the Curves box then Shift-click 
at the bottom-middle and top-right to make a v-shaped curve 
(or try an upside-down v if you like). Next, add a second Curves 
layer, select the red channel and drag the bottom-left and top-
right points inwards slightly. Finally, select the Blue channel and 
drag the top-right point downwards.

Mimic a light leak 
what is it?  recreate an effect 
that used to plague budget 

cameras, but – thanks to apps like 
Instagram – is now all the rage. Light 
leaks occurred in cheap camera 
bodies, fogging the edges of film  
and shifting colours. 

how to do it   First, use a Curves layer 
to skew the colour channels by adding 
yellow and green. Next, add another 
Curves layer and drag the red Channel 
right up and the Blue channel down 
to make bright orange, then press 
ctrl/cmd+i to invert the mask. Paint 
with a low-opacity white brush to 
reveal the orange around the edges, 
and experiment with different colour 
shifts to build up the effect.

start imaGe

Amazing effects with...

LeveLs and curves
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Get the cross-processed look
what is it?  Cross-processing involved either developing slide film in negative C-41 
chemicals, or negative film in slide film E-6 chemicals. The results were punchy 

over-saturated tones and unpredictable colour shifts.

how to do it  As the cross-processing effect traditionally had unpredictable results, 
you’re free to experiment with colour shifts using the red, Green and Blue channels. Try 
making an angular S-shape on the Green channel and a hump-shaped curve on the Blue 
channel, then add punch and saturation with an S-curve on the rGB channel.

Make bleak modern art
what is it?  Turn simple photos into contemporary art by mapping blocks of 
colour onto the highlights. The effect works best on high-contrast scenes such 

as silhouetted subjects against bright skies.

how to do it  First, crop to a square, then add a Curves Adjustment Layer and plot an 
S-curve to boost contrast. Next, double-click the White Eyedropper on the left of the 
Curve graph then choose a bold colour from the Color Picker. When asked if you want 
to save colours, choose No, then simply click on the brightest part of the image to 
remap the tones around the new colour.

start imaGe
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